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Hardware and Software Version Summary

Table1l. Hardware and Software Version Summary

Cisco DNA Center Appliance 2.2.2.5 (System 1.6.424)
Cisco ldentity Services Engine 3.0 Patch 2

Cisco SD-WAN Controllers 20.3.4

Cisco I0S XE WAN Edge Devices 10S XE 17.3.4a

Cisco SD-Access Devices I0OS XE 17.3.4

© 2021 Cisco and/or its affiliates. All rights reserved. Page 3 of 148



About This Guide

STEP 1 STEP 3

DEFINE DEPLOY

8CC0O

STEP 2 STEP 4

DESIGN OPERATE

This document contains four major sections:
The DEFINE section provides a high-level overview of the Cisco SD-WAN, SD-Access architecture, and components.

The DESIGN section provides a detailed discussion on the design considerations, deployment topology options, and
prerequisites needed to integrate the solutions.

The DEPLOY section discusses step-by-step procedures, workflows to connect multiple SD-Access fabric sites with SD-WAN
network.

The OPERATE section briefly discusses how to monitor and troubleshoot the common issues.

Refer to Appendix A for details on the platform and software versions used to build this document.
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Introduction

This guide provides design and deployment steps to use the Cisco SD-Access and Cisco SD-WAN solutions to achieve end-to-end
segmentation and consistent policy across enterprise and branch. The guide focuses on the design considerations, best
practices, and the step-by-step procedures needed to integrate the two solutions together.

The Cisco SD-Access | Cisco SD-WAN Integrated Domain and Independent Domain deployment models provide network

administrators the ability to:
e Securely onboard network devices and interconnect campus and branch locations
e Preserve Scalable Group Tags (SGTs) across the SD-WAN transport
e Maintain end-to-end segmentation across the enterprise campus and branch locations
e Define and enforce group-based policy throughout the network

These capabilities, coupled with the unique capabilities provided through each solution, enables organizations to build the next-

generation Intent-Based Networking solution.

Figure 1. Integrated Domain Components
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The guide focuses on the Integrated Domain deployment model where the SD-WAN controllers and Cisco DNA Center are
integrated. In this approach, the WAN Edge devices perform both SD-WAN edge and SD-Access border and control plane
functionality, managed and provisioned by the SD-WAN controllers. The SD-WAN vManage controller shares the WAN Edge
devices to Cisco DNA Center. The SD-Access fabric components are managed and provisioned by the Cisco DNA Center.
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Companion Resources

For more information on the SD-WAN Design and Deployment best practices, see:

e Cisco SD-WAN Design Guide

e Cisco WAN Edge Onboarding Prescriptive Deployment Guide

e Cisco SD-WAN End-to-End Deployment Guide

For more information on the SD-Access best practices design and deployment, see:

e SD-Access Solution Design Guide

e SD-Access and Cisco DNA Center Management Infrastructure

e SD-Access Fabric Provisioning Prescriptive Deployment Guide

e SD-Access for Distributed Campus Deployment Guide

For all full list of related deployment guides, design guides, and white papers, visit the following pages:

e https://cs.co/en-cvds

o https://www.cisco.com/go/designzone

If you didn’t download this guide from Cisco Community or Design Zone, you can check for the latest version of this guide.

Audience

The intended audience for this document includes network design engineers and network operations personnel who are looking
to deploy multiple Cisco SD-Access sites, interconnect with Cisco SD-WAN solution with the intent to maintain end-to-end

automation, segmentation, and consistent group-based policy.

© 2021 Cisco and/or its affiliates. All rights reserved. Page 6 of 148


https://www.cisco.com/c/en/us/td/docs/solutions/CVD/SDWAN/cisco-sdwan-design-guide.html
https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/sd-wan-wan-edge-onboarding-deploy-guide-2020jan.pdf
https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/SD-WAN-End-to-End-Deployment-Guide.pdf
https://cs.co/sda-cvd
https://cs.co/sda-infra-pdg
https://cs.co/sda-fabric-pdg
https://cs.co/sda-distrib-pdg
https://cs.co/en-cvds
https://www.cisco.com/go/designzone
https://cs.co/integrated-domain

Define

This chapter is organized into the following sections:

_

Define Cisco SD-WAN Solution Overview

Cisco SD-Access Solution Overview

Protocol Operational Planes Overview

Cisco SD-Access | SD-WAN Pairwise Overview

Integrated Domain Protocol Integrations

Cisco Software-Defined Wide Area Network Solution Overview

The Cisco® Software-Defined Wide Area Network (SD-WAN) solution is an enterprise-grade SD-WAN overlay architecture that
enables digital and cloud transformation. The solution fully integrates routing, security, centralized policy, management, and
orchestration into large-scale networks and addresses the problems and challenges of common WAN deployments.

Cisco SD-WAN Solution Components

There are four key components that make up the Cisco SD-WAN solution, each performing distinct activities in different network
planes of operation: orchestration plane, management plane, control plane, and data plane.

Orchestration Plane Controller — Securely onboards the SD-WAN Edge routers into the SD-WAN overlay
Management Plane Controller — Provides assurance, visibility, and management

Control Plane Controller — Responsible for central configuration and monitoring

Data Plane Devices — Forwards packets based on decisions from the control plane

In Cisco SD-WAN, Cisco vBond is responsible for the orchestration plane, the management plane is enabled and powered
through Cisco vManage, Cisco vSmart drives the control plane, and Cisco I0S® XE SD-WAN Edge routers are responsible for the
data plane.
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Figure 2. Cisco SD-WAN Solution components
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vBond — The vBond controller, or vBond orchestrator, authenticates and authorizes the SD-WAN routers and controllers into the
network. The vBond orchestrator uses a distribute list to propagate vSmart and vManage controller information to the WAN
Edge routers.

vManage — The vManage controller is the centralized network management system that provides the GUI interface. This single
pane of glass allows easy deployment, configuration, monitoring, and troubleshooting of the Cisco SD-WAN network.

vSmart — vSmart builds and maintains the network topology and makes decisions on the traffic flows. The vSmart controller
disseminates control plane information between WAN Edge devices, enforces centralized control plane policies, and distributes
data plane policies to the WAN Edge devices to do enforcement.

vAnalytics — Cisco vAnalytics is a cloud-based service that provides visibility and insights into the network infrastructure,
application usage, and performance across the SD-WAN network.

SD-WAN Edge Routers — WAN Edge devices provide secure data plane connectivity across locations connected to the WAN
network. These routers are responsible for traffic forwarding and provide security, encryption, and quality of service (QoS)
enforcement.

Cisco Software-Defined Access Overview

Cisco® Software-Defined Access (SD-Access) is the evolution from traditional campus designs to networks that directly
implement the intent of an organization. SD-Access is a software application running on Cisco DNA Center hardware that is used
to automate wired and wireless campus networks.

Fabric technology, an integral part of SD-Access, provides wired and wireless campus networks with programmable overlays and
easy-to-deploy network virtualization, permitting a physical network to host one or more logical networks to meet the design
intent. In addition to network virtualization, fabric technology in the campus network enhances control of communications,
providing software-defined segmentation and policy enforcement based on user identity and group membership. Software-
defined segmentation is seamlessly integrated using Cisco TrustSec® technology, providing micro-segmentation for groups
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within a virtual network using scalable group tags (SGTs). Using Cisco DNA Center to automate the creation of virtual networks
with integrated security and segmentation reduces operational expenses and reduces risk. Network performance, network
insights, and telemetry are provided through the Assurance and Analytics capabilities.

Cisco SD-Access Solution Components

Figure 3. Cisco SD-Access Solution components
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The Cisco SD-Access solution is comprised of the following components:

Fabric Site — Independent fabric includes a control plane node, border node, edge node, and usually includes a Cisco Identity
Services Engine (ISE) Policy Service Node (PSN) and fabric-mode Wireless LAN Controller (WLC).

Fabric Edge Nodes —This is equivalent to an access layer switch in a traditional campus LAN design. Endpoints, IP phones, and
wireless access points are directly connected to edge nodes.

Fabric Border Node —This serves as the gateway between the SD-Access fabric site and networks external to the fabric. The
border node is the device physically connected to a transit (either SD-WAN transit, IP-Transit or SD-Access transit) or to a next-
hop device connected to the outside world.

Fabric Control Plane Node — The SD-Access fabric control plane node is based on the LISP Map-Server (MS) and Map-Resolver
(MR) functionality combined on the same node. The control plane database tracks all endpoints in the fabric site and associates
the endpoints to fabric edge nodes, decoupling the endpoint IP address or MAC address from the location (closest router) in the

network.
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Fabric Wireless LAN Controller — The Wireless LAN Controller (WLC) provides centralized access point (AP) image and
configuration management and client session management. The WLC integrates and communicates with the fabric Control Plane
Node to provide mobility services for endpoints attached to fabric Access Points.

Fabric Access Points — Access Points (APs) operating with fabric SSIDs build a VXLAN data tunnel to fabric Edge Nodes. Control
traffic is still tunneled to the WLC. By terminating client traffic at the first-hop Edge Node, policy for wired and wireless traffic
can be enforced at the same location in the network.

Identity Service Engine (ISE) — Cisco ISE is a secure network access platform enabling increased management awareness,
control, and consistency for users and devices accessing an organization's network. ISE is an integral part of SD-Access for policy
implementation, enabling dynamic mapping of users and devices to scalable groups and simplifying end-to-end security policy
enforcement.

Cisco DNA Center — Cisco DNA Center software, including the SD-Access application package, is designed to run on the Cisco
DNA Center Appliance. The Cisco UCS® appliance is available in form factors sized to support not only the SD-Access application
but also network assurance.

The same enterprise Cisco DNA Center cluster can be used to discover, provision, and manage all the network devices across the
enterprise—campus and remote branch locations.

Virtual Networks (Macro-segmentation) — Use Virtual Networks (VNs) when requirements dictate isolation at both the data
plane and control plane. In general, if devices need to communicate with each other, they should be placed in the same virtual
network. If communication is required between different virtual networks, use an external firewall or other device to enable
inter-VN communication. A VN provides the same behavior and isolation as VRFs.

SGTs (Micro-segmentation) — SGTs allow for simple-to-manage group-based policies and enable granular data plane isolation
between groups of endpoints within a virtualized network. Using SGTs also enables scalable deployment of policy without
having to do cumbersome updates for these policies based on IP addresses.

Protocol Operational Planes Overview

This chapter is organized into the following sections:

_

Protocol Operational Planes Control Plane Protocols

Data Plane Protocols

Policy Plane Protocols

In SD-Access the control plane is based on Locator/ID Separation Protocol (LISP), the data plane is based on Virtual Extensible
LAN (VXLAN), the policy plane is based on Cisco TrustSec and the management plane is enabled and powered by Cisco DNA
Center.

In SD-WAN the control plane is based on Overlay Management Protocol (OMP), the data plane is based on IPSec/GRE, the policy
plane is not limited to Layer 3 through Layer 7 information and can incorporate Service Level Agreements managed by vSmart,
and the management plane is enabled and powered by vManage.

An overview of each of these protocols is provided in this section. The interaction of these protocols and how they are used to
carry segmentation, policy, and traffic end-to-end is discussed in the next section.

Tech tip

For additional details on the SD-Access protocols, see: SD-Access Operational Planes in the Cisco SD-Access Solution Design Guide.
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Control Plane Protocols

Cisco SD-Access leverages LISP control plane to communicate and exchange the endpoint’s identity (EID) in relationship to its
routing locator (RLOCs). The fabric devices query the control plane nodes to determine the RLOC information associated with
the destination address (EID-to-RLOC mapping) and use the RLOC information as the traffic destination.

Cisco SD-WAN leverages OMP to communicate and exchange the route prefixes, next-hop routes, crypto, and policy information
between WAN Edge routers and vSmart controllers. The LAN Segment routes are redistributed into OMP and advertised to the
vSmart controller. The vSmart controller then redistributes these learned routes to other WAN Edge routers in the SD-WAN
network.

Data Plane Protocols

Cisco SD-Access uses VXLAN as the encapsulation method for data packets. When encapsulation is added to the data packets, a
tunnel network is created between the fabric devices. The fabric devices place additional information in the fabric VXLAN
header, including attributes that can be used to make forwarding decisions by identifying each overlay virtual network using
VXLAN network identifier (VNI) and policy decision with the Scalable Group Tag. At minimum, these extra headers add additional
50 bytes of overhead to the original packet.

Figure 4. VXLAN-GBP (VXLAN-GPO) Packet Header
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Cisco SD-WAN secures the data traffic with IPSec authentication and encryption. The secure data plane connection is established
at the time of the WAN Edge onboarding process to ensure data plane integrity.

Cisco WAN Edge devices support MPLS extensions to data packets that are transported within IPsec connections. These
extensions provide the ability to carry the network segmentation (Virtual Network ID) information across the WAN environment.

Cisco I0S XE 17.3.1a introduced Cisco TrustSec capabilities, which adds an additional 8 bytes header. This header, Cisco Meta
Data or MDATA, is used to carry the SGT in the WAN environment.

Figure 5. SD-WAN IPSec Packet Header
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Policy Plane Protocols

The Cisco SD-Access solution leverages the Cisco TrustSec solution as the policy plane. The solution is defined in three phases:
classification, propagation, and enforcement. Cisco TrustSec implementation uses ingress classification and egress enforcement.
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Classification — An SD-Access Edge Node sends user and device authentication requests to the ISE Policy Services Node (PSN)
persona via RADIUS packets. The ISE Policy Service Node persona provides the scalable group tag (SGT) as part of the
authorization profile. This provides an association between the SGT and the endpoint.

Propagation — Any data traffic from the endpoint traversing the Edge Node is tagged with the SGT value. This SGT information is
carried to the fabric node in a VXLAN-encapsulated packet.

Enforcement — Security policies relevant to the SGT are downloaded from ISE PSN persona and installed on the fabric edge for
policy enforcement. The fabric edge only downloads policies relevant to directly connected endpoints. The destination fabric
node leverages the SGT information in the VXLAN data packet and SGT value of the directly connected endpoint for policy
enforcement at the destination egress direction.

Cisco SD-Access | Cisco SD-WAN Pairwise Integration Overview

The focus of the SD-Access | SD-WAN Pairwise Integration is to connect multiple, independent SD-Access fabric sites using a
Cisco SD-WAN transport. This transport preserves the macro- and micro-segmentation constructs of virtual network (VN) and
security group tags (SGTs), respectively. This enables secure endpoint onboarding, consistent user experience, and consistent
end-to-end security policies across the enterprise for any user, any device, or any application that are anywhere on the network.

The SD-Access | SD-WAN Pairwise Integration can be deployed in three ways:

e [ntegrated Domain

e Independent Domain

e Both

Integrated Domain Deployment

In this deployment approach, the SD-WAN controllers and Cisco DNA Center are integrated together. This allows for the sharing
of network device information and configuration between the controllers for an end-to-end automation and seamless
integration. In this model, the SD-WAN Edge functionality is colocated with the SD-Access Border Node and Control Plane Node
functionality on the same device.

Cisco SD-Access | SD-WAN Integrated Domain integration provide the capability of carrying end-to-end segmentation and policy
with the simplicity of managing the domains together. This is best suited for a branch or remote location across the WAN.

Independent Domain Deployment

In this deployment approach, the SD-WAN controllers and Cisco DNA Center are not integrated. The SD-Access fabric roles are
deployed on one set of network devices, while the SD-WAN Edge functionality is deployed on a separate set of network devices.
In this deployment, the SD-Access components are managed independently by Cisco DNA Center, and Cisco SD-WAN
components are managed independently by the vManage controller.

Cisco SD-Access | SD-WAN Independent Domain integration provide the capability of carrying end-to-end segmentation and
policy with the flexibility of managing the domains independently. Using Inline tagging and 802.1Q tags, the segmentation
constructs are carried across the independent domains.

Hybrid Independent and Integrated Domain Deployments
This model allows enterprises with multiple fabric sites to deploy a combination of Independent Domain and Integrated Domain

deployment models across their networks.

This deployment model is commonly seen in branch deployments with centralized headend locations. At the branch locations,
the SD-Access functionality and SD-WAN functionality are colocated on the same device(s). At the headend location, the SD-
Access and SD-WAN functionality are deployed on separate devices.

© 2021 Cisco and/or its affiliates. All rights reserved. Page 12 of 148


bookmark://Both_Domains_Deployment/

Figure 6. Independent Domain at Headend and Integrated Domain at Branch
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Tech tip

An SD-Access fabric site can be deployed with the Independent Domain model or the Integrated Domain model. Both models cannot be
deployed together at the same fabric site.

Integrated Domain Protocol Integrations

This chapter is organized into the following sections:

_

Integrated Domain Protocol Integrations Control Plane Integration

Data Plane Integration

Policy Plane Integration

Putting It All Together

Control Plane Integrations — Integrated Domain

In the Integrated Domain Pairwise Integration, the WAN Edge device performs WAN Edge, colocated fabric Border and Control
Plane functionality. SD-Access control plane protocol (LISP) is redistributed into SD-WAN control plane protocol (OMP) and vice
versa to share routes across the sites. Each virtual network in the SD-Access environment is mapped to a dedicated service VPN
in the SD-WAN environment. This ensures routes are shared across mapped segment and provide end-to-end segmentation
across the WAN environment.

Data Plane Integrations — Integrated Domain

The data traffic in the SD-Access fabric site is VXLAN encapsulated. The VXLAN header carries the virtual network and scalable
group tag from the Edge Node towards the Border Node or towards another Edge Node and vice-versa. The WAN Edge device,
also the fabric Border Node, decapsulates the VXLAN packet and performs route lookup to determine the egress interface to
reach the remote-site across the SD-WAN fabric in that segment. The VPN and SGT learnt from the SD-Access network is carried
across the WAN transport to the remote site.

The remote-site WAN Edge device decapsulates the IPSec data packets. Based on the VPN ID information in the MPLS label
header, the packet is forwarded into the appropriate SD-Access virtual network. The WAN Edge device copies the VPN and SGT
in the IPSec header to the SD-Access VXLAN packet, before forwarding the data traffic at the SD-Access fabric segment,
preserving the segment information in the data plane.

Policy Plane Integrations — Integrated Domain

In the Integrated Domain Pairwise Integration, the SGT is extracted from the fabric VXLAN header (VXLAN-GPO) by the Border
Node and placed in the CMD header of the IPSec packet. The Border Node, also the WAN Edge device, carries the SGT into the
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IPSec CMD header. This allows the SGT to be carried across WAN transport to other SD-Access fabric sites. Once received by the
WAN Edge router on the other side of the IPSec tunnel, the process of transferring the SGT occurs in reverse. The SGT is copied
back to the VXLAN header and carried in the fabric segment. This preserves the end-to-end segmentation in the policy plane.

Figure 7. Integrated Domain Protocols Integrations
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Putting It All Together

Cisco DNA Center provides network operators the ability to automate the LAN segment with SD-Access workflows. Cisco
vManage SD-WAN Controller provides WAN segment automation with feature templates. In the Integrated Domain deployment
model, the domain controllers are integrated from the Cisco DNA-Center by providing SD-WAN vManage controller details.

The secure integration between the controllers allows to share information through RESTful API calls. The respective domain
orchestrator owns the workflow and configuration generation:

e SD-WAN vManage controller owns the WAN configuration generation and provision.

e Cisco DNA Center owns the SD-Access configuration generation and provisioning to all LAN segment network devices
with the exception of WAN Edge devices.

o Cisco DNA-Center builds and shares the required fabric configuration to the vManage SD-WAN controller to provision the
WAN Edge with colocated Border and Control Plane functionality.

This provides enterprise deployments the flexibility to integrate the two domains together with the ability to securely onboard,
provision the network devices and extend the benefits of Cisco SD-Access across sites, maintaining end-to-end segmentation
and consistent policy across sites.

With the Integrated Domain deployment:

e The Virtual Network segmentation in the Cisco SD-Access environment is mapped to corresponding service VPN on the
WAN Edge device to extend the macro-segmentation.

e The Scalable Group Tag is carried from the Cisco SD-Access environment to the WAN environment natively in the data
plane.
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e The WAN Edge device, also the fabric Border and Control Plane node, transfers the SGT data from the VXLAN into IPSec

data packet header and carries it across the WAN environment, preserving the micro-segmentation.

Figure 8. VXLAN to Inline Tagging to IPSec
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Design

This chapter is organized into the following sections:

O

Design SD-WAN Flexible Topologies Overview

SD-WAN High Availability Topologies

SD-Access Flexible Topologies Overview

Flexible Topologies Integration

Integrated Domain Design Considerations

This section discusses design consideration, provides an overview of the topology used in this guide, and deployment steps to
build distributed SD-Access fabric sites interconnect with the SD-WAN transport using the Integrated Domain deployment
approach.

SD-WAN Flexible Topologies Overview

Cisco SD-WAN solution provides flexibility in creating various WAN overlay topologies. By default, Cisco WAN Edge devices
establish full-mesh IPSec data plane connections with other WAN Edge devices in the SD-WAN overlay infrastructure. Depending
on the size of the network, it might not be desirable to build full-mesh WAN topology, either due to routing platform limitations
or the number of tunnels the router can support.

Based on the deployment requirements, the SD-WAN overlay network can be modified to establish hub-and-spoke, partial-
mesh, or a combination of both with simple control policies defined in vManage. Additionally, any SD-WAN specific use cases,
such as Direct Internet Access (DIA), Application-Aware Routing, and App QoE can be provisioned and monitored from vManage.

Refer to Cisco SD-WAN Design Guide for design recommendations and best practices to build SD-WAN infrastructure.

Figure 9. SD-WAN Hub-and-Spoke Deployment
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Figure 10.  SD-WAN Partial-Mesh Deployment
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Figure 11.  SD-WAN Full-Mesh Deployment
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SD-WAN High Availability Topologies

High Availability in the SD-WAN network can be achieved through several different topologies. For high availability in the

physical network, a WAN Edge device can connect to multiple WAN transports. For high availability in the physical network and
physical devices, two WAN Edge devices can be deployed in a dual multihomed topology where both WAN Edge devices connect
to both WAN transports. For environments that cannot dual multihome, an alternative is single multihoming. Each WAN Edge

device is connected to a single WAN transport, and the TLOC extension is used between the routers to connect to the other

WAN transport.
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Figure 12.  Single WAN Edge Dual Homed
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SD-Access Flexible Topology Overview

Having a well-designed network foundation on which to build the overlay ensures the highest stability, performance, and most
efficient utilization of the SD-Access network. This underlay network foundation can be built manually, which provides the
largest degree of configuration granularity, or it can be automated through Cisco DNA Center LAN Automation. LAN Automation
is the Plug-n-Play (PnP) zero-touch automation of the underlay network in the SD-Access solution. The simplified procedure
builds a solid, error-free underlay network using the principles of a Layer 3 routed access design.

Whether using Layer 2 switched access or Layer 3 routed access, the network should utilize full-mesh, equal-cost routing paths
leveraging Layer 3 forwarding in the core and distribution layers of the network to provide the most reliable and fastest
converging design for those layers. For optimum convergence at the core and distribution layer, build triangles, not squares, to
take advantage of equal-cost redundant paths.

Refer to Cisco SD-Access Solution Design Guide - Underlay Network Design Chapter for design recommendations and best-
practices to build SD-Access infrastructure.

When deploying the SD-Access fabric nodes, the reference network architecture provisions the fabric roles in the same way the
underlying network architecture is built: distribution of function. Separating roles onto different devices provides the highest
degree of availability, resilience, deterministic convergence, and scale.

For Integrated Domain deployment, the SD-WAN WAN Edge device must be colocated with the SD-Access Border and Control
Plane nodes functionality. This provides deployment flexibility for medium to small sites by co-locating the Border and Control
Plane node and integrating embedded wireless on the Edge Node or with dedicated SD-Access Wireless Controller at the site for
scaled environment. These solution deployment options provide flexibility to design a zero-trust, highly resilient, and always-
available wired and wireless infrastructure, as shown in Figure 15.

Refer to Cisco SD-Access Solution Design Guide for further design recommendations and best practices to build SD-Access
infrastructure.

Flexible Topology Integration

With Integrated Domain SD-Access | SD-WAN Pairwise Integration, the SD-Access fabric sites must be new deployments. The
SD-WAN WAN Edge routers at these locations can be new or existing network. Integrated Domain provides significant flexibility
by integrating the two domains and preserving:

e End-to-end macro- and micro-segmentation across the enterprise.
e Consistent policy for wired and wireless across the fabric sites.

e Consistent network access experience for any users, any device, any application at any location in the network.
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Figure 15.  Flexible Topologies Example
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Integrated Domain Design Considerations

This chapter is organized into the following sections:

_

Design Considerations Service VPN and VN Considerations

Underlay Infrastructure Considerations

MTU Considerations

Cisco SD-Access Fabric site considerations

Macro-Segmentation considerations

Micro-Segmentation Considerations

Route-leaking Options

SNMP and Syslog considerations

Network Assurance and Visibility

Latency Considerations

Platform Requirements

SD-Access Scale Considerations

SD-WAN Edge SGT Forwarding Interoperability

Deployment Limitations

Service VPN and VN Considerations

Cisco SD-WAN components have two predefined Service VPNs: VPN 0 and VPN 512. WAN Edge devices leverage routes in VPN 0,
which is associated with the WAN Global Routing Table (GRT), to securely connect to the SD-WAN controllers and establish
secure control and data plane connections with other SD-WAN routers. VPN 512 is the Management VPN that provides out-of-
band (OOB) management access for the SD-WAN devices.

Network administrators can configure additional Service VPNs to segment the LAN traffic across the WAN environment. The
supported VPN numbers are VPN 1 through VPN 511 (1-511) and VPN 513 through VPN 65500 (513-65500). Other VPNs IDs are
reserved for internal use by the WAN Edge device and should be avoided as the routes in these reserved VPN IDs are not shared
across the WAN environment.

Each Layer 3 Virtual Network in the SD-Access environment is mapped to a corresponding Service VPN in the SD-WAN
environment. The SD Access fabric site underlay, which is part of the global routing table (GRT), is mapped to a dedicated Service
VPN on the WAN Edge device. This Fabric GRT Service VPN must be used at all sites to provide end-to-end IP reachability for the
network devices.
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Tech tip

The SD-WAN Global Routing Table uses VPN 0 to build the WAN fabric across WAN transports. The SD-Access Global Routing Table maps
to a user-defined SD-WAN Service VPN. The SD-WAN GRT and SD-Access GRT do not need to communicate with each other and are not
mapped together.

Mapping of SD-WAN Service VPN to Cisco SD-Access Virtual Network in DNA Center must be complete before SD-Access fabric site is
created.

Underlay Infrastructure Considerations

Cisco SD-WAN Orchestrators take ownership of securely onboarding the WAN Edge devices and building resilient secure WAN
network. The vManage controller integrated in Cisco DNA Center shares the selected WAN Edge devices part of the Integrated
Domain integration with the Cisco DNA Center.

The shared WAN Edge devices can then be leveraged with Cisco DNA Center SD-Access workflow to build Fabric GRT
infrastructure. The Cisco SD-Access fabric site’s underlay is defined by the physical switches and routers that are used to deploy
the SD-Access overlay network. Establish a stable, resilient, and fast converged underlay either manually or using LAN
Automation.

The WAN Edge device part of the Integrated domain integration can be configured as LAN Automation Seed devices to discover
and configure the LAN segment network devices. LAN Automation provisions IS-IS routing protocol to provide Fabric GRT LAN
connectivity at the site. Cisco DNA Center generated LAN Automation configuration for the WAN Edge device is shared with
vManage orchestrator, to provision the WAN Edge device(s).

Alternatively, LAN segment can be manually configured and can leverage OSPF, EIGRP feature templates to build connectivity
between the WAN Edge and the access layer.

Refer to the Cisco SD-Access Design Guide on design requirements and recommendations to build resilient and highly available

networks for an SD-Access deployment.

Tech tip

The WAN Edge device must be provisioned with /32 host mask ip address for Loopback 0 interface and should be part of Fabric GRT
Service VPN.

The WAN Edge interfaces that connect to the LAN segment should be associated to the Fabric GRT Service VPN.
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Figure 16.  SD-Access VN and SD-WAN Service VPN — Mapping Across the Enterprise
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MTU Considerations

Cisco SD-Access VXLAN header adds an additional 50 bytes, and optionally 54 bytes, of encapsulation overhead. On switching
platforms in SD-Access, the MTU is increased at the system level with the ‘system MTU <mtu value> command, which tunes the
MTU on all the interfaces. On routing platforms, the MTU is set per interface using the command ‘mtu <mtu value>" on the
physical interface.

Cisco SD-WAN Edge devices use the default MTU of 1500 bytes on the physical interface and this can be increased to a
maximum MTU of 2000 bytes on the LAN-segment interfaces. To accommodate ethernet jumbo packets across the LAN
segment, configure the WAN Edge device interface with MTU of 2000 bytes in the Cisco VPN Interface Ethernet feature
template.

Tech tip

Fabric GRT network devices discovered and configured with Cisco DNA Center LAN Automation workflow will be provisioned higher
MTU of 9100 bytes. The Seed device, WAN Edge device interface connecting the fabric site LAN segment is provisioned with MTU of
9100 bytes along with the system-mtu of 9100 bytes on the discovered switches.

MTU within the SD-WAN environment is addressed using Bidirectional Forwarding Detection (BFD) packets. These packets are
used to periodically probe each WAN transport for path liveliness and quality, which includes tunnel status, loss/latency/jitter,
and IPSec tunnel MTU. WAN Edge devices use this probing information to natively fragment and reassemble the packet before
forwarding them on the WAN transport.

Cisco SD-Access Fabric Site Considerations
Before SD-Access fabric site is created, the following must be completed in Cisco DNA Center:

e Service VPN is associated to Virtual Network
e Network devices, including the SD-WAN WAN Edge devices are discovered with loopback 0 interface

o Network devices are provisioned to a site.
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With the completion of the above, create fabric Site, associate fabric roles and connect IP-Transit or SD-WAN Transit or both.
Note that the SD-WAN Transit is created in Cisco DNA Center on successful integration between the domain controllers. The
WAN Edge part for the Integrated Domain integration is required to be associated with colocated Border and Control Plane
Node functionality.

Macro-Segmentation Considerations

Cisco SD-Access overlay prefixes for each virtual network, advertised in LISP, is redistributed to corresponding Service-VPN SD-
WAN control plane (OMP). This ensures control plane separation from one domain to another across the WAN environment.

By default, the WAN Edge device advertise /32 host prefixes from the fabric site LISP database to the SD-WAN OMP routing
protocol. This can be modified by adding the overlay client prefixes in the Advertise OMP section of the Cisco VPN templates for
each Service-VPN and advertise aggregate only for each virtual network.

Figure 17.  Extending Macro-Segmentation — SD-Access VN to SD-WAN Service VPN
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Micro-Segmentation Considerations

The WAN Edge device, also the fabric Border, terminates the VXLAN encapsulated packets from the LAN segment fabric nodes.
The device copies the scalable group value from the VXLAN header into the IPSec CMD header for traffic destinated to remote-
sites connected through the SD-WAN WAN environment.

At the remote-site the WAN Edge device copies the scalable group value form the IPSec CMD header to the VXLAN header
before forwarding the traffic to the SD-Access fabric environment. This ensures the micro-segmentation information is carried
natively in the data-plane across the domains.
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SNMP and Syslog Considerations

SNMP and Syslog statistics on the WAN Edge router and LAN network devices are collected by Cisco DNA Center. It is
recommended to leverage Cisco DNA Center, Network Setting > Device Credentials workflow to configure the device credentials,
SNMPv2/SNMPv3 and Syslog parameters to the network devices across the enterprise infrastructure.

Network Assurance and Visibility

Visibility of SD-WAN WAN Edge device health, WAN transport health and Application statistics across the WAN transports are
monitored in the SD-WAN vManage controller. Network Assurance from the fabric nodes are monitored in Cisco DNA Center. In
the Integrated Domain integration

¢ SNMP and Syslog statistics for the WAN Edge are destined to Cisco DNA Center.

e Cisco DNA Center provides Site-level Topology, Network health, Network level Issues and Events, Device 360 and Client
360 visibility

¢ SD-WAN vManage provides WAN Edge device-level visibility into Inventory, Control Status, Site Health, Device Health,
Transport Health and Events.

Latency Considerations

Latency in the network is an important consideration for performance, and the RTT between Cisco DNA Center and any network
device it manages must be taken into strict account. The RTT should be equal to or less than 100 milliseconds to achieve optimal
performance for all solutions provided by Cisco DNA Center, including SD-Access. The maximum supported latency is 200 ms
RTT. Latency between 100 ms and 200 ms is supported, although longer execution times could be experienced for certain
functions, including inventory collection, fabric provisioning, SWIM, and other processes that involve interactions with the
managed devices.

Figure 18.  Cisco SD-Access Latency Requirements
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**%* |SE to NAD communication, including TrustSec, uses RADIUS; RTT is therefore based on RADIUS requirements.

Platform Requirements

Cisco SD-Access | SD-WAN Integrated Domain Integration requires the network device to perform SD-WAN WAN Edge
functionality and SD-Access colocated Border and Control Plane functionality.

Tables 1 list the supported hardware devices.
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Table1l. Integrated Domain SD-WAN Edge Supported Platforms

Supported Cisco hardware Additional details

ISR 4331 Series Routers 2> 8G Memory
ISR 4351Series Routers > 8G Memory
ISR 4400 Series Routers > 8G Memory
ASR 1001-X Series Routers > 8G Memory
ASR 1002-X Series Routers 2> 8G Memory
ASR 1001-HX Series Routers > 8G Memory
ASR 1002-HX Series Routers > 8G Memory

Cisco Catalyst® 8300 Series Edge Platforms > 8G Memory
Cisco DNA Center 22.1.2.6
10S XE 217.3.3

SD-Access Scale Considerations

SD-Access has a number of scaling components that must be taken into consideration. Platform-specific scale includes items
such as the number of endpoints, the number of virtual networks, the number of routes, and the number of SGTs. Cisco DNA
Center has scale components, such as the number of fabric sites, the number of fabric devices within a site, and the total
number of concurrent endpoints. For details, consult the SD-Access Platform Scale, Appliance Scale, and fabric VN Scale Tables
in the Cisco DNA Center data sheet.

Table 2 list the scaling numbers for the WAN Edge platforms that are part of the Integrated Domain integration

Table 2.  Integrated Domain WAN Edge platform scale numbers

Virtual Networks (VNs) Max EID per VN Max EID Entries

ASR Series Routers 5,000 50,000

ISR Series Routers 10 1,000 10,000

SD-WAN Edge SGT Forwarding Interoperability

The Cisco SD-WAN solution can contain WAN Edge devices running either I0S-XE SD-WAN or Viptela software. For the Cisco SD-
Access | SD-WAN Pairwise Integration, it is required to deploy supported I0S-XE SD-WAN Edge devices running >17.3.2a.

Table 3 shows the interoperability behavior for various WAN Edge platforms and their corresponding software version with
respect to carrying SGTs in the data plane.
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Table3.  SD-WAN Traffic Forwarding Interoperability
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without SGT

Traffic is sent
without SGT

Traffic is sent
without SGT

Traffic is sent

without SGT
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without SGT
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SGT

Traffic is sent without

SGT

Traffic is sent without
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Deployment Limitations

Integrated Domain integrates Cisco SD-Access and SD-WAN solution natively on the same WAN Edge device. This integration
model is ideal, but not limited, for remote-branch deployment. The ability to fully automate the WAN and the LAN segment at
remote sites, provides business the ability to deploy Zero-Trust Branch site faster, securely and provide consistent user
experience.

Below lists the design constrains before considering the Integrated Domain deployment approach:
e Cisco SD-WAN WAN fabric infrastructure is built first followed by SD-Access network.
e Cisco IOS-XE WAN Edge device must be in vManage mode.
e Cisco SD-Access Border and Control Plane functions must be colocated on the I0S-XE SD-WAN WAN Edge router.
e A maximum of 2x colocated SD-Access | I0S XE WAN Edge devices are supported per SD-Access fabric site.
e Cisco SD-Access Border node should be configured as External-Only node.

e Group-Based policy enforcement is not supported on the I0S-XE WAN Edge devices.
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¢ The following features are not supported on the colocated SD-Access | I0S-XE WAN Edge device:
o Multicast
o IPv6
o Layer 2 Flooding
o Layer 2 Border Handoff
o SD-Access Transit

o MultiSite Remote Border

Deploy

This chapter is organized into the following sections:

_

Deploy Deployment Topology Overview

Deployment Prerequisites

Deployment Steps

This section provides an overview of the topology used throughout this guide and covers the prerequisites and steps needed for
this Integrated Domain deployment.

Deployment Topology Overview

The validation topology has two SD-Access fabric sites connected via a Cisco SD-WAN fabric, representing multiple locations. The
Cisco SD-WAN controllers are deployed in the enterprise private cloud. The WAN Edge routers are connected to SD-WAN fabric
across public-internet and MPLS WAN transports.

At branch site, the single WAN Edge device part of the Integrated Domain deployment is directly connected to fabric Edge and
to WAN transports.

At the headend location, the two WAN Edge devices are connected to fabric Edge devices, WAN transports and also the IP-
Transit for reachability to shared-services network. At this site, embedded-wireless on Catalyst 9000 is deployed.

Cisco DNA Center, the Identity Service Engine, and shared services such as the DHCP, DNS, and Windows Active Directory (AD)
servers are deployed at an on-premises data center that is accessible through the IP-Transit.
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Figure 19. Deployment Topology
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Deployment Prerequisites

Before beginning with this guide, the following items must be completed in advance.

e Cisco SD-WAN Controllers (vManage, vBond, and vSmart) are deployed with valid certificates.

e Cisco WAN Edge devices are onboarded and have established secure control connections with the Cisco SD-WAN
controllers and secure data plane connections to the other WAN Edge devices in the SD-WAN environment using all
available WAN transports.

e Cisco DNA Center is installed and integrated with the Identity Services Engine as an Authentication and Policy Server.

e The Design Application in Cisco DNA Center is appropriately configured for the deployment. This includes the network
hierarchy and network settings such as device credentials, IP address pools, and wireless settings for each fabric site
(optional).
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Deployment Steps

The validated deployment is divided into the following processes and procedures:

Verifying Prerequisites for Integrated Domain Verify the SD-WAN infrastructure

Verify the WAN Edge secure data plane connections

Verify Cisco DNA Center is installed with SD-Access Application

Verify Cisco DNA Center is integrated with ISE

Verify Cisco DNA Center design application configuration

Associating |I0S-XE WAN Edge device with Service VPN Configuring Service VPN

Configuring ethernet interface for loopback 0

Associate VPN and ethernet template to the WAN Edge device

Integrating the domain controllers Integrating vManage in Cisco DNA Center

Associating I0S-XE WAN Edge devices to participate in the Integrated-Domain
integration

Provision the I0S-XE WAN Edge devices to participate in the Integrated-Domain
integration

Mapping Service VPN to Virtual Network in Cisco DNA Center

Associate Scalable Groups to Virtual Networks

Configuring LAN Segment manually Creating Interface template connecting to the LAN segment

Configuring routing protocol template to form LAN segment routing adjacencies

Associating interface, routing protocol templates on the I0S-XE WAN Edge device

Discover and Provision the network devices to a site

Configuring LAN Segment with LAN Automation Initiate LAN automation

Provision Cisco SD-Access Fabric Site(s) Provision the network devices to a site

(Optional) Provision IP - Transit Network

Provision Fabric — Create Fabric Site

Provision Fabric — Configure Host Onboarding

Configure WAN Edge to advertise aggregate-summary routes for associated IP
Address Pool

(Optional) Provision Fabric — Port Assignment

Defining Group-Based Access Control Policies Configure Group-Based Access Control policies

© 2021 Cisco and/or its affiliates. All rights reserved. Page 30 of 148



Process 1: Verifying Prerequisites for Integrated Domain

Before beginning the Integrated Domain deployment, the SD-WAN and SD-Access controllers must be deployed.

Procedure 1. Verify the SD-WAN infrastructure

Use this procedure to verify that vManage, vBond, vSmart, and the WAN Edge devices are successfully onboarded, in a healthy
state, and that they are running their applicable software versions.

Step 1. LogintovManage and navigate to Dashboard > Main Dashboard.
Step 2.  Verify the state of vManage, vBond, vSmart, and the WAN Edge devices.

The 1 green up arrow indicates a healthy, onboarded state.

Cisco vManage

(M| 25 DASHBOARD | MAIN DASHBOARD
o o] Warning 0
@ 1 9 3 g 1 c 1 Reboot 0 L Q— 0
& vSmart -1 WAN Edge - 3 U vBond -1 vManage - 1 614
R control Status (Total 3) Site Health (Total 2) Transport Interface Distribution
-
Control Up Full WAN Connectivity 0 sites <10 Mbps 25
2 10 Mbps - 100 Mbps 0
- Partial Partial WAN Connectivity 2 sites 100 Mbps - 500 Mbps 0
> 500 Mbps 0
Control Down 0 ©  NoWAN Connectivity 0 sites

View Percent Utilization

Step 3. InvManage, navigate to Monitor > Network.

Step 4. Select the device from the WAN - Edge list.

Cisco vManage

L MONITOR | NETWORK

WAN - Edge | Colocation Clusters
o
e J—
o VPN Group Avail -
s ®0e
2 Device Group | * - Q, Sear - Total Rows: 6
o e T e I T e e S T e
U vmanage 1m1nn vManage 174f932e-6b11-4f3e-a666-82884df ... reachable n 4 2034 07 Sep 2021 10:09:00 AM PDT "No groups” mnnn”
- 12121212 vSmart c51ffbc4-88f8-475a-8f55-031911 reachable 1 - 7 2034 07 Sep 2021 10:09:00 AM PDT "No groups” 1A
13131313 vEdge Cloud (vBo... 39563661-3b52-4c62-847e-3(266. reachable 1 - 2034 07 Sep 2021 10:08:00 AM POT No groups ARIRERE
11190 ASR1001-X ASR1001-X-JAE204100WU reachable 10 4 3 17.03.042.0, 5574 09 Sep 2021 7:30:00 AM PDT ‘No groups” 11.11.11.17
1.1.m ASR1001-X ASR1001-X-JAE203201XB reachable 10 3(4) 3 17.03.04a.0.5574 09 Sep 2021 7:43:00 AM PDT "No groups” 111111117
@R:"\.‘ISRA;;I 18 121272 ISR4331 ISR4331/K9-FDO2012092M reachable 12 7(8) 3 17.03.02.0.3263 18 Aug 2021 8:42:00 AM PDT No groups AARAREREN

Step 5. Select Control Connections from the left panel to view the device control connections status.

Verify the DTLS sessions are established with the SD-WAN controllers across the available WAN transport
connections.
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Cisco vManage

L MONITOR Metwork > Control Connections
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TLS/SSL Decryption vsmart 12121212 dils 12446 12446 ] 11 Sep 2021 5:13:09 AM PDT
vmanage (RRIRERT] dils 12446 12446 a 09 Sep 2021 7:31:14 AM PDT

Unibrella DNS Re-direct

Control Connections

Step 6. In vManage, navigate to Monitor > Network.
Step 7.  Verify the State, Reachability, BFD, Control, and Version sections for the devices.

The desired State is V.

e The desired Reachability is reachable.
e BFD and Control will vary based on the deployment though should have non-zero numbers.
e The IOS-XE WAN Edge Version is 17.03.04a.

Cisco vManage
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@Riu ISR4331-18 1212121 ISR4331 ISR4331/K9-FDO2012092M reachable 12 7(8) 3 17.03.02.0.3263 18 Aug 2021 8:42:00 AM PDT “"No groups” RARRRERLE

Procedure 2. Verify the WAN Edge secure data plane connections

Step 1. InvManage, navigate to Monitor > Network.
Step 2.  Select the device from the WAN - Edge list.
Step 3. Select WAN > Tunnel option from the left panel.

Step 4. Verify the WAN Edge device has successfully established data plane connections to other WAN Edge devices across
the WAN environment.

e The desired State is 1.

e The desired Protocol is IPSEC.
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Cisco vManage

(A ) moNITOR WAN - Tunnel

Select bevice - 10 Devos Model ASRIGTX @)

Applications

DPI Appiications

FEC Recovery Rate

(¥ ResiTima] 1h 2h 6h 1z anoaE e

R public-internet RS12-1SR4331-18:publicint...  GigabitEthernet0/1/5 Giga... - PSEC

public-intemet-RS12-1SR4331-1 E:mple GlgabitEthemet0/0/5-Giga PSEC

X1 mpls RS12- Gigabit

001X-1mpls-RS12-1S GigabitEthemet0/0/4-Gig:

Security Monitoring

Procedure 3. Verify Cisco DNA Center is installed with the SD-Access application

- | ) 1

ssup
2 11 Sep 1 1 Sep 11 P 1 Sep 11 P 1 Sep 11 P 1 n 11 p 1 11 Sep 1 Sep ep 12
iace
- wtetocs Endocins, Lol ntefece Desrpton and Remote e Desciphon s Wik b deful. Pisasa lckonth Cokams dropcown o ihaighto enabiethem) oY=
TP Optmzatios Q e ptons Tetal ows: 4
P # o) O 4 o ca

o 10.00 B
0o 10.00 8
oo 10.00 ]
oo 10.00 8

Step 1. Login to Cisco DNA Center, and navigate to System > Software Updates,
Step 2.  Select Installed Apps from the left panel.

Step 3. Under the Automation section, verify SD Access is installed.

Cisco DNA Center

Q @& @ 4o

stem Healtk

View Details

ystem

1 Explore
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nel X
Critical Issues Trends and Insights
Last 24 Hours Last 30 Days
P P2 Throughput Coverage Capacity

View Details
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= Cisco DNA Center System . Software Updates Q @ ® &»

Updates Installed Applications

Installed A;
I — . Cisco DNA Center Core

Automation - Base ' 2.1.365.62360 ninstall
Cisco DNA Center Ul 1.6.2.432 J
Cloud Connectivity - Data Hub 1.6.0.380
Cloud Connectivity - Tethering 2.12.1.2
Disaster Recovery 2.1.364.362034
NCP - Base 2.1.365.62360
NCP - Services 2.1.365.62360
Network Controller Platform 2.1.365.62360
Network Data Platform - Base Analytics 1.6.1019
Network Data Platform - Core 1.6.579 tall
Network Data Platform - Manager * 1.6.541
Network Experience Platform - Core 2.1.365.62360
RBAC Extensions ! 2.1.364.1910003 tall
System Commons ¢ 2.1.365.62360 Uninstall
Automation
Application Hosting 1.6.0.2107090810 Uninstall
Application Policy 2.1.364.170201 1
Application Registry 2.1.364.170201 stz
Application Visibility Service 2.1.364.170201 Uninstall
Cisco Umbrella 2.1.364.592099 Uninstall
Cloud Device Provisioning Application ' 2.1.365.62360
Command Runner 2.1.365.62360
Device Onboarding * 2.1.365.62360
Image Management i 2.1.365.62360

| D Access ¢ 2.1.365.62360 |
Stealthwatch Security Analytics / 2.1.364.1091088
Wide Area Bonjour 2.4.363.75002 Uninstall

Procedure 4. Verify Cisco DNA Center is integrated with the Identity Services Engine

Step 1. In Cisco DNA Center, navigate to System > Settings.
Step 2.  Under External Services, select Authentication and Policy Servers from the left panel.

Step 3.  Verify the ISE server is integrated and in ACTIVE state.

= Cisco DNA Center a e @ o

2Q Search Settings Settings / Extemal Services
PnP Device Authorization 1 1 H
Authentication and Policy Servers
| External Services v |
Use this form to specify the servers that authenticate Cisco DNA Center users. Cisco
Umbrella Identity Services Engine (ISE) servers can also supply policy and user information.
|| Authentication and Policy Servers |
@ Add v Export As of: Sep 12, 2021 3:00 PM

Authentication Tokens

Integrity Verification IP Address Protocol Type Status Actions

vManage
4.250.225 RADIUS_TACACS ISE ACTIVE
IP Address Manager

Cisco Al Analytics

Stealthwatch

Procedure 5. Verify Cisco DNA Center design application configuration

Step 1.  In Cisco DNA Center, navigate to Design > Network Settings > Network.

Step 2.  Under the appropriate site hierarchy make sure the AAA Server, DHCP Server, DNS Server, and NTP Server are
configured.
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Cisco DNA Center aQa @ @ o

I Design - Network Settings I

Device Credentials IP Address Pools SP Profiles Wireless Telemetry

@ ~dd servers

Configure AAA, NTP, and Image Distribution (SFTP) servers using the " Add Servers” link. Once devices are discovered, DNA Center will deploy using

Find Hierarch
Q Find Hierarchy these settings.

~ ¢ Global

AAA Server ©
~ & North America
Network Client/Endpoint
> & Region - NY
NETWORK
~ & Region - RTP
I 4 Reglon Servers Protocol
~ [ RTP-06 ®) 158 O asa (®) RaDIUS QO 1acacs
£2 Floor-01 Network 1P Adéress (Primary) 0O 1P Address (Additional)
& Floor-02 10.4.250.225 w o 10.4.250.228 % w  10.4.250.229 x
£ Floor-03

Change Shared Secret
> & Region - SJ 9

CLIENT/ENDPOINT

Servers Pratocal
@ 1se O ana (® rapus O
Client/Engpoint = 1P Address (Primaryl = © 1 Adaress (Additional) =

10.4.250.225 % s 10.4.250.231 x s 10.4.250.232 ®

Change Shared Secret

DHCP Server =
DHCP
10.4.249.102 +

Step 3.  Under IP Address Pools tab, make sure IP address are reserved appropriately for the site hierarchy.

Design - Network Settings

SP Profiles Wireless Telemetry

(), Find Hierarchy E

= Cisco DNA Center Qa @ @ 0

Network Device Credentials

~ & Global IP Address Pools (15) Take a Tour &
~ & North America
Subnet Type IPvaonly  Dual-Stack
> db Region - NY
% Fil cti As of: Sep 12, 2021 3:04 PM oy
" v & Region - RTP W Filter 0 Selected Reserve More Actions v s of: Sep &
~ @8 RTP-06 ] Mame ~ Type 1Pwa Subnet IPud Used (O 1PV6 Subnet 1Pv6 Used () Inherited from Actions
£ Floor-01
) RTP_AP_PREFIX Generic 10.4.211.0/25 % @ - - - -
£ Floor-02
£ Floor-03 ] RTP_BORDER_L3Handoff Generic 10.4.218.0/24 0% @ - - - -
> & Region - SJ
)  RTP_BORDER_L3Handofi_GUEST Generic 10.4.219.0/24 0% @ - - - -
[0  RIP_CAMPUS_DATA Generic 10.4.212.0/24 0% @ - - - -
[0  RTP_CAMPUS_VOICE Generic 10.4.213.0/24 % @ - - -
[J)  RIP_CRITICAL_DATA_PREFIX Generic 10.4.216.0/25 0% @ - - - -
[0 RTP_CRITICAL_VOICE_PREFIX Generic 10.4.216.128/25 % @ - - - -
[0 RTP_EN_PREFIX Generic 10.4.211.128/25 0% @ - - - -
] RTP_GUEST_PREFIX Generic 10.4.215.128/25 0% @ - - - L
) RIPLIOT_PREFIX Generic 10.4.215.0/25 0% @ - - - -
. s 15 Records Show Records: 25 ~ 1-15 < @ >

Step 4. (Optional) Under the Wireless tab, select Global in the hierarchy.

Confirm the wireless Network SSID is configured and associated with Wireless Profile.
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= Cisco DNA Center Network Settings a @ @ L

Network Device Credentials IP Address Pools SP Profiles Wireless Telemetry

Q) Find Hierarchy

Wireless SSID(s) e Create
I + d& Global
~ & North America Fiter
> d Region - NY i ;
O Network Name (SSID) » WLAN Type L2 Security L3 Security Wireless Profiles. Portal Type Portal Name Action (1)
~ & Region - RTP
e 0  @-ENT-GUEST Guest open web_auth FABRIC-WIRELESS Self Registered RTP_GUEST_PORTAL Configure AAA (D)
v -
& Floor-01 O @-ENT-OPEN Enterprise open open FABRIC-WIRELESS Not Applicable Not Applicable Configure AAA
£ Floor-02
0  @-ENT-PSK Enterprise wpa2_wpa3_personal open FABRIC-WIRELESS Not Applicable Not Applicable Configure AAA
£ Floor-03
> & Region - SJ 0  @-ENT-SSID1 Enterprise wpa2_enterprise open FABRIC-WIRELESS Not Applicable Not Applicable Configure AAA (D)

Process 2: Associate IOS-XE WAN Edge device with Service VPN

This section details the procedure to create service VPN templates and loopback 0 interface to the I0S-XE WAN Edge devices.

Procedure 1. Configuring Service VPN

In this procedure, lets create Service VPN — one dedicated for undelay reachability and others for multiple overlay networks.

Step 1. Login into vManage, navigate to Configuration > Templates

Cisco vManage - [=] as (7] admin -

2§ DASHBOARD | MAIN DASHBOARD

Warning 0
3 1 @ 1 Reboot Q -
Configuration art - 1 8 WAN Edge - 3 @ wBond - 1 vManage - 1 st e 0 I i 0
Site Health (Total 2) Transport Interface Distribution
Full WAN Connectivity 0 sites <10 Mbps 25
10 Mbps - 100 Mbps 0
Partial WAN Connectivity 2 sites 100 Mbps - 500 Mbps 0
> 500 Mbps 0
o @  NoWAN Connectivity 0 sites
View Percent Utilization
WAN Edge Health (Total 3) Transport Health Type: Byloss & = 0
100%
4
4
3 0 0
50
3
0 Normal Warning Error .
= Application-Aware Routing Type: Byloss &

I e =
Step 2.  Select Feature tab and select Add Template

Cisco vManage

£ CONFIGURATION | TEMPLATES

Device | Feature
(]
o | © Add Template @ e
aQ Template Type MenDefakt  ~ Search Options v Tatal Rows: 30
____ Boin Tompiis ___-
= SD-WAN_CONTROLLER VPNO  SD-WAN_CONTROLLER VPN  vSmart VPN Smart |vManage admin 13 Aug 2021 11:25:18 AM PDT
" SD-WAN_CONTROLLER VPNS12 ~ SD-WAN_CONTROLLER VPNS12  vSmart VPN vSmart |vManage 2 2 admin 13 Aug 2021 11:27:57 AM PDT
SD-WAN_CONTROLLER_SYSTEM  SD-WAN_CONTROLLER_SYSTEM  vSmart System vSmart | vManage 2 2 admin 13 Aug 2021 11:18:10 AM POT
m SD-WAN_CONTROLLER_NTP SD-WAN_CONTROLLER_NTP NTP uSmart |vManage 2 2 admin 13 Aug 2021 11:18:50 AM PDT

Step 3. Choose all the WAN Edge devices.

under VPN, choose Cisco VPN template
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Cisco vManage

Device  Feature

Feature Template - Add Template

KX CONFIGURATION | TEMPLATES

LY Select Devices
[l
=
ASR1001-HX
ASR1001-X
m
ASR1002-HX
ASR1002-X

0O c1ioae

Step4. Input Template Name, Description for the template

Cisco Secure Internet Gateway (SIG)

WAN

Cisco VPN Interface GRE

WAN

VPN Interface Multilink

WAN | LAN

Under Basic Configuration, input VPN, Name

Under DNS, input Primary DNS (IPv4)

Cisco VPN

Cisco VPN Interface IPsec

WAN

Under Advertise OMP, Enable BGP (IPv4), Connected, OSPF External, LISP

Tech tip

For sites connected to shared services in traditional IP network:

Cisco VPN Interface Ethernet

Management | WANLAN

VPN Interface Ethernet PPPoE

WAN

e Enable BGP to be advertised in OMP ensuring remote-sites WAN Edge devices can reach the shared-services.

e Enable LISP to be advertised in OMP to share the SD-Access INFRA_VN prefixes for Access Point, Extended/Policy-Extended nodes.

e Enable Fabric GRT routing protocol (EIBGP/OSPF/ISIS) to be advertised in OMP to provide end-to-end reachability across all sites.

e Enable Connected to be advertised in OMP

For sites connected to SD-WAN Transit only:

e Enable LISP to be advertised in OMP to share the SD-Access INFRA_VN prefixes for Access Point, Extended/Policy-Extended nodes.

e Enable Fabric GRT routing protocol (EIBGP/OSPF/ISIS) to be advertised in OMP to provide end-to-end reachability across all sites.

e Enable Connected to be advertised in OMP

Click Save
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Cisco vManage

* CONFIGURATION | TEMPLATES

Device Feature

o
Feature Template -~ Add Template -~ Cisco VPN
c Device Type ASR1001-HX,ASR1001-X ASR1002-HX,ASR1002-X,ISR4321,ISR4331,ISR4351,I1SR4431,ISR4451-X ISR4461
b Template Name VPN_SERVICEVPN100
=

Description v ICEVPNIOD

DNS Advertise OMP 1Pv4 Route IPv6 Route Service Service Route GRE Route IPSEC Route NAT Global Route Leak

Name

Enhance ECMP Keying [ 2% On e Off

Primary DNS Address (IPvd)

Secondary DNS Address (IPv4) @~

© New Host Mapping

Cisco vManage

a CONFIGURATION | TEMPLATES

Device Feature

jmm | —
Feature Template Add Template Cisco VPN
o
Basic Configuration DNS IPv4 Route 1Pv6 Route Service Service Route GRE Route IPSEC Route NAT Global Route Leak
- ]
BGP (IPv4)
o

Static (IPv4)

Connected (IPvd)

OSPF External

0SPFV3 on @ off

EIGRP on _@T

Lisp off

1818 on @ off
NETWORK AGGREGATE

Network (IPvd) on ©—Off

Cancel

Step 5. Repeat steps in this Procedure to create additional Service VPN as needed
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Cisco vManage

FRll %% CONFIGURATION | TEMPLATES

Device  Feature

a

o (01=]

a Template Type | Nonoctaun ~ Q) 4_SERVICE ‘Search Options Total Raws: B of 37
I S N T T [ N

. T senvicevenzD P— ISR 1SR4 VX SRALST X ASRT . 0 0 18 5ep 202 62914 PMPDT
RS_VPN_SERVICEVPNZO |SR4331 1ISR4221X [ ISR4451-K| ASRI... O (] admin 13 Sep 2021 6:30:00 PM PDT

Tech tip

Each Virtual Network in Cisco SD-Access network should have a corresponding Service VPN in the SD-WAN environment.

Procedure 2. Configuring ethernet interface for loopback 0

In this procedure, lets create Cisco VPN Interface Ethernet for interface loopback 0. This procedure is needed only when building
the Fabric GRT manually.

Skip the Procedure 2 and proceed to Procedure 3 if the deployment will leverage LAN Automation workflow to discover and
provision the Fabric GRT network devices. As a part of the LAN Automation workflow, Cisco DNA Center will provision loopback
0 interface on the WAN Edge device.

Tech tip

Each Virtual Network in Cisco SD-Access network should have a corresponding Service VPN in the SD-WAN environment.

Step 1. Login into vManage, navigate to Configuration > Templates

Cisco vManage - =] s 7]

23 DASHBOARD | MAIN DASHBOARD

@ Waming 0
8 3 @ 1 Q 1 Reboot 0 N v 0
Configuration art - 1 WAN Edge - 3 vBond - 1 vManage - 1
Site Health (Total 2) Transport Interface Distribution
Full WAN Connectivity 0 sites <10 Mbps 25
10 Mbps - 100 Mbps 0
Partial WAN Connectivity 2 sites 100 Mbps - 500 Mbps 0
o > 500 Mbps 0
@  NoWAN Connectivity 0 sites
View Percent Utilization
WAN Edge Health (Total 3) Transport Health Type: Byloss & = 03
100%
4
4
3 0 0
50
3
0 Normal Wamniny
] Error .
= Application-Aware Routing Type: Byloss &

I e e T
Step 2.  Select Feature tab and select Add Template
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Cisco vManage

%X CONFIGURATION | TEMPLATES

Device Feature

© Add Template @ e

o

a Template Type | MonDsfaut Q, Search Options v Total Rows: 30

= SD-WAN_CONTROLLER_VPNO SO-WAN_CONTROLLER_VPNO vSmart VPN vSmart | vManage 2 2 admin 13 Aug 2021 11:25:18 AM PDT e
SD-WAN_CONTROLLER VPN512  SD-WAN_CONTROLLER VPNS12  vSmart VPN vSmart | yManage 2 2 admin 13 Aug 2021 11:27:57 AM PDT
SD-WAN_CONTROLLER_SYSTEM  SD-WAN_CONTROLLER_SYSTEM  vSmart System vSmart | vManage 2 2 admin 13 Aug 2021 11:18:10 AM POT

m SD-WAN_CONTROLLER_NTP SD-WAN_CONTROLLER_NTP NTP vSmart | vManage 2 2 admin 13 Aug 2021 11:18:50 AM PDT

Step 3. Choose all the WAN Edge devices.

under VPN, choose Cisco VPN Interface Ethernet template

Cisco vManage

° CONFIGURATION | TEMPLATES

Device Feature

Feature Template - Add Template

E -
* e _
=
Cisco Secure Internet Gateway (SIG) Cisco VPN Interface Ethernet
- ASR1001-HX Cisco VPN
WAN Management| WAN | LAN
ASRID01X
o
ASRI00Z-HX Cisco VPN Interface GRE Cisco VPN Interface IPsec VPN Interface Ethernet PPPoE
WAN WAN VAN
ASR1002:X
O criop VPN Interface Multilink
WAN | LAN
O criot-4pirer

Step4. Input Template Name, Description for the template
Under Basic Configuration,
Shutdown, enable No
Input Interface Name - Loopback0
Input Description - Loopback0
Under IPv4, select Static option
Under IPv4 Address / prefix-length, create Device Specific variable ‘vpn100_loopback0_address’
Click Save
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Cisco vManage

c CONFIGURATION | TEMPLATES

Device Feature

jm
Feature Template - Add Template - Cisco VPN Interface Ethernet
Device Type ASR1001-HX,ASR1001-X, ASR1002-HX, ASR1002-X,ISR4321 ISR4331,ISR4351,1SR4431,ISR4451-X ISR4461
-
o Basic Configuration Tunnel NAT VRRP ACL/QoS ARP TrustSec Advanced

GURATION

Shutdown - Yes @® MNo

Interface Name
pescrption
a-

IPva Address/ prefix-length

Secondary IP Address (Maximum: 4) © Add

DHCP Helper [

Ganeel

Procedure 3. Associate VPN and ethernet template to the WAN Edge device

This section details the procedure to associate cisco VPN and ethernet interface templates to the WAN Edge devices with the
intent to provide end-to-end Fabric GRT reachability across the sites.

Step 1.  Login into vManage, navigate to Configuration > Templates

Cisco vManage - [=] as (7] admin v

23 DASHBOARD | MAIN DASHBOARD

Warning 0

3 1 : 1 Reboot Q
Configuration art - 1 @ WAN Edge - 3 @ Bond - 1 @ vManage - 1 35124 0 I8 e 0

Site Health (Total 2) Transport Interface Distribution
Full WAN Connectivity 0 sites <10 Mbps 25
10 Mbps - 100 Mbps 0
Partial WAN Connectivity 2 sites 100 Mbps - 500 Mbps 0
> 500 Mbps 0
o @  NoWAN Connectivity 0 sites
View Percent Utilization
WAN Edge Health (Total 3) Transport Health Type: Byloss & = 0
100%
ed Communications 4
Cloud onRamp for SaaS 4 3 0 0
s
Cloud onRamp for laaS 3
0 Normal Warning Error
0% e e e e e e e e e e e e e e e e e ee

= = Application-Aware Routing Type: Byloss  § 0

Step 2.  Select the WAN Edge device from the list, click the three dots (...), and select Edit from the drop-down list.
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Cisco vManage

£ CONFIGURATION | TEMPLATES

| Device IFea\ure

© Create Template ~

-
a Template Type | NonDefaut < Q Search Options v
o oo
= AASRID0TA Feature ASR1001X 14 1
" A-ASRIDD1X-2 A-ASRI001X:2 Feature ASRI001X u 1
RS1245R4331-18 RS12-1SR4331-18 Feature ISR4331 14 1
o WManage WManage Feature WManage 9 1

vSmart vSmart Feature vSmart

Step 3.  Select Service VPN, click Add VPN

Cisco vManage

(o=

Total Rows: 5
KT N KR
admin 12 Sep 2021 45252 PMPDT  In Sync []
admin 18 Aug 2021 6:09:51 AMPDT  In Sync _
admin 18 Aug 2021 B:3324 AMPDT InSync | view
admin 16 Aug 2021 25253 PMPDT InSync  Delete
admin 16 Aug 2021 2.50.33 PMPDT  In Syne Copy

Attach Devices
Detach Devices
Export CSV

Change Device Values

3 CONFIGURATION | TEMPLATES

Basic Information Transport & Management VPN

Additional Templates

]
aQ
Service VPN
=
0 Rows Selected
Q Search Options
o

Step 4. Select previously created Fabric GRT Service VPN, ‘VPN_SERVICEVPN100’
Selected VPN Templates. Click Next

Cisco vManage

) select VPNs

Select one or more Service VPNs to add:

Template Name

Create VPN Template

Step 5.

This is required for deployments building manual Fabric GRT at the site.

Deployments using LAN Automation workflow to discover and provision Fabric GRT
proceed to next step (Step 6).

Select Additional Cisco VPN Templates > Cisco VPN Interface Ethernet.

© 2021 Cisco and/or its affiliates. All rights reserved.

oe

Total Rows: 0

Template Name Sub-Templates
8 e 2 . |

and move from Available VPN Templates to

1 ltems Selected

Q

10

Template Name

| e7e7a788-3aff-4292-8596-e2b5b102936e VPN_SERVICEVPN100

CANCEL

LAN segment, skip this step (Step 5) and
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Choose previously created ‘LAN_LOOPBACKOQ’ interface template and any additional interface to provide Fabric GRT
connectivity.

Click Add

@ Select VPNs ©) Select Sub-Templates

Include sub-templates to attach to ALL selected service VPNs:

[ Additional Cisco VPN Templates
© Cisco IGMP
© Cisco Multicast

Cisco VPN Interface Ethernet - © sub-Templates - .
. . o conrm

Cisco BGP BGP_YPN100 - o

Cisco VPN Interface Ethernet ] © sub-Templates ~ © Cisco 0SPF
© Cisco OSPFv3
Cisco VPN Interface Ethernet LAN_SUB_INTERFACES . o © sub-Templates ~ © Cisco VPN Interface Ethernet
© Cisco VPN Interface IPsec
© EIGRP
© VPN Interface MultiLink Controller
BACK CANCEL
Step 6. Add additional Service VPN created.
click Add VPN,
select VPNs and move from Available VPN Templates to Selected VPN Templates
click Next
Cisco vManage - =] at [7] n =
»
) Select VPNs
Select one or more Service VPNs to add: 3 Items Selected
Q v Q 5
D Template Name D Template Name
Td2edal1-2b7a-49ch-a22a-60260d36e169 RS_VPN_SERVICEVPN10 ab266174-88h5-4bd4-840f-560da0587efb VPN_SERVICEVPN10
4572dd85-f1a5-ddca-aa78-5 RS_VPN_SERVICEVPN100 09320009-d4d7-472¢-a039-747106f97707 VPN_SERVICEVPNZ0
Obe64fcd-adad-43e5-81c7-a6261665420e RS_VPN_SERVICEVPN20 fodac024-féaf-4b97-be9e-324133aa6d92 VPN_SERVICEVPN30
e7b353ee-1135-4c42-9eba-bbadfl cabb0? RS_VPN_SERVICEVPN30 9
e

Create VPN Template CANCEL

and Click Add

© 2021 Cisco and/or its affiliates. All rights reserved. Page 43 of 148



Cisco vManage

@& select VPNs ) Select Sub-Templates

Include sub-templates to attach to ALL selected service VPNs:

Additional Cisco VPN Templates
Cisco IGMP

Cisco Multicast

Cisco PIM

Cisco BGP

Cisco OSPF

Cisco OSPFv3

Cisco VPN Interface Ethemet

Cisco VPN Interface IPsec

EIGRP

VPN Interface MultiLink Controller

BACK CANCEL

Tech tip

Associating Service VPN to the WAN Edge devices ensures these VPNs are shared with Cisco DNA Center, when the WAN Edge device is
added part of the Integrated Domain deployment.

Step 7. Click Update

Cisco vManage

ﬂ CONFIGURATION | TEMPLATES

o Basic Information Transport & Management VPN Additional Templates
&
h Service VPN
=
0 Rows Selected ee
= e ——— Total Rows: 4
o
u_-
€7e74788-3aff-4a92-8596-e2b5b1b2936e WPN_SERVICEVPN100 Cisco BGP, Cisca VPN Interface Ethernet, Cisco VPN Interface Ethernet, Cisco VPN Interf...  wa.
ab266174-88b5-4bd4-8401-560da0587efb VPN_SERVICEVPN10 -
O 09320009-d4d7-472¢-a039-747106f97707 VPN_SERVICEVPN20 e
fodac024-f6af-4b37-bede-324133aa6d92 VPN_SERVICEVPN30 - s

Additional Templates

AppQoE Choose. -

Global Template * Factory_Default_Global_CISCO_Template - 0

Gancel

Step 8.  click the three dots (...), select Edit Device Template from the drop-down list,

Cisco vManage

£ CONFIGURATION | TEMPLATES

=] Device Template |  A-ASR1001X-1

o (+ 1+ ]

N SR Total Rows:
- [ —— mm 1Pv4 Address/ prefix-length{vpn100_loopbackD_address) Interface Name(vpns12_mgm_interface) Address(vpn0_MPLS_nexthop) m

.

= ASR1001-X-JAE204100WU 1.1.1.10 A-ASR1001X-1 GigabitEthernetd 105208121 10.5.20 u

an Edit Device Template

o

input Device-Specific variables and click Update and Next.
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Variable List (Hover over each field for more information)
1Pv4 Address/ prefix-length(mpls_interface_ip_address) 10.5.208.122/30

Interface Name(inet_interface_name) GigabitEthemet0/0/5

AS Number(bgp_as_num) 5000

Router ID(bgp_router_id) 105208122
Network Prefix(bgp_inet_prefix) 105.207.120/30
Network Prefix(bgp_mpls_prefix) 10.5.208.120/30
Address(inet_bgp_neighbor_address) 105207121
Address(mpls_bgp_neighbor_address) 105208121

Description(inet_bgp_neighbor_description) INET

Descripti ;_bgp_neighbor_descri MPLS
Remote AS(inet_bgp_neighbor_remate_as) 499

Remate AS(bgp_neighbor_remote_as) 65000
Hostname(system_host_name) A-ASR1001%-1
System IP(system_system_ip) 11110

Site ID(system_site_id) 1

Interface Name(vpnS12_mgmt_interface) GigabitEtheretd

1Pv4 Address/ prefix-length(vpn100_loopback0_address) 10.4.200.1/32

LX CONFIGURATION | TEMPLATES

Device Template |  A-ASR1001X-1
s 00
Q Q, Search Options v Total Rows: 1
"] Grast e [sysmie | Fosmame | IPv el prflengipm10 oopbckadies) T — oo P ston) | A |
-
= @  ASRI001-X-JAEZ04100WU 11.1.10 A-ASRI001X1 10.4200.1/32 GigabitEthemet0 105208121 10520 a
E N

Cancel

Click Config Preview to view the configuration being provisioned to WAN Edge device.

Click Configure Devices

‘Canfigure’ action will be applied to 1 device(s)

L CONFIGURATION | TEMPLATES
attached to 1 device template(s).

Device Template Total
A-ASR1001X-1 1

Device list (Total: 1 devices) system
2tp-status in-progress
an device-model vedge-ASR-1001-X
host-name A-ASR101X-1
ASR1001-X-JAE204100WU systen-ip Lo
e overlay-id 1
site-id 10

port-offset °
control-session-pps 300
Max-omp-sessions 20
admin-tech-on-failure
sp-organization-name EN-SOLUTIONS
organization-name EN-SOLUTIONS
port-hop

track-transport
track-default-gateway
consale-baud-rate 9600

no on-demand enable

on-demand idle-tineout 10

vbond 18.4.246.13 port 12346

Configure Device Rollback Timer
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Cisco vManage admin *

[Tl B TaskviEw

= Push Feature Template Configuration | & Validation Success + Initiated By: admin  From: 100.119.42.104
Total Task: 1| Success : 1
Q Search . otal Rows: 1
= \
- © Success Done - Push Feature Template ., ASR1001-X-JAEZ04100WL ASR1001-X A-ASR1001X 1110 1111111
o

Step 9. Return to the Stepl of the Procedure and repeat for each WAN Edge device in the SD-WAN fabric.

Step 10. Verify the WAN Edge device have reachability to Cisco DNA Center from loopback 0 interface.

In vManage, navigate to Tools > SSH Terminal, select the WAN Edge device from the list. Login with the device credentials and
execute the command ‘show vrf’ and ‘show ip route vrf 100 <DNA Center ip-address>’

il Cisco vManage a admin ¥

sco

A, TOOLS | SSH TERMINAL

Device Group 1212121

All

Q

Sortby  Reachability

vmanage
11111107 | Site ID: 1

vsmart

12121212 | Site ID: 1

vbond
13131313 | Site ID: 1
100 10.4.249.102
A-ASR1001X-1
1.1.1.10 | Site ID: 10

A-ASR1001X-2
1.1.1.117 | Site ID: 10

RS12-1SR4331-18 ISR4331
1212121 | SiteID:12

Reachable

RS12-ISR4431-21

10520521 | Site ID: 12

Router C8500-12X4QC

10.5.205.2 | SiteID: 11

Router C8500-12X4QC

10.5.205.3

Process 3: Integrate the domain controllers

This section details the procedure to integrate SD-WAN vManage controller in Cisco DNA Center and share |0S-XE WAN Edge
device(s) for the Integrated Domain integration.

Procedure 1. Integrating vManage in Cisco DNA Center

This section details the procedure to integrate vManage and DNA Center controllers together.

Step 1. Login into Cisco DNA Center, navigate to System > Settings
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Cisco DNA Center a ® @ 0o
Take a Tour  [_] Explore
hnnel X
Critical Issues Trends and Insights
P P2 Thraughput Coverage Capacity
w Details View Details
Step 2.  Under External Services, click vManage
Input Host Name/IP Address of the VManage controller,
Credentials: user must be part of the netadmin user-group in vManage.
Port Numbers: 8443
= Cisco DNA Center System - Settings Q ® @ 4L
ZQ segarch Settings Settings | External Sarvic

Device Settings v vManage
Device Controllability Use this form to configure the vManage server and credentials. These settings enable
communication with the vManage server to manage SD-WAN devices from Cisco DNA

Network Resync Interval Center
SNMP
A certificate is required if vManage is authenticated via a root CA. This certificate is

installed in vEdge during th

ICMP Ping onboarding process in NFVIS provisioning

Note: Only Privacy-Enhanced Mail (PEM) standard files can be uploaded to Gisco DNA
Center.

Image Distribution Servers

Device EULA Acceptance
Host Name/IP Address

10.4.246.11

PnP Device Authorization

External Services ~ The hostname or IP address of yM

Umbrella

ted for this IP. k here to add in trus

Authentication and Policy Servers

Authentication Tokens The usar ID of wManage

Integrity Verification

vManage
The password of vManage

IP Address Manager

Cisco Al Analytics

. nage port number
Stealthwatch

Destinations

vBond Host Name/IP Address
DNA Spaces/CMX Servers i
Machine Reasaning Engine

Organization Name
Cloud Access Keys

Step 3. Install the trustpool certificate, by clicking the Click here and allow the ip-address to be added to the trustpool
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= Cisco DNA Center System - Settings a ® @ 5L
ZQ Search Settings Settings | External Services
Device Settings » vManage
Device Gontrollability Use this form to configure the vManage server and credentials, These settings enable
communication with the vManage server to manage SD-WAN devices from Cisco DNA
Network Resync Interval Center.
SNMP
A certificate is required if vManage is authenticated via a root CA. This certificate is
ICMP Ping installed in vEdge during the onboarding process in NFVIS provisioning.
. . Note: Only Privacy-Enhanced Mail (PEM) standard files can be uploaded to Cisco DNA
Image Distribution Servers Center.

Device EULA Acceptance

Hast Name/IP Address*
PnP Device Authorization

10.4.246.11
External Services v The hostname or IP address of vManage
Umbrella Certificate is not trusted for this IP. Click here to add in trustpool
Usermname”
Authentication and Policy Servers
admin
Authentication Tokens The user ID of vManage
Integrity Verification Password®

sHow
vManage
The password of vManage

IP Address Manager
Port Number*

Cisco Al Analytics 8443
The vManage port number
Stealthwatch ;
Destinations
vBond Host Name/IP Address
DNA Spaces/CMX Servers Infa
Machine Reasoning Engine

Organization Name
Cloud Access Keys

Tech tip

vBond Host Name/IP Address and Organization Name are optional for the Integrated Domain controller integrated but needed if the
vManage is managing Enterprise NFV network devices.

The certificate associated with this IP
address is not trusted.

Certificate Details

I\ow DNA center to access this IP
address and add the untrusted

certificate to the trustpool.
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Cisco DNA Center

ZQ Search Settings

Device Settings v
Device Controllability
Network Resync Interval
SNMP
ICMP Ping
Image Distribution Servers
Device EULA Acceptance
PnP Device Authorization
External Services v
Umbrella
Authentication and Policy Servers
Authentication Tokens
Integrity Verification
vManage
IP Address Manager
Cisco Al Analytics
Stealthwatch

Destinations

Step 4.

Cisco DNA Center

Q  Search Settings

Device Settings v
Device Controllability
Network Resync Interval
SNMP
ICMP Ping
Image Distribution Servers
Device EULA Acceptance
PnP Device Authorization
External Services v
Umbrella
Authentication and Policy Servers
Authentication Tokens
Integrity Verification
vManage
IP Address Manager
Cisco Al Analytics
Stealthwatch

Destinations

/A Spaces/CMX Servers
Machine Reasoning Engine
Cloud Access Keys

System Configuration v

System - Settings

Settings / External Services

vManage

° Certificated added in trustpool successfully X

Use this form to configure the vManage server and credentials. These settings enable
communication with the vManage server to manage SD-WAN devices from Cisco DNA
Center.

A certificate is required if vManage is authenticated via a root CA. This certificate is
installed in vEdge during the onboarding process in NFVIS provisioning.

Note: Only Privacy-Enhanced Mail (PEM) standard files can be uploaded to Cisco DNA
Center.

Hast Name/IP Address®

10.4.246.11
The hostname or IP address of vManage
Username*
admin
The user ID of vManage
Password*

sHow
The password of vManage
Port Number*

B443

The vManage port number

Click Save and Continue in the pop-up Warning page.

System - Settings

HosT Name/IP Agoress™

10.4.246.11
The hostname or IP address of vManage
Username*
admin
The user D of vManage
Password®

..... SHOW

The password of vManage

Port Number*

8443

The yManage port number

vBond Host Name/IP Address

nfo

Organization Name

nfa

@

Choose a file or drag and drop to upload.

Accepted files: .pem .cert
Accepted sizes: up to 10MB
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&H

Warning

Note 1: If you are using this vManage setting for managing NFV, make sure
that you have added the vBond and Organization Name

Note 2: To move a cEdge (SD-WAN) router to Managed state, perform ONE
of the following: 1) Assign the router to a site for which SNMP and CLI
(SSH) credentials have already been configured. 2) Update the router's
SNMP and CLI (SSH) credentials in the Edit Device slide-in pane (Provision
> Network Devices > Inventory > Actions > Inventory > Edit Device)

Note 3: Configure a vManage VPN for INFRA VN before proceeding with

using cEdge (SD-WAN) routers on DNAC in the Edit Virtual Network slide-in
pane (Policy > Virtual Network > Infra_VN > Edit)

Cancel

Step 5.  Verify the controller integration health in Cisco DNA Center > System 360, scroll down to External Connected
Systems section and view the vManage status

= Cisco DNA Center Q& ® o

System 360 Service Explorer

System Management

Software Updates Backups Application Health
As of Sep 12, 2021 8:35 PM As of Sep 12, 2021 8:35 PM As of Sep 1

@® Connected to Cisco's software server. ® No backups server configured. Configure ® Automation

® System Package is up to date. @® Assurance

Externally Connected Systems

Identity Services Engine (ISE) IP Address Manager (IPAM) vManage
As of Sep 11, 2021 8:35 PM As of Sep 12, 2021 8:35 PM As of Sep 11, 2021 8:35 PM
Primary 10.4.250.225 & Available ) ® No IPAM server configured. Configure Server URL 10.4.246.11 & Available )
Secondary 10.4.250.226 & Available ) Username admin
Pxgrid-Active 10.4.250.225 & Available )
Pxgrid-Standby 10.4.250.226 & Available )
Update Update

Step 6.  On successfully integration a registered entry is created in SD-WAN vManage controller.

Login to vManage, navigate to Administration > Integration Management
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Cisco vManage

235 DASHBOARD | MAIN DASHBOARD

Warning 0
e A 3 N 1 Last2m va
vSmart - 1 WAN Edge - 3 vBond - 1 vManage - e

Control Status (Total 3) Site Health (Total 2) Transport Interface Distribution
Control Up Full WAN Connectivity 0 sites <10 Mbps 27
Administration 10 Mbps - 100 Mbps 0
Partial WAN Connectivity 2 sites 100 Mbps - 500 Mbps 0
> 500 Mbps 0

v ©  NoWAN Connectivity 0 sites

View Percent Utilization
WAN Edge Health (Total 3) Transport Health Type: Byloss & = o

- 10
integration Management 4

W A

0 Normal Warning Error
L S S —

Cisco vManage

H £x ADMINISTRATION | INTEGRATION MANAGEMENT

Rafll Showing lst of third-party controllers registered on vManage. Associate Sites for each controller from the 'Actions' menu icon in the table.

© (o1=]

Q Q, Search Options ~ Total Rows: 1

o L L o T T - N——
DNAC_08239fb6-33dd-479-0dc2-a098a744a... DNAC deployment for 08e39fb6-33dd-479e-9...  08e39fb6-33dd-479e-0dc2-a098a744ab0f dnac admin 12 Sep 2021

a8

o

Procedure 2. Associating I0S-XE WAN Edge devices to participate in the Integrated-Domain integration

This section details the procedure to associate I0S-XE WAN Edge devices in vManage, share Service VPN and network devices to
Cisco DNA Center that are part of the Integrated Domain deployment.

Step 1. Login to vManage, navigate to Administration > Integration Management

Cisco vManage

L H ﬂ ADMINISTRATION | INTEGRATION MANAGEMENT

Showing list of third-party controllers registered on vManage. Associate Sites for each contraller from the 'Actions' menu icen in the table,

® 0e

aQ Q. Search Options v Total Rows: 1

= I I T T . ——
DNAC_08239fb6-33dd-479e-9dc2-a098a744a... for 08e39fb6-33dd-479e-9...  08e39fb6-33dd-479e-9dc2-a098a744ab0t dnac admin 12 Sep 2021

an

o

Step 2.  Click the three dots (...) and select Attach Devices from the drop-down options

Cisco vManage

0 ADMINISTRATION | INTEGRATION MANAGEMENT

HH
JRf Soing st of third-party controllers registered on vManage Associate Sites for each controllr from the Actions' menu icon in the table
N - SeaN DRk Total Rows: 1
& —m“_—-“m_—_-
DNAC_08¢39fb6-33dd-479-0dc2-a098a744a...  DNAC deployment for 08e39fb6-33dd-479¢-9...  08e39fb6-33dd-479¢-9dc2-a098a744ab0f dnac admin 12 Sep 2021 EI
.
a
Attach Devices
o Detach Devices

Step 3.  Select IOS-XE WAN Edge devices from the Available Devices to move them to Selected Devices
and click Attach
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Attach device from the list below

3 ftems Selected

All - Q All v

Name Device IP Name Device IP
ISR4431/K9-FOC22282008 A-ASR1001X1 1.1.1.10
AASR1001%-2 111m

RS12-1SR4331-18 1212121

¢ ADMINISTRATION | INTEGRATION MANAGEMENT

Showing list of third-party controllers registered on vManage Associate Sites for each controller from the 'Actions' menu icon in the table.

® (o]=)
aQ Q Search Options ~ Total Rows: 1
= [ e = = ]

DNAC_08e39fb6-33dd-479¢-9dc2-a098a744a...  DNAC deployment for 08e39fb6-33dd-47%e-9...  08e39fb6-33dd-479% 9dc2-a098a744ab0f dnac admin 12 Sep 2021

Select the value in the Devices column list the devices that are shared by vManage to Cisco DNA Center

Q Search Options v Total Rows: 3

I L S

ISR4331/K9-FDO2012092M RS12SR4331-18 1212121

ASR1001-X-JAE203201XB A-ASR1001X-2 11111

ASR1001-X-JAE204100WU A-ASR1001X-1 11110
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Procedure 3. Provision the IOS-XE WAN Edge devices to participate in the Integrated-Domain integration

This section details the procedure to provision I0S-XE WAN Edge devices to a site in Cisco DNA Center.
Step 1. Login to Cisco DNA Center, navigate to Provision > Network Devices > Inventory.

The WAN Edge device status in Cisco DNA Center is Ping Reachable with Manageability status as Managed with SNMP
Authentication Failure. This is expected as the device has not been provisioned with site-specific parameters that contain SNMP
configuration required to manage in network device in Cisco DNA Center.

Tech tip

The WAN Edge device status can also be in Reachability status as Unreachable and Manageability status as Managed with
Device Connectivity Failure. This is expected as there is no loopback 0 ethernet interface configured on the WAN Edge device
and the ‘system-ip’ address on the WAN Edge device is not reachable from Cisco DNA Center.

The Cisco DNA Center LAN Automation workflow to discover and provision the Fabric GRT network devices, will provision the
required loopback 0 ethernet interface on the WAN Edge devices selected as Primary and Peer Seed device.

= Cisco DNA Center Provision - Network Devices - Inventory Preview New Page Q ® @ L

Inventory Plug and Play

) @ Global > Unassigned Devices E - N
Q, Find Hierarchy
DEVICES (1)
~ & Global focus: Inventory v
C i »
I © Unassigned Devices (1) Filter @ Add Device Tag Device Actions ~ (D | Take a Tour As of: 10:45 AM Export {7 Refresh
> & North America
O Device Name - IP Address  Device Family I ility (D ility (D jance () HealthScore  Site MAC Address  De  }
A Managed
]} RS12-ISR4431-21 (3 12.12.12.2  Unsupported Cisco Device @ Unreachable o NiA NA Assign &

Device Connectivity Failure

Continue with steps in this Procedure, even for the WAN Edge devices in the error state - Unreachable, Managed with Device
Connectivity Failure status. Any DNA Center generated configuration is shared with vManage to provision it to the WAN Edge
devices.

Step 2.  With the WAN Edge devices in either Reachability and Manageability state, select the WAN Edge devices in the
Unassigned Devices hierarchy

select Actions > Provision > Assign Device to Site

= Cisco DNA Center | Provision « Network Devices - Inventory Preview New Page a @ 4 o
Inventory  Plug and Play
@ Global E [T ]
Q Find Hierarchy
DEVICES (3)
I ~ &b Global rocus: Inventory ~
| © Unassigned Devices (3) I Filter @ Add Device Tag Device Actions ¥ @ | TakeaTour | Asof: 1004 aM 1 Export £ Refresh
> & North America
e Device Name IPAddress  Device Family ity @ @ o ® Site  MACAddress  DevicaRole  ImageVersion  Uptime L.
A Managed
B A-ASR1001X-1 @& 10.4.200.1 A Ping Reachable £ NiA NA Assign & CORE
SNMP Authentication Fallure
A-ASR1001X-2 @ 10.4.200.2 & Ping Reachable & Managed NiA NA Assign & CORE
SNMP Authentication Failure
Managed
0 RS12-ISR4331-18 (3  10.5.205.18 A Ping Reachable 4+ Manage: A NA Assign & CORE

SHMP Authenticatic
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= Cisco DNA Center

Inventory Plug and Play

Q Find Hierarchy

I ~ ¢ Global
© Unassigned Devices (3)

> & North America

Step 3.
= Cisco DNA Center

Inventory Plug and Play

(3, Find Hierarchy

I ~ 4 Global
O Unassigned Devices (3)

> & North America

o
Step 4.

= Cisco DNA Center

Inventory Plug and Play

() Find Hierarchy

~ ¢ Global
© Unassigned Devices (3)

> & North America

Click Assign

DEWICES (3)
rocus: Inventory ~

Y Filter @ Add Device

Device Name ~

A-ASR1001X-1 @&

(] A-ASR1001X-2 ©

D RS12-ISR4331-18 @

Inventory

@ Add Device

“V Filter

Device Name »

A-ASR1001X-1 @

[ ] A-ASR1001X-2 @
O RS12-ISR4331-18 ©
Show 25 v entries

DEVICES (3)
Focus: Inventory v

VFiter | @ Add Device

Device Name

(] A-ASR1001X-1 @
[} A-ASR1001X-2 @

[m] RS12-1SR4331-18 ©

Show 2% ~ entries

© 2021 Cisco and/or its affiliates. All rights reserved.

Tag Device

IP Address

10.4.200.1

10.4.200.2

10.5.205.1€

Tag Device Actions v @ | Take a Tour

1P Address Device Family Reachability ()
10.4.200.1 A\ Ping Reachahy
10.4.200.2 4 Ping Reachab)
10.5.205.18 A Ping Reachab)

Tag Device Actions v~ (D | Takea Tour

IP Address Device Family Reachability (O
10.4.200.1 A Ping Reachab
10.4.200.2 A Ping Reachab)
10.5.205.18 A Ping Reachat¥

Provision « Network Devices -« Inventory

Take a Tour
Inventory >
Software Image 5
achable

Telemetry >

@ Global
2 Selec
@ ® Sito MAC Address
A Managed
= NiA NA Assign
NiA NA Assign
Provision Device
NiA NA Assign

Device Replacement >

LAN Automation

Others

LAN Automation Status

Compliance >

Provision - Network Devices - Inventory

Provision - Network Devices - Inventory

In the slide-out page Choose a Site for each device and click Next

Assign Device to Site

Preview New Page

Preview New Page

a e o o

(= K

Asof: 10:04 AM 1 Export Refresh
Device Role Image Version Uptime Loog
£ CORE ==
& CORE =
£ CORE -
Q@ ¢ o
X

| il Global/North America/Region - RTP... |

Serial Number Devices
FXS2027Q2BB A-ASR1001X-1

1] Apply to A1l (D
FXs2011Q1B1 A-ASR1001X-2

| @il Global/North America/Region - RTP... x

Device Controllability is Enabled. Learn More | Disable

View the parameters that gets provisioned to the device and click Next

Assign Device to Site

A-ASR1001X-1
GLOBAL/NORTH AMERICA/REGION -
RTP/RTP-06 site.
I A-ASR1001X-1
Syslog Server

A-ASR1001X-2

Wireless Streaming Telemetry

SNMP Trap Receiver
AP Impersonation

Syslog Level

Device Controllability is Enabled. Learn More | Disable Cancel

Praview New Page Q.

Cancel

@ &0

The following settings will be deployed during assignment to

Cisca DNA Center
Yes
Cisco DNA Center

Enabled

6 - Information Messages
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= Cisco DNA Center

Inventory Plug and Play

O, Find Hierarchy

l ~ & Global
© Unassigned Devices (3)

> & North America

Step 5.

DEVICES (3)

Focus: Inventory

Filter @ Add Device

Device Name ~

A-ASR1001X-1 @

[ ] A-ASR1001X%-2 @

O RS12-ISR4321-18 ©

Show 25 ~ entries

Provision - Network Devices - Inventory

Tag Device  Actions v () Take a Tour

IPAddress  DeviceFamily  Reachability (1)
10.4.200.1 A Ping Reachab)
10.4.200.2 A Ping Reachaby
10.5.205.18 A Ping Reachaly

Verify the devices are associated to the site.

Preview New Page

Assign Device to Site

© Now
Task Name*
Assign 2 Device(s) to Site

O Later

Device Controllability is Enabled. Learn More | Disable Cancel

a o a L

For WAN Edge devices configured with Loopback 0 interface associated in the Fabric GRT Service VPN, Cisco DNA
Center will use Loopback 0 IPv4 address to connect, perform SNMP polling and move the device to Managed state.

= Cisco DNA Center

Inventory Plug and Play

Q Find Hierarchy

v ¢ Global
© Unassigned Devices (1)
~ &2 North America
> & Region - NY
I > & Region - RTP

> & Region - SJ

DEVICES (2)
Focus: Inventory v

Filter | @ Add Device
O Device Name =

(] A-ASR1001X-1 @

O A-ASR1001%-2 @

Show 25 ~ entries

Provision - Network Devices - Inventory

Q Global > North America > Region - RTP

Shawing 2 of 2

Froview New Page Q

Tag Device Actions » () | Take a Tour Asof: 10:39 AM T Export 7 Refresh
IP Address Device Family ility (1) 0] i (0] Health Score Site MAC Address Device Role Imi i

10.4.200.1  Routers @ Reachable @ Managed @ compliant NA ...[Region - RTP/RTP-06  a0:3c:6f:03:c0:00 ¢ BORDER ROUTER  17.3.4a
10.4.200.2  Routers @ Reachable ©® Managed @ compiiant NA .../Region - RTP/RTP-06  00:a6ica:e1:08:00 < BORDER ROUTER 17.3.4a

For WAN Edge devices with no Loopback 0 interface configured, Cisco DNA Center will not be able to connect. Devices
will be in Unreachable, Managed with Device Connectivity Failure state but part of the site hierarchy.

= Cisco DNA Center

Inventory Plug and Play

Q_ Find Hierarchy

v & Global
© Unassigned Devices

~ && North America

DEVICES (1)
Focus: Inventory v

I ~ ¢ Region - NY

> B NYC-01
» & Region - RTP

> &b Region - SJC

“ Filter @ Add Device Tag Device Actions ~ (O
0O Device Name = IP Address. Device Family
0O RS12-ISR4431-21 @ 12.12.12.2  Unsupported Cisco Device
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Provision - Network Devices - Inventory

Preview New Page Q.

Q@ Global > North America > Region - NY

Take a Tour

0] 6] (@  HealthScore  Site

@ Unreachable A Managed /A NA

Device Connectivity Failure

As of: 1:24 PM

@ @ O

T Export <0 Refresh

MAC Address Devl

-..[Region - NY/NYC-01
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Tech Tip

The Cisco WAN Edge CLI credentials defined in the Cisco DNA Center network setting, must be configured on the network device. If
needed, local user credentials can be configured on the WAN Edge device with Cisco AAA feature template from the vManage Ul.

Procedure 4. Mapping Service VPN to Virtual Network in Cisco DNA Center

This section details the procedure of mapping Service VPN to Virtual Network in Cisco DNA Center.

Step 1.  Login to Cisco DNA Center, navigate to Policy > Virtual Networks
Cisco DNA Center Qe oo

Take a Tour  [) Explare

| X
Critical Issues Trends and Insights
Last 24 Hours Last 30 Days
P P2 Throughput Coverage Capacity
View Details View Details
Step 2.  Click in the Virtual Network name INFRA_VN, and click Edit in the slide-out page
= Cisco DNA Center Policy - Virtual Network Q ® @ o
Virtual Networks (2) X

View Virtual Network

Name

INFRA_VN
Name vManage VPN Guest VN
O DEFAULT_VN
(@] INFRA_VN

cancel

Choose the Fabric GRT Service VPN associated to the WAN Edge device in the vManage VPN drop-down option.
Click Save
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= Cisco DNA Center

Policy - Virtual Network Q ® @ 0
virtual Networks (2) Edit Virtual Network 8
Y Filter -
INFRA_VN
Name vManage VPN Guest VN
DEFAULT_VN
wManage VPN
| 100 ~
INFRA_VN
Q searct
10
20
100
T
30
Show 10 entries Showing 1 - 2 of 2 Cancel

Tech tip

The vManage VPN lists all the user-configured Service VPNs that are created and associated to I0S-XE WAN Edge device that are part of
the integration.

click Accept

A

Warning

You are setting the vManage VPN for an
INFRA VN over which underlay devices

are managed. If the LAN devices are
already added in the INFRA VN, then
they may become unreachable after
changing it. Do you want to continue?

Cancel

Step 3.  Repeat the previous step, Step 2, for all Service VPN deployed in the SD-WAN fabric that has a corresponding Virtual
Network already created.
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Cisco DNA Center

Policy - Virtual Network Qo @ o
Virtual Networks (2) Last updated: 5:20 AM £ Refresh G Create Virtual Network
% Fier
Name vManage VPN Guest VN Scalable Groupi(s)
DEFAULT_VN 21
INFRA_UN 100 Add

Step 4. Create a new SD-Access Virtual Network and map to Cisco SD-WAN Service-VPN to it.
Click Create Virtual Network

= Cisco DNA Center

Policy - Virtual Network Q O ® o
Virtual Networks (2) Last updated: 5:20 AM £ Refresh
W Filter
Name VManage VPN Guest VN Scalable Group(s)
DEFAULT_VN 21
(& INFRA_VN 100 Add

Input Name and choose the Service VPN that maps to the Virtual Network from the drop-down option

Click Save

Cisco DNA Center Palicy - Virtual Network

Q ® @ o
) ’ x
Virtual Networks (2) Create Virtual Network
“\ Filter -
I VN_CAMPUS |
Name VManage VPN Guest N
DEFAULT_VN Manage VPN
10 . |
INFRA_VN 100
[0 Guest Virtual Network
Show 10 entries Showing 1 - 2 of 2 Cancel
Select Accept
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&

Warning

You are setting the vManage VPN 10 a
VN. This should not be changed once
this is used in the LAN network as
changing it can disrupt the network. Do
you want to continue?

Cancel

Step 5. Repeat the previous step, Step 4, for all Service VPN deployed in the SD-WAN WAN fabric and that requires
corresponding Virtual Network in the Cisco SD-Access fabric.

Step 6.  Verify each Virtual Network is mapped to SD-WAN Service VPN extending the macro-segmentation from one domain
to another.

= Cisco DNA Center Policy - Virtual Network aQ ® @ o
Virtual Networks (5) Last updated: 5:30 AM () Refresh ‘ @ create Virual Network

' Filter

Name wvManage VPN Guest VN Scalable Group(s)

O DEFAULT_VN 21

O INFRA_VN 100 Add

O VN_CAMPUS 10 Add

(@] VN_GUEST 30 Add

Q VN_IOT 20 Add
Show 10 entries Showing 1 - 5 of § 1

Procedure 5. Associate Scalable Groups to Virtual Networks

This section details the procedure to create Scalable groups and associate Scalable groups to Virtual Networks.

Step 1. In Cisco DNA Center, navigate to Policy > Group-Based Access Control
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Cisco DN Q @ @ 0
Take a Tour  [_] Explore
nnel. X
Critical Issues Trends and Insights
Last 24 Hours Last 30 Days
P1 P2 Throughput Coverage Capacity
Details View Details
Step 2.  Select Scalable Groups tab
= Cisco DNA Center Palicy . Group-Based Access Control Q @ @ 0

© Migration is complete. Cisco DNA Center will be the policy administration point, and screens of Scalable Groups, Access Contracts and Policies in Cisco ISE will be read-only. You can review the policy migration log, and/or change the administration X
mode in GBAC Configurations

Policies Access Contracts Analytics
Scalable Groups (19)
Q Sear ble Y
0 Selected Deploy
O Name Tag Value Description Created in Policies Virtual Networks
O Auditors 9/0x9 Auditor Security Group 1] DEFAULT_VN
O BYOD 15/0xf BYQD Security Group o DEFAULT_WN
O Contractors 5/0x5 Contractor Security Group 0 DEFAULT_VN

Note: By default, the Scalable Group learnt from ISE are associated to DEFAULT_VN
Step 3.

To associate the Scalable Group to different Virtual Network, select the Scalable Group from the list and click Edit

= Cisco DNA Center

Policy - Group-Based Access Control Q @ @ L

© Migration is complete. Cisco DNA Genter will be the policy administration point, and screens of Scalable Groups, Access Contracts and Policies in Cisco ISE will be read-only. You can review the policy migration log, and/for change the administration
mode in GBAC Configurations

Policies Scalable Groups Access Contracts Analytics

Scalable Groups (19) @ Create Scalable Group
Q Search Table v
1 Selected Delete  Deploy
a2 Name Tag Value Descriptian Created in Policies Virtual Netwarks
O Auditors 9/0x8 Auditor Security Group 0 DEFAULT_VN
O BYOD 15/0xf BYQD Security Group 0 DEFAULT_VN

E Contractors 5/0x5 Contractor Security Group 0 DEFAULT_VN

Select the Virtual Networks from the options and click Save

© 2021 Cisco and/or its affiliates. All rights reserved. Page 60 of 148



= Cisco DNA Center Policy . Group-Based Access Control a @ @ 0
) Migration is complete. Cisco DNA Center will be the policy administration point, and screens of Scalable Groups, Access Contracts and Policies in Cisco ISE will be read-only. You i x
mode in GBAC Configurations Edit Scalable Group
Policies Scalable Groups Access Contracts Analytics Nome*
— Contractors
Scalable Groups (19)
Q, Search Table Tag Value {decimal)®
5
1Selected  Edit Delete  Deploy
Description {optional)
] Name Tag Value Deseription Created in Contractor Security Group
£
(| Auditors 9/0x9 Auditor Security Group
Virtual Networks™
O BYOD 15/0xf BYOD Security Group VN_CAMPUS x @ ~
] Contractors 5/0x5 Contractor Security Group Q Search
O Critical_SGT 19/0x13 undefined DEFALLT_WN
INFRA_VN
[m] Developers B8/0xB Develaper Security Group
YN_CAMPUS
(] Development_Servers 12/0xc Development Servers Security Group VNGUEST
VN_IOT
O Employees a/0xd Employee Security Group
(| Extranet 17/0x11 Extranet Scalable Group
O Guests 6/0x8 Guest Security Group
Cancel
19 Records
-
Cisco DNA Center Policy - Group-Based Access Control Q & @ L

) Migration is complete. Cisco DNA Genter will be the policy administration point, and screens of Scalable Groups, Access Contracts and Policies in Cisco ISE will be read-only. You can review the policy migration log, and/or change the administration
mode in GBAC Configurations

Policies Scalable Groups Access Contracts Analytics

Scalable Groups (19)

@ Create Scalable Group

Q,  Search Table Y
0 Selected Deploy
O Name Tag Value Description Created in Policies Virtual Networks ~

@]

5/0x5 Contractor Security Group o VN_CAMPUS

Step 4. Repeat Step 3, for other Scalable Groups being deployed at the site.

Step 5. To create new Scalable Group, select Create Scalable Group

= Cisco DNA Center Policy - Group-Based Access Control Q@ @ 0

© Migration is complete. Cisco DNA Center will be the policy administration point, and screens of Scalable Groups, Access Contracts and Policies in Cisco ISE will be read-only. You can review the policy migration log, and/or change the administration X
mode in GBAC Configurations

Policies Scalable Groups Access Contracts Analytics
Scalable Groups (19) ]
Q, Sesrch Table v
0 Selected Deploy
] Name Tag Value Description Created in Policies Virtual Networks ~
] Contractors 5/0x5 Contracter Security Group 0 VN_CAMPUS

Input Name, Tag Value (optional), Virtual Networks and click Save
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= Cisco DNA Center

Policy - Group-Based Access Control

Q o @ O

mode in GEAC Configurations

) Migration is complete. Cisco DNA Center will be the palicy administration paint, and screens of Scalable Groups, Access Contracts and Policies in Cisco ISE will be read-anly. You

Policies Scalable Groups Access Contracts Analytics

Scalable Groups (19)

Q  Search Table

0 Selected Deploy
(m] Name Tag Value
(|} Contractors 5/0x5
[m] Auditors 9/0x9
(m] BYOD 15/0xf
[m] Developers 8/0x8
a Development_Servers. 12/0%c
()] Employees 4/0x4
a Guests 6/0x6
(m} Network_Services 3/0x3
a PCI_Servers 14/0xe
19 Records

Cisco DNA Center

Description Created in

Contractor Security Group

Auditor Security Group

BYOD Security Group

Developer Security Group

Development Servers Security Group

Employee Security Group

Guest Security Group

Network Services Security Group

PCI Servers Security Group

Policy . Group-Based Access Control

Create Scalable Group

Name*

| IP_PHONE_SGT I
|=——

Tag Value (decimal)®
18

Description (optional)

IP_PHONE_SGT !
z

Virtual Networks*®
VN_CAMPUS X -

(] Propagate to ACI

Cancel

a @ ® 4o

mode in GBAC Configurations

® Migration is complete. Cisco DNA Center will be the policy administration point, and screens of Scalable Groups, Access Contracts and Pol

's in Cisco ISE will be read-only. You can review the policy migration log, and/or change the ads

X

Policies Scalable Groups Access Contracts Analytics

Scalable Groups (20)

Q  Search Table

0 Selected Deploy
(] Name Tag Value
O Contractors 5/0x5

[m]

Step 6.

© 2021 Cisco and/or its affiliates. All rights reserved.

Description Created in

Contractor Security Group

IP_PHONE_SGT

o @ Create Scalable Group

v

Policies Virtual Networks =

0 VN_CAMPUS

Repeat the previous step, Step 5, to create additional Scalable Group and associate Virtual Networks.
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= Cisco DNA Center Policy - Group-Based Access Control Qa ® @ 4L

o Migration is complete. Cisco DNA Center will be the policy administration point, and screens of Scalable Groups, Access Contracts and Policies in Gisco ISE will be read-only. You can review the policy migration log, and/or change the administration X
mode in GBAC Configurations

Policies Scalable Groups Access Contracts Analytics
Scalable Groups (21) b @ Create Scalable Group
Q  Search Table T4
0 Selected Deploy
(] Name Tag Value Description Created in Policies Virtual Networks ~
O IoT_Device_SGT 20/0x14 loT_Davice_SGT o VN_IOT
(] Guests 6/0x8 Guest Security Group 0 VN_GUEST
O Contractors 5/0x5 Contractor Security Group 0 VN_CAMPUS
O Employees 4/0xa Employee Security Group 0 VN_CAMPUS
(] IP_PHONE_SGT 18/0x12 IP_PHONE_SGT 0 VN_CAMPUS
O Network_Services 3/0%3 Network Services Security Group 0 DEFAULT_VN I

Process 4: Configuring LAN Segment manually

This section of the deployment guide provides detailed steps to manually configure the LAN segment with the intent to build
Fabric GRT reachability at the site and also provide Fabric GRT reachability across sites.

WAN Edge device connectivity to LAN and WAN segment over different Service VPN.

Figure 20.  Cisco SD-WAN WAN Edge Interface Service VPN Mapping

vManage

vBond O* vSmart

SD-WAN Fabric

WAN Edge
m VPNO - WAN Transport m
,.,,,,_/
VPN100 - Fabric GRT Service VPN { BN|CP ' WAN Edge
/\

R1001-HX-2
WAN Edge A
ASR1001-HX-1 '
(@& O WAG

Shared-Services

ISE  DNAC DHCP, DNS, AD

DR
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Procedure 1. Creating Interface template connecting to the LAN segment

This section details the procedure to create templates for Ethernet interface on the I0S-XE WAN Edge devices with the intent to
connect to downstream LAN devices at the site.

Step 1. Login to vManage, navigate to Configuration > Templates, click Feature tab and Add Template

Cisco vManage

5 | LX CONFIGURATION | TEMPLATES
Device Feature

o

a © Add Template Q e
Template Type NonDefault  ~ Search Options v Total Rows: 37

— T e e I i

a SD-WAN_CONTROLLER_V... SD-WAN_CONTROLLER_V... wvwSmart VPN vSmart | vManage admin 13 Aug 2021 11:25:18 AM.

. SD-WAN_CONTROLLER_V... SD-WAN_CONTROLLER_V... vSmart VPN vSmart|vManage 2 2 admin 13 Aug 2021 11:27:57 AM..
SD-WAN_CONTROLLER_S... SD-WAN_CONTROLLER_S. vSmart System vBmart|vManage 2 2 admin 13 Aug 2021 111810 AM... ...

Step 2.  Select the WAN Edge devices from the list and under VPN category, click Cisco VPN Interface Ethernet template

Cisco vManage

LX CONFIGURATION | TEMPLATES

Device Feature

|
Feature Template - Add Template
o
- |
r Cisco Secure Internet Gateway (SIG) Cisco VPN Interface Ethernet
s AsRnET Cisco VPN
WAN Management | WAN | LAN
ASR1001-X
m
ASR1002-HX Cisco VPN Interface GRE Cisco VPN Interface IPsec VPN Interface Ethemet PPPoE
WAN WAN WAN

ASR1002-X

ci101-4p VPN Interface Multilink

WAN|LAN

Step 3. Input Template Name and Description to reference the template.
Under Basic Configuration tab, select

Shutdown: No

Interface Name: ‘vpn100_lan_interfacel’

Description: ‘vpn100_lan_interfacel’

Select IPv4

Select Static

IPv4 Address/prefix length: ‘vpn100_lan_interface_address’
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Cisco vManage

* CONFIGURATION | TEMPLATES

Device Feature

jmu}

Feature Template Add Template Cisco VPN Interface Ethernet
E-3

Device Type ASR1001-HX,ASR1001-X ASR1002-HX,ASR1002-X,ISR4321,I1SR4331,ISR4351,ISR4431,ISR4451-X,ISR4461
-

Deseription LAN_INTERFACE?

o Basic Configuration Tunnel NAT VRRP ACL/QoS ARP TrustSec Advanced

DNFIGURATION

Shutdown

Interface Name o< [:]
Description < | ven100_ten interfacer

O pymamic

Secondary IP Address (Maximum: 4) © Add

Under Advanced tab, input
IP MTU: 2000

click Save
Tech tip

IP MTU for the interface connecting to the SD-Access LAN segment must be increased to more than 1550 to accommodate the VXLAN
encapsulated packets. It is recommended to change the MTU size to highest supported value on the interface, which is 2000 bytes.

Cisco vManage

tH ° CONFIGURATION | TEMPLATES

Device Feature

|
Feature Template - Add Template - Cisco VPN Interface Ethernet
Basic Configuration Tunnel NAT VRRP ACL/QoS ARP TrustSec

&
" Duplex -
o MAC Address ©-

1P MTU

TCP MSS O~

Speed o~

ARP Timeout -

Autonegotiation o~ on off

TLOC Extension @~

Goneel

Step4. Repeat this Procedure to add additional interface(s) that connects the I0S-XE WAN Edge devices to the Fabric GRT
LAN segment.
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P - i

[+ 2

Cisco vManage

Device Feature

© Add Template

Template Type | MonOsfaut  ~

* CONFIGURATION | TEMPLATES

Q,  INTERFAGE x

Search Options v

Total Rows: 16 of 37

L B 15 B 2 B

LAN_INTERFACE2
LAN_LOOPBACKD
LAN_MAIN_INTERFACE1
LAN_MAIN_INTERFACE2
LAN_MAIN_INTERFACES
LAN_SUB_INTERFACE1
LAN_SUB_INTERFACEZ

LAN_SUB_INTERFACE3

Tech Tip

LAN_INTERFACE2
LAN_LOOPBACKO
LAN_MAIN_INTERFACE1
LAN_MAIN_INTERFACEZ
LAN_MAIN_INTERFACES
LAN_SUB_INTERFACE1
LAN_SUB_INTERFACEZ

LAN_SUB_INTERFACE3

Cisco VPN Interface Ethernet

Cisco VPN Interface Ethernet

Cisco VPN Interface Ethernet

Cisco VPN Interface Ethernet

Cisco VPN Interface Ethernet

Cisco VPN Interface Ethernet

Cisco VPN Interface Ethernet

Cisco VPN Interface Ethernet

ISR4331|ISR4221X | ISR4451-X ...
ISR4331 | ISR4221X | ISRv | ISR4. .

ISR4331|ISR4221X | ISRv | ISRA. .

ISR4331|1SR4221X | ISRv | ISR4.
ISR4331 | ISR4221X | ISR | ISR4.

ISR4331 | ISRAZ21X 1SR | ISR4,

ISR4331|ISR4221X | ISRv | ISR4...

ISR4331 | ISR4221X | ISRv | ISR4. .

admin

admin

admin

admin

admin

admin

admin

admin

17 Aug 2021 5:05.05 PM PDT
17 Aug 2021 5:19:30 PM PDT
17 Aug 2021 5:18:28 PM PDT o
17 Aug 2021 5:18:48 PM PDT
17 Aug 2021 5:19:08 PM PDT
17 Aug 2021 4:30:56 PM POT
17 Aug 2021 4:31:46 PM PDT

17 Aug 2021 4:32:32 PM PDT

10S-XE WAN Edge deployments with connection to peer-device, via IP-Transit, to reach the Shared-Services servers leverage sub-
interfaces to accommodate Fabric GRT and overlay interface handoff. In such deployment, create the main-interface first with the Cisco
VPN Interface Ethernet feature template and then add any additional interface template for each sub-interface with reduced IP MTU
(1996) to accommodate the 4-bytes Dot1Q information.

Procedure 2.

Also, ensure all the Fabric GRT interface template are associated to the dedicated Fabric GRT Service VPN.

Configuring routing protocol template to form LAN segment routing adjacencies

This section details the procedure to create routing protocol, OSPF, templates on the 10S-XE WAN Edge devices with the intent

to form routing adjacencies to downstream LAN devices at the site.

Step 1.

Cisco vManage

Login to vManage, navigate to Configuration > Templates, click Feature tab and Add Template

A% 0

[+

Step 2.

| L& CONFIGURATION | TEMPLATES |

Device Feature
© Add Template

Template Type | NenDefauit

SD-WAN_CONTROLLER_V...
SD-WAN_CONTROLLER_V.

SD-WAN_CONTROLLER_S...

SD-WAN_CONTROLLER_V...

SD-WAN_CONTROLLER_V...

SD-WAN_CONTROLLER_S.

vSmart VPN
vSmart VPN

vSmart System
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Search Options v

vSmart|vManage
vSmart|vManage

vSmart|vManage

2

2

2

2

admin
admin

admin

0=

Total Rows: 37

13 Aug 2021 112518 AM... ...

13 Aug 2021 11:27:57 AM... ...

13 Aug 2021 1111810 AM... ..

Select the WAN Edge devices from the list and under Other Templates category, click Cisco OSPF template
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Cisco vManage

Q CONFIGURATION | TEMPLATES

Device Feature

] —
Feature Template - Add Template
E-3
aQ Select Devices
OTHER TEMPLATES
=
ASR1001-HX Cli Add-On Template
- AppQoE Cisco Banner
WAN
ASR1001-X
o
ASR1002-HX Cisco BGP Cisco DHCP Server Cisco IGMP
ASR1002:X TSI LAN LAN
O cuoap . . Cisco OSPF
Cisco Logging Cisco Multicast
O ci1101-4PLTER WANILAN
O crio-4paepwe Cisco OSPFV3 Cisco PIM . ‘
Cisco SIG Credentials
D C1109-2PLTEGB el L
O crios2preus EIGRP
Cisco SNMP Probes
O ©1109-2PITEVZ —
=

Step 3. Input Template Name and Description to reference the template.
Under Basic Configuration tab, select

Router ID: ‘ospf_router_id’

Cisco vManage

X CONFIGURATION | TEMPLATES

Device Feature

=
Feature Template - Cisco OSPF - LAN_OSPF

o

aQ Device Type ISR4331,/SR4321,ISR4351ISR4221,ISR4221X,ISR4431,ISR4461,ISR4451-X ASR1001-HX,ASR1002-X ASR1002-HX,ISRV,ASR1001-X
Template Hame :

-]

m

Redistribute Maximum Metric (Router LSA) Area Advanced

flouterl =" :]

Distance for External Routes o~
Distance for Inter-Area Routes (B9
Distance for Intra-Area Routes [

Step4. Under Redistribute tab, click New Redistribute and select
Protocol: ‘ospf_redistribute_protocol’
Enable Mark as Optional Row
and click Add
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Cisco vManage

X CONFIGURATION | TEMPLATES

Device Feature

Feature Template - Add Template

Basic Configuration Maximum Metric (Router LSA) Area Advanced

P - |

1]

m E’Mark as Optional Row ()

Route Policy @~

Cancel

N N

Step 5. Under Area tab, click New Area and input

Area Number: ‘ospf_area_a_number’

Click Add Interface and click Add Interface

Cisco vManage

X CONFIGURATION | TEMPLATES

Device Feature

Feature Template - Add Template - Cisco OSPF

Advanced

Maximum Metric (Router LSA)

-3
Basic Configuration Redis
-\

o ] Mark as Optional Row ()

Set the area type o~

Interface

Range

Cancel
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No OSPF Interfaces added, add your first OSPF Interface

Configure With No Interfaces

Input Interface Name: ‘ospf_intefacel’
Add additional interfaces as needed for the deployment by clicking Add Interface

and then click Add

Interface Name = Loopbackd

ospf_interfacel

osplnterface2 Hello Interval {seconds)

aspf_interfaced

Dead Interval (seconds)

LSA Retransmission Interval
(seconds)

Interface Cost

Advanced Options >

Cancel

Click Add
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Cisco vManage

= ﬁ CONFIGURATION | TEMPLATES

Device Feature
Feature Template - Add Template - Cisco OSPF

Basic Configuration Redistribute Maximum Metric (Router LSA) m Advanced
- ]
[J Markas optional Row @

]
Area Number & -
Set the area type ©-
Interface 4 Interface
Range © ~dd Range

Cancel

Step 6.  Click Save to save the routing protocol OSPF template

Cisco vManage

0 CONFIGURATION | TEMPLATES

Device Feature

o —
Feature Template Add Template Cisco OSPF
-
Basic Config imum Metric (Router LSA) m Advanced
- = [osplarea_a_num]
m

aneel

Cisco vManage - (%] admin ~

£X CONFIGURATION | TEMPLATES

Device Feature

ee

Template Type  Morbefaut = Q, [ osPF x Search Options w Total Rows: 1 of 37
_—_————-
= LAN_OSPF LAN_OSPF Cisco DSPF ISR4331 | ISRAZZ1X| ISRy |ISRA... 1 admin 17 Aug 2021 5:20.04 PM PDT

Procedure 3. Associating interface, routing protocol templates on the I0S-XE WAN Edge device

This section details the procedure to associate Cisco VPN Ethernet interface, routing protocol template with the intent to
establish connectivity, establish routing adjacencies with network devices at the site and to provide end-to-end Fabric GRT
connectivity across sites.

Step 1. Login to vManage, navigate to Configuration > Templates, click Device tab

© 2021 Cisco and/or its affiliates. All rights reserved. Page 70 of 148



Cisco vManage

PRl ¢ CONFIGURATION | TEMPLATES

-]

. Device | Feature

o (o1=]

a, Template Type MorDefaut = Q Search Options v Total Rows: §

S T R N 2

= A-ASR1001X-1 A-ASR1001X-1 Feature ASR1001-X admin 13 Sep 2021 6:48:47 PMPDT  In Sync

o AASRI001X:2 AASRI00TX2 Feature ASR1001-X 27 1 admin 13 Sep 2021 &:50:14 PMPDT  In Sync
RS12-1SR4331-18 RS12-1SR4331-18 Feature 1SR4331 19 1 admin 13 Sep 2021 6:51:38 PMPDT  In Sync

m WManage vManage Feature vManage 3 i admin 16 Aug 2021 25253 PMPDT  In Sync .
Smart wSmart Feature vSmart 10 1 admin 16 Aug 2021 2:50:33 PM PDT  In Sync

Step 2.  Select the WAN Edge device from the list and click three dots (..) and select Edit from the drop-down options

Cisco vMan

Q CONFIGURATION | TEMPLATES

De

© Create Template ~ 0 e

Feature

E ]
Template Type | Nonoefault = Q, Search Optians v Total Rows: §
. T T T TN

= Feature ASR1001-X admin 13 Sep 2021 6:48:47 PMPDT In Sync
.- A-ASR1001X-2 A-ASR1001X-2 Feature ASR1001-X 27 1 admin 13 Sep 2021 6:50:14 PMPDT  In Sync. E
2 i

RS125R4331-18 RS12-1SR4331-18 Feature 1SR4331 19 1 admin 13 Sep 2021 6:51:38 PMPDT  In Sync View i
o vManage YManage Feature wManage 9 1 admin 16 Aug 2021 25253 PMPDT InSync | pelete

vSmart vSmart Feature vSmart 10 1 admin 16 Aug 2021 2:50:33 PM PDT  In Sync Cﬂpy
| Attach Devices
Detach Devices
Export CSV
Change Device Values

Step 3.  Select Service VPN tab

click Fabric GRT Service VPN from the list and click three dots (...) and select Edit from the options

Cisco vManage

$ CONFIGURATION | TEMPLATES

Basic Information Transport & Management VPN Additional Templates
]
Service VPN
- ]
1 Rows Selected | [EIREl El
Q Search Options v
o
n 0 Template Name
[ & | e7era7a8-3att.4200-8596-e2b5b1b39300 VPN_SERVICEVPN100
L ab266174-88b5-4bd4-8401-560da0587efb VPN_SERVICEVPN10 - e
[ 09320003-d4d7-472c-a039-747106197707 VPN_SERVICEVPN20 -
O fbdac024-f6af-4b37-bede-324133226d92 VPN_SERVICEVPN3D e

Step 4. Selectinterfaces that connects to the LAN segment, by selecting Additional Cisco VPN Templates > Cisco VPN
Interface Ethernet

And select the interface template previously created.
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Additional Cisco VPN Templates

Cisco BGP BGP_VPN100 - @

© Cisco IGMP

° © Cisco Multicast
Cisco VPN Interface Ethernet - Sub-Templates ~
LAN_LOOPBACKD L] ol © CiscoPIM

Cisco VPN Interface Ethernet LAN_SUB_INTERFACE2 - @ © sub-Templates ~ @ Cisco OSPF

© Cisco OSPFv3
Cisco VPN Interface Ethernet LAN_SUB_INTERFACE3 - @ © sub-Templates ~

© Cisco VPN Interface IPsec
Cisco VPN Interface Ethernet | LAN_INTERFACET - |° © sub-Templates ~ © EiGRP

© VPN Interface MukiLink Controller
Cisca VPN Interface Ethernet I LAN_INTERFACE2 . |e © Ssub-Templates ~

Step 5.  Select routing protocol by selecting Additional Cisco VPN Templates > Cisco OSPF

And select the routing protocol template previously created.

CRUNELE - (=] an Q dmin «
X
I Additional Cisco VPN Templates ]
Cisco BGP BGP_VPN10D - ©
= © Cisco IGMP
© Cisco Multicast
Cisco OSPF -
LaR-osPr e © CiscoPIM
Cisco VPN Interface Ethernet. LAN_LODPBACKD . @ © Sub-Templates ~
© Cisco OSPFv3
Cisco VPN Interface Ethernet LAN_SUB_INTERFACE2 - @ © Sub-Templates ~ © Cisco VPN Interface Ethemnet
© Cisco VPN Interface IPsec
Cisco VPN Interface Ethernet LAN_SUB_INTERFACES . @ O SubTemplates ~ © EIGRP
© VPN Interface MuktiLink Controller
Cisco VPN Interface Ethernet LAN_INTERFACET - @ © Sub-Templates ~
Cisco VPN Interface Ethernet LAN_INTERFACEZ - @ @ Sub-Templates
Step 6.  Click Save.
- =] att @ min =
Additional Cisco VPN Templates
Cisco BGP BGP_VPN1OD - ©
- © Cisco IGMP
© Cisco Multicast
Cisco OSPF -
LAN.0sPR ® © CiscoPIM
Cisco VPN Interface Ethernet LAN_LOOPBACKD - @ © sub-Templates ~
© Cisco OSPFv3
Cisco VPN Interface Ethernet LAN_SUB_INTERFACE2 - ® © sub-Templates ~ © Cisco VPN Interface Ethernet
© Cisco VPN Interface IPsec
Cisco VPN Interface Ethernet LAN_SUB_INTERFACE3 . e © Sub-Templates ~ © EIGRP
© VPN Interface MultiLink Controller
Cisco VPN Interface Ethernet LAN_INTERFACET . @ @ Sub-Templates
Cisco VPN Interface Ethernet LAN_INTERFACEZ - @ @ Sub-Templates

CANCEL

Step 7. Click Update to associate the templates to the WAN Edge device
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sco vManage

%2 CONFIGURATION | TEMPLATES

Device  Feature

¢ Device Model
\ Template Name
Description AASRI00TX1
Basic Information Transport & Management VPN Service VPN
m

Basic Information

Cisco System * WAN_EDGE_SYSTEM -
Cisco Logging* Factory._Default Cisco_Logging Template =
Cisco NTP CISCONTP - ®

Additional Cisco System Templates

Step 8.  Input values to device-specific variables, by clicking the three dots (...) and choose Edit Device Template

a CONFIGURATION | TEMPLATES

Device Template | A-ASR1001X%-1

Search Options v

]
aQ

Ik

ASR1001-X-JAE204100WU 11110 A-ASR1001X-1

And click Update

Variable List (Hover over each field for more information)
Chassis Number

System IP

Hostname

Interface Name(vpn100_lan_interface2)

IPv4 Address/ prefix-length(vpn100_lan_interface2_address)
Interface Name(vpn100_lan_interface1)

IPva Address/ prefix-length(vpn100_lan_interface1_address)
Interface Name(vpn100_subinterface3)

IPv4 Address/ prefix-length(vpn100_subinterface3_address)
Interface Name(vpn100_subinterface2)

IPv4 Address/ prefix-length(vpn100_subinterface2_address)
IPv4 Address/ prefix-length(vpn100_loopbackD_address)

AS Number(bgp_as_num)

Network Prefix{bgp_network_address_prefix_G0/0/2.1)
Address(bgp_neighbor_address_interface2)

Remote AS(bgp_neighbor_remote_as_interface2)

Interface Name(vpn512_mgmt_interface)
Address(vpn0_MPLS_nexthop)

Address(vpnO_INET _nexthop)

Interface Name(mpls_interface_name)

IPv4 Address/ prefix-length(mpls_interface_ip_address)

Interface Nam

net_interface_name)

Generate Password

Chassis Number m Interface Name(vpn100_lan_interface2) 1Pv4 Address/ prefix-length(vpn100_lan_interface2_address)

TenGigabitEthemetd/0/1

(2] ]

Total Rows: 1

Interface Name{vpn100_lan_interface1)

10.4.202 5/30 TenGigabitEtherneto/0/0

ASR1001-X-JAE204100WU
11110
A-ASRI001X-1
TenGigabitEthernet0/0/1
10.4.202.5/30
TenGigabitEthernetd/0/0
10.4.202.1/30
GigabitEthernet0/0/1.1
10.4.202.89/30
GigabitEthernet0/n/2.1
10.4.202 85/30
10.4.200.1/32

5000

10.4.202.84/30
10420286

3

GigabitEthernetd
105208121
105207121
GigabitEthernet0/0/4
10.5.208.122/30

GigabitEthernet0/0/5

Step 9. Click Next and Configure Devices
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Cisco vManage

£ CONFIGURATION | TEMPLATES
exit

interface TenGigabitEthernetd/a/o
description  wpnl@®_lan_interfacel
no shutdown

arp timeout 1280

vrf forwarding 100

ip address 10.4.202.1 255,255.255,252

Device Template Total
A-ASR1001X-1 1

Device list (Total: 1 devices)

ip mtu 2000

ASR1001-X-JAE204100WU load-interval 30

AASRI001X111.1.1.10 mtu 2000
exit

interface TenGigabitEthernet@/a/1
description  vpnl@@_lan_interface2
no shutdown

arp timeout 1280

vrf forwarding 100

ip address 10.4.202.5 255.255.255.252

ip mtu 2000
load-interval 30
ntu 2000

exit

interface Loopback®
description vpnl@@_loopbackd
Configure Device Rollback Timer

Cisco vManage

B TASK VIEW

Push Feature Template Configuration | € Validation Success ~ Initiated By: admin  From: 100.119.42.104

Total Task: 1| Success : 1

Q Search Dptions Total Rows: 1
&

I N T T N T T
- @ Success Dane - Push Feature Template ASR1001-X-JAEZ047100WU ASR1001-X A-ASR1001X1 11190 10 1minnn
m

Step 10. Repeat steps in this Procedure to establish resilient, highly available Fabric GRT connectivity on each I0S-XE WAN
Edge device

Cisco vManage

[Pl B TaskVEW

o Push Feature Template Configuration | € Validation Success ~ Initiated By: admin From: 100.119.42.104
Total Task: 1| Suecess : 1
o
Search Optins v Total Rows: 1
- Q ot
I L T T O N N S
- @ Success Done - Push Feature Template ASR1001-X-JAE203201XB ASR1001-X A-ASR1001X-2 1.1anm 11.11.91.11

Step 11. Verify the Fabric GRT connectivity to the downstream devices

In vManage, navigate to Tools > SSH Terminal, select the WAN Edge device from the list. Login with the device
credentials and execute the below command

‘show run int <interface name>’
‘show ip ospf neighbor’

‘show ip route vrf <Fabric GRT Service VPN>’
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Cisco vManage i admin ~

9, TOOLS | SSH TERMINAL

Device Group

All

Q

Sorthy Reachability

vmanage
111111

A-ASR1001X-1
1.1.1.10 | siteID:10
Reachable

A-ASR1001X-2

11101 | Site

RS12-1SR4331-18
2.1 | Site ID: 12

Cisco vManage

admin «
9, TOOLS | SSH TERMINAL

Device Group ¢ 1111

All s

Q

Sortby Reachability %

FULL/DR
FULL/DR

vmanage vManage 0 sh ip route vrf 100
1.11.11.11 | SiteID.

vsmart vSmart

12121212 | SitelD: 11
vbond
A-ASR1001%-1 ASR1001-X

1.1.1.10 | Site ID: 10
Reachable

1001X-2
1| Site ID: 10

SR1001-X

A-ASR
1114

RS12-ISR4331-18 5R433
2121 | Site 1D:12

Procedure 4 Discover and Provisi

This section details the procedure to discover, provision the switches to a site with the intent to build Fabric GRT and prepare
network devices to build Cisco SD-Access network.

Please refer Cisco SD-Access Design Guide for design recommendation band deployment best-practices to build resilient Fabric
GRT network for Cisco SD-Access fabric site.

Step 1. In Cisco DNA Center, navigate to Tools > Discovery
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Cisco DNA Center

Takea Tour [ Explore
Design B
prnel. X
Command Runnei
License Manager
Critical Issues Trends and Insights
Last 24 Hours ast 30 Days
Tools ) .
Platform > P O O I - —_—
Activities Ne ner P P2 Thraughput Coverage Capacity
View Details View Detalls
Step 2.  Click Add Discovery
= Cisco DNA Center Toals - Discovery Q & o L
Sep 14, 2021 7:25 AM
Discovery
Inventory Overview Latest Discovery
As of Sep 14, 2021 7:26 AM As of Sep 14, 2021 7:26 AM : Site-3
W Routers : 0

e Add Discovery || View Al Discoveries
W Success : 1

Unreachable : 0

M Discarded : 0

Device Controllability is Enabled. W Unknown : 3

Step 3. Input Discovery Name
Select Discovery Type: IP Address/Rage and input IP Address of the devise to be discovered
Select Preferred Management IP Address: Use Loopback

= Cisco DNA Center Tools - Discovery - Add Discovery

jol
@
\
:
(]

Discovery > Add Discovery

New Discovery

Site-3 | 1 Reachable Devicals)
Range 10.4.210.140-10.4 210,140 Discavery Name*
Site-2 | 1 Reachable Devicels)
Range 10.4.210.135-10.4. 210,138

SDA-TRANSIT-

R..  IP Address/Range *

Range 10.4.210.13

Discovery Typa

) CDP | IP Address/Range | () LLOP

" @

10.4.200.56

Subnet Filters @ +

Preferred Management IP Address (1)

(O None *) Use Loopback

Under Credentials > select CLI, SNMPv3, HTTP(s) Read, HTTP(s) Write, NETCONF parameters
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= Cisco DNA Center

Discovery > Add Discovery

B

) Site-3 | 1 Reschavie Devicels)

= Range 10.4.210.140-10.4.210.140

Site-2 | 1 Reacnavie Devicels)

Rangs 10.4.210.135-10.4.210.135

SDA-TRANSIT-DEVICES | 3.

Range 10,4.216,130-10.4.210.132

@ Network_Devices | 4 reschavie ..

Range 10.4.210.123-10.4.210.126

New Discovery

Discovery Name®
RTP-LAN-Devices

“ Credentials

Tools - Discovery - Add Discovery

© At least one CLI credential and one SNMP credential are required.

© Netconf is mandatory for enabling Wireless Services on Wireless capable devices such as C9800-Switches/Controllers.

@ GLOBAL m Task-specific

CLl

SNMPv2c Read

[.j LAN_CREDENTAILS

SNMPv2c Write

HTTP(S) Read

SNMPv3

| [D SNMPv3_CREDENTIALS |

HTTP(S) Write

| u HTTPS_READ

|| (@D v e |

NETCONF

|rh

1

Step4. Under Advanced > Protocol Order, select SSH, Telnet

click Discover

= Cisco DNA Center

Discovary > Add Discovery

B e

5 Site=3 | 1 Reachatie Dovise(s)

Range 10.4.210.140-10.4,210.140

G Site2 | 1 Reacnusie evials)

Rangs 10.4.210.135-10.4 210,135

o SDA-TRANSIT-DEVICES | 1R...
Range 10.4.210.130-10.4 210,132

Network_Devices | 4« reachable ...

Range 10.4.210.123-10.4.210.126

New Discovery

Discovary Name*
RTP-LAN-Devices

HTTP(S) Read

Tools - Discovery - Add Discovery

.:] SNMPv3_CREDENTIALS

HTTP(S) Write

( D HTTPS_READ

] D HTTPS_WRITE

NETCONF

-

v Advanced

Pratocal Qrder O

[1] ssH

[ Telnet

Device Controllability is Enabled. Config changes will be made on network devices during

discovery/inventory or when device is associated to a site. Learn More | Disable

Step 5.  Verify the network devices are successfully discovered in Cisco DNA Center
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= Cisco DNA Center Toals - Discovery - Add Discovery a @ o o

Discovery > Add Discovery

Qv Search by [ . @ RTP-LAN-Devices 3 Reachable Device(s) | 00h:07m:18s © Take a Tour
. RTP-LAN-Devices | 3 Reachabi DEVICE STATUS . W Filter History »
" Range 10.4.200.55-10.4.200.58
P Address  DeviceName  Status ICMP + SWWP  CLI  NETCONF
(5 Site=3 | 1 Reachable Devica(s)
Ranga 10.4.210.140-10.4.210.140 10420086 | a-o300m
W Success 10420087 || a-suora
. Site-2 | 1 Roachable Devica(s)
- oachabio Bovioals 3 M Unreachable 10420058 | a-3850me
Range 10.4.210.195-10.4.210.136 Device(s)
Discarded
. SDA-TRANSIT-DEVICES | 3 ...
™ Range 10.4.210.130-10.4.210.132
Netwark_Devices | « Rsachatie ..
" Range 10.4.210.123-10..210.125 Discovery Details
COP Level None LLDP Level None
Protocol Order  ssh telnet Retry Count 3
Timeout 5 second(s) IP Address/Range  10.4.200.56-10.4.200.58
IP Filter List None Preferred Use Loopback
Management IP
Address
CLI Credentials  LAN_CREDENTAILS SNMPv2c READ  None
SNMPv2c WRITE  None SNMPv3 SNMPv3_CREDENTIALS
HTTP(S) READ HTTPS_READ HTTP(S) WRITE HTTPS_WRITE Show 25 Showing 116 3 of 3 Page 1 ~ of1
success @) wwmeachamie (2 paiume noreEn @) usavaLasLe

Step 6.  Verify the network devices are in Provision> Network Devices > Inventory > Unassigned Devices hierarchy and
devices are Reachable and in Managed state

= Cisco DNA Center | Provision - Network Devices - Inventory | Froview New Page a @ o L

Inventory Plug and Play

@ Global > Unassigned Devices H - N
Q) Find Hierarchy
DEVICES (3)
~ &b Global Focus: Inventory v
I © Unassigned Devices (3) Filter @ Add Device TagDevice Actions v (D | Take a Tour Asof 7:657 AM ) Export . Refresh
> d North America
a DeviceName -  IPAddress  Device Family ity (D) 0 (@  HealthScore  Sie MAC Address DeviceRole  ImageVersion  Uptime 1

10.4.200.58  Switches and Hubs | @ Reachable @ Managed @ compliant 1 Assign  00:57:d2:f8:9d:80 & ACCESS 16.12.3s 101 days 22 hrs

10420056 SWChesandHuds | g poachable @ Managed | @ Non-Compiant 10 Assign  baa8b9:c0:73:80 2 ACCESS  17.3.2a 101 days 22 hr:
(WLC Capable)
Switches and Hubs . e g .
10.4.200.57 (WLC Capable) @ Reachable Managed @ Compliant 0 Assign  2c:5a:0f:1c:f9:40 & ACCESS 17.3.2a 101 days 23 hre

Step 7.  Assign network devices to appropriate site.
Select network devices from the Unassigned Devices list

click Actions > Provision > Assign Device to Site
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= Cisco DNA Center

Inventory Plug and Play

Q. Find Hierarchy

Provision - Network Devices - Inventory

Praview New Page Q

@ 8 8L

@ Global > Unassigned Devices

a -

DEVIC 3)
~ ¢ Global rFocus: Inventory
© Unassigned Devices (3) | 7Fiter | @ Add Device Tag Device Take a Tour Asof: 7:57 M (T Export £ Refresh
» & North America
[} Device Name = IP Address Devic  Inventory > Manageability()  Compliance (O Health Score Site MAC Address Device Role Image Version Uptime i
A-3850mc @ 10.4.200.58 Swit Software Image > © Managed © Compliant 1 Assign 00:57:d2:f8:9d:80 & ACCESS  16.12.3s 101 days 22 hrt
.
A-9300b © 10420056 pliant 10 Assign  b4:a8:b9:c0:73:80 & ACCESS 17.3.2a 101 days 22 hre
Telemetry
Swit Provision Device
A-9407a @ 10420057 u Device Replacement > " 10 Assign  20:5a0f1c:f9:40 & ACCESS  17.3.20 101 days 23 hr:
LAN Automation
Others
LAN Automation Status
Compliance >
Choose the site for each device in the list and select Next
= Cisco DNA Center Provision - Network Devices - Inventory Praview New Page Q @ & 4L
Inventory Plug and Play X

Q) Find Hierarchy

DEVICES (3]
~ ¢ Global Focus: Inventory v
© Unassigned Devices (2) /Fiter | @ Add Device Tag Device Actions v @ | Take a Tour
» & Morth America
-] Device Name «  IP Address  Device Family Reachability (0
a A-3850mc (3  10.4.200.58 Switches and Hubs @ Reachable
Switches and Hubs
- .4.200.! Reachabl
[ ] A-9300b @ 10.4.200.56 0 i) @ Reachable
Switches and Hubs
- .4.200. Reachable
(] A94072 © 10420087 o ol ]
o Chonr 25 s mmeiae

Assign Device to Site

Serial Nurber Devices

FCW1949C1TX A-3850me | il Global/North America/Region - RTP... x I
Apply to All (D)

FCW2146L0GL A-5300b | b Global/North America/Region - RTP... |

FXS2131Q3YF P | & Global/North America/Region - RTP... |

View the parameters that gets provisioned to the device and select Next

= Cisco DNA Center

Inventory Plug and Play

Q) Find Hierarchy

DEVICES (3)
~ & Global Focus: Inventory v
© Unassigned Devices (3) 7 Filter © Add Device Tag Device Actions v @ | Takea Tour
» & North America
(] Device Name ~  IP Address Device Family Reachability (1)
=3850mc 10.4. . itches an ubs :achable
] A-3850mc @ 0.4.200.58  Switche d Hubs @ Reachabl
Switches and Hubs
- Reachabl
[] A-9300b @ 10.4.200.56 0 et @ Reachable
Switches and Hubs
] A-9407a @ 10420057 o o) ® Reachable
e, 25 .
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Provision - Network Devices - Inventory

Device Controllability is Enabled. Learn More | Disable Cancel
Preview New Page Q e ¢ L
Assign Device to Site .
A-3850mc
GLOBAL/NORTH AMERICA/REGION - The following settings will be deployed during assignment to
RTP/RTP-06 site.
I A-3850mc
Syslog Server Cisco DNA Center
A-9300b
Netflow Collector Cisco DNA Center
A-9407a IP Device Tracking MEW
Yes
Wireless Streaming Telemetry Yes
SNMP Trap Receiver Cisco DNA Center
AP Impersonation Enabled

Syslog Level 6 - Information Messages
Cisco TrustSec (CTS) Credentials  Yes
Controller Certificates Yes

Device Controllability is Enabled. Learn More | Disable Cancel

o)
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Click Assign

= Cisco DNA Center Pravision - Network Devices - Inventory Praview New Page Q @ g 0
[ It Pl dl Pl . . .
nventory ug and Play Assign Device to Site "

(), Find Hierarchy

DEVICES (3) O Now (O Later
~ & Global Focus: Inventary Task Name*
Assign 3 Device(s) to Site
© Unassigned Devices (3) Fiter | @ Add Device TagDevice Actions v @ | Take a Tour

> & North America
[] Device Name = IP Address Device Family Reachability (1) L

A-3850mc &  10.4.200.58 Switches and Hubs @ Reachable 4

Switches and Hubs

(WLC Capable) @ Reachable L

A-9300b @ 10.4.200.56

. Switches and Hubs

A-9407; 10.4.200.57 Reachable
= e (WLC Capabie) = I

Device Controllability is Enabled. Learn More | Disable Cancel

s . am

Step 8.  Navigate to appropriate site Hierarchy and view the devices are assigned to the site.

Ensure the network devices are Reachable and in Managed state

= Cisco DNA Center Provision - Network Devices - Inventory Preview New Page aQa @ @ O
Inventory Plug and Play
@ Global > North America > Region - RTP E - W
Q) Find Hierarchy
DEVICES (9)
~ & Global Focus: Inventory
O Unassigned Devices Vriter | @ AddDevice TagDevice Actions v @ Take a Tour Asof: 6:14 AM T Export £ Refresh

~ d North America
0 1P Address Device Family I ility (D) il OI Compliance (1) HealthScore  Site MAC Ac  §

> & Region - NY
|| D A-3850mc @ 10.4.200.58 Switches and Hubs @ Reachable @ Managed @ compliant 8 .../[Region - RTP/RTP-06  00:57:d2:f8:¢

> db Region - RTP

N Switchs d Hub:
> éh Region - SJC 0 A-9300b & 10.4.200.56 (V:'tg ;::al‘e)u S @ Reachable © Managed @ Compliant 10 .../[Region - RTP/RTP-06  bd:aB:b9:c0:

@ A-9407a © 10.4.200.57 m‘r;";:;‘;l';”bs @ Reachable @ Managed © Compliant 10 .[Region - RTP/RTP-06  2c:5a:0f:1c:f

Switches and Hubs

0O A-9500-1 @ 10420051 (0 oo abie) © Reachable @ Managed @ Compliant 10 .../Region - RTP/RTP-06  00:a3:d1:44:
itch
D A-9500-2 O 10.4.200.52 f\m‘; ;::a'::e':”bs © Reachable © Managed @ Compliant 10 ..IRegion - RTP/RTP-06  00:a3:d1:44:
0 A-ASR1001X-1 @ 10.4.200.1  Routers © Reachable @ Managed © Compliant 10 ../Region - RTP/RTP-06  20:3d:6f:d3:c
O A-ASR1001X-2 @O 10.4.200.2  Routers @ Reachable @ Managed @ Compliant 10 .../Region - RTP/RTP-06  00:ab:ca:el:l
D A-N7706-1.sda-lab.local ¢ 10.4.200.11 Switches and Hubs @ Reachable @ Managed @ Non-Compliant 10 .../Region - RTP/RTP-06  8c:60:4f:ab:E
o Show 25 “ entries Showing 9 of @

Step 9. If required, upgrade network device image.
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Tech Tip

For network devices that require Image upgrade, refer to detailed steps documented in Campus Software Image Management (SWIM)
using Cisco DNA Center Deployment Guide.

Image Management of I0S-XE SD-WAN WAN Edge devices is managed in SD-WAN vManage Controller, refer to detailed steps
documented in ‘Appendix B - Upgrading software on SD-WAN device’ in Cisco SD-WAN:WAN Edge Onboarding Prescriptive Deployment
Guide

Software Recommendation and Image location are available at Cisco Software-Defined Access Compatibility Matrix.

= Cisco DNA Center I Provision - Network Devices - Inventory Proview New Poge Q ®@ o o

Inventory Plug and Play

@ Global E > m
Q Find Hierarchy
DEVICES [10)
~ & Global | Focus: Software Images ~ |
© Unassigned Devices Fiter | @ Add Device TagDevice Actions v (O | Take a Tour Asof:9:19AM T Export £’ Refresh
> & North America
Device Name ~ IP Address Device Family I Site Reachability (7 I Software Image 0S Update Status Image Needs Upc
A-3850me © 10.4.200.58 Switches and Hubs  .../Region - RTP/RTP-06 @ Reachable cat3k_caa-universal...  16.12.3s 2““"?“["”‘ Success  pToRATE
See Details
itch H i
O A-9300b @ 10.4.200.56 OwichesandHubs o RTP/RTP-D6 @ Reachable  catSk_josxe.17.03.0...  17.3.4 Activation Success  |p1opATE
(WLC Capable) See Details
m] A-9407a © 10.4.20057 OwichesandHubs o ion - RTP/RTP-06 @ Reachable  catok_iosxe.17.03.0.. 17.3.4 Activation Suecess  \pTopATE
- (WLC Capable) See Details
m] A-9500-1 @ 10420051 SwichesandHubs o RTPRTP-06 @ Reachable  catok_iosxe.17.03.0... 17.3.4 Activation Success | \oropaTE
[WLC Capable) Ses Details

Switches and Hubs vt
0 A-9500-2 @ 10.4.200.52 > enes and i IRegion - RTP/RTP-06 @ Reachable  cat9k_iosxe.17.03.0. 17.3.4 Activation Success

- UPTODATE
(WLC Capable) See Details I

Process 5: Configuring LAN Segment with LAN Automation

This section of the deployment guide provides detailed steps to automate the LAN segment with LAN Automation, with the
intent to build Fabric GRT reachability across sites. In this guide, we will leverage ISR4331 as seed device and onboard 9300
switch.

WAN Edge device connectivity to LAN and WAN segment over different Service VPN
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Figure 21.  Cisco SD-WAN WAN Edge Interface Service VPN Mapping

vManage

vBond O* vSmart

Shared-Services
SD-WAN Fabric

ISE DNAC DHCP, DNS, AD

RS12-ISR4331-18

__— H
VPN100 - Fabric GRT Service VPN [((BN|CP WAN Edge
i . ASR1001-HX-2
/ WAN Edge ™
ASR1001-HX-1 ‘\‘

WAN Edge % 4——{ VPNO - WAN Transport | — :

Procedure 1. Initiate LAN Automation

This section details the procedure to configure I0S-XE WAN Edge as seed device and discover network devices with the intent to
build fabric site Fabric GRT connectivity.

Step 1. In Cisco DNA Center, navigate to Provision > Network Devices > Inventory

= Cisco DNA Center | Provision » Network Devices - Inventory I Preview New Page a ® @ L

Inventory Plug and Play

Q. Find Hi " @ Global > North America > Region - NY E [T ]
ind Hierarchy

DEVICES (1
~ & Global Focus: Inventory
© Unassigned Devices Filter ® Add Device Tag Device Actions v (D | Take a Tour As of: 2:00 PM Export Refresh
~ & North America
I O Device Name = 1P Address Device Family @ iy  Compli (D  Health Score Site MAC Address Device Role Wk

~ & Region - NY

5 @@ NYC-01 O RS12-ISR4331-18 & 12.12.12.1  Unsupported Cisco Device @ Unreachable

NiA NA .../Region - NY/NYC-01 & CORE
» & Region - RTP

> & Region - SJC

Step 2.  Click the Hierarchy from the left panel, select the WAN Edge devices from the list of devices.

Click Actions > Provision > LAN Automation navigate to appropriate site

© 2021 Cisco and/or its affiliates. All rights reserved. Page 82 of 148



= Cisco DNA Center Provision - Network Devices - Inventory Freview New Page Q @ @ o

Inventory Plug and Play

@ Global > North America > Region - NY E - W
Q. Find Hierarchy
DEVICES (1)
~ { Global Focus: Inventory ~
© Unassigned Devices /Fiter | @ Add Device Tag Device Take a Tour | 1 Selected Asof: 2:00PM (" Export  £7Refresh
~ & North America
a Device Name 1P Address Inventory > [6] o @  HealthScore  Site MAC Address  DeviceRole I 1
|| ~ d Region - NY I
Software Image > A Managed i
> B NYC-01 IEI RS12-ISR4331-18 © 1212121 © unreachable [ T e A NA ../Region - NY/NYC-01 # CORE '

. Provision

R Telemetry >
> & Region - SJC Pravision Device

Device Replacement >
LAN Automation
>

Others
LAN Automation Status

Compliance >

Step 3. Inthe slide-out LAN Automation page:
Select Primary Site
Select the Primary Device
Select the Peer Site (if available)
Select the Peer Device (if available)

Under SELECTED PORTS OF PRIMARY DEVICE, click Modify selections

= Cisco DNA Center Provision - Network Devices - Inventory Preview New Page Qe ¢ o
Inventory Plug and Play .
LAN Automation X
QL Find Hierarchy
DEVICES (1) ‘ @ Cisco recommends that you add the peer with the primary. Why? *
~ & Global rocus: Inventory v
@ Unassigned Devices Fitor | @ AddDevics TogD LAN automation brings up the LAN network automatically starting from seed and peer device. Lan automaton will use the selected ports of the primary device to discover
i i
o evice  Tag DY .nd on-board new devices in the netwaork. The onboarding devices should be in the factory default mode.
~ d North America
O Davice Name + 1P Adg Devices will be auto-upgraded to the Golden Image tagged for the device(s). You can modify the Golden Image selection from [ Image Repository.
I > & Region - NY
(m] RS12-ISR4331-18 @ 105,  Before starting LAN automation, see the f Gisco DNA Center SD-Access LAN Automation Deployment Guide
> & Region - RTP Primary Site*
Ny | Glabal/North America/Region - NY/NYC-01 I v
Primary Device*
RS12-15R4331 | v
Peer Site -

SELECTED PORTS OF PRIMARY DEVICE (0)*

Choose the interface(s) that connect to Fabric GRT switches at the site and click Done.
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= Cisco DNA Center Provision - Network Devices - Inventory Preview New Page Q @ ¢ &L

Inventory Plug and Play LAN Automation %

Q Find Hierarchy

Choose Ports of Primary Device

DEVICES (1)
~ & Global Focus: Inventory v
@ Unassigned Devices 7 Filter © Add Device Tag De ‘You have selected:
~ @ North America (E=0=CItie
O Device Name = 1P Ad
I > & Region - NY T Fiter | P
S T RS O RS12-ISR4331-18 @ 10.5.
> & Region - 8J 8  tame- Mac Address Status

GigabitEthernet0/0/2

GigabitEthernet0/1/0

GigabitEthernet0/1/1

GigabitEthernet0/1/3

(W]
O
[m] GigabitEthernet0/1/2
]
o

GigabitEthernet0/1/4

Showing 10 of 11 Show More

e Show 25 v entries Cancel

= Cisco DNA Center Provision « Network Devices - Inventory Preview New Page Qa @ o &

Inventory Plug and Play LAN Automation X

Q Find Hierarchy

Primary Device®

) RS12-ISR4331-18 ~
~ 4 Global Focus: Inventory v
© Unassigned Devices Y Fiter @ Add Device  Tag De .

Peer Site v

v & North America

O Device Name = 1P Ad

I » & Region - NY

0 RS12-ISR4331-18 @ 105  PeerDevice -

> & Region - RTP

> ¢ Region - SJ
SELECTED PORTS OF PRIMARY DEVICE (1)*  Modify Selections

Gigabi... emet0/0f2 x

Clear All

Under Discovered Device Configuration section,
Input Discovered Device Site:

Input Main IP Pool:

Under Hostname Mapping,

Input Device Hostname Prefix:

And click Start
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= Cisco DNA Center Provision - Network Devices - Inventory

Preview New Page

Inventory Plug and Play LAN Automation

Q Find Hierarchy Discovered Device Configuration

DE‘JIC[S;H Discovered Device Site*

I d ™

~ & Global Focus: Inventory | Global/North America/Region - NY/NYC-01 d
@ Unassigned Devices " Filter @ Add Device  Tag Devi

Main 1P Pool*

~ ¢ North America 0 Device Name = 1P Addrel NY_LAN_AUTOMATION_PREFIX | v @

> i Region - NY

. a RS12-ISR4331-18 @  10.5.2d
> & Region - RTP Link Overlapping IP Pool

> b Region - SJC
1S-1S Domain Password [0}
Enable Multicast @

Hostname Mapping
Device Hostname Prefix

NY-9300 0]

Choose a File

Choose File | No file chosen O .l Download Sample File

° Show 25 ~ entries Clear

Step 4. Click Accept on the information pop-up page

= Cisco DNA Center Provision - Network Devices - Inventory Preview New Page

®

Information

Complete these prerequisites before starting LAN automation:
1. Devices will be upgraded automatically to the golden image selected for the site(s)
You can change the golden image selection in the Image Repository.
2. All seed and discovered devices must have a Cisco DNA Advantage license. To

check the installed license, use the show version command in EXEC mode.

Do you want to continue?

Cancel

Step 5. View the LAN Automation status, navigate to Provision > Network Devices > Inventory.

Select Actions > Provision > LAN Automation Status

© 2021 Cisco and/or its affiliates. All rights reserved.

Cancel

a ® @ o
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= Cisco DNA Center

Inventory Plug and Play

Q. Find Hierarchy

Provision - Network Devices - Inventory

Preview New Page

Q Global > North America > Region - NY

Asof: 2:00 PM (

MAC Address

.../Region - NY/NYC-01

Preview New Page Q @

DEWICES (1)
~ { Global Focus: Inventory ~
© Unassigned Devices " Fiter | @ Add Device Tag Device Take a Tour | 1 Selecte
~ & North America
a Device Name 1P Address Inventory > [6] @  HealthScore  Site
|| ~ d Region - NY ‘
Sof Imag M d
> @ NYC-01 IEI RS12-ISR4331-18 © 1212121 oftware Imags * @ Unreachable :m:":imw ra A NA
. Provision
_ Telemetry >
> & Region - SJC Provision Device
Device Replacement >
LAN Automaticn
Others
Compliance >
= Cisco DNA Center Provision - Network Devices - Inventory
Inventol Plug and Pla: :
" N Y LAN Automation Status
Q) Find Hierarchy
DEVICES (1)
~ & Global Focus: Inventory v Summary Devices Logs
© Unassigned Devices Y Fiter | @ Add Device Tag Devid
~ &% North America Discovered Site NYC-01
(] Device Name ~ 1P Addrd
> & Region - NY Primary Device RS12-ISR4331-18
> & Reglon - RTP O RS12-1SR4331-18 @ 10.52( PeerDevice None
Primary Device Interfaces GigabitEthernet0/0/2

> & Region - SJC

Show 25 v entries

IP Pool

Link Overlapping IP Pool
Multicast

Device Prefix

Hostname File

Status

Discovered Devices

) Completed : 0 (9 In Progress : 0 ) Error: 0

View the LAN automation Status logs, by selecting the Logs tab.

© 2021 Cisco and/or its affiliates. All rights reserved.

NY_LAN_AUTOMATION_PREFIX
None
Disabled

NY-9300

None

Last updated Sep 14, 2021 6:31 AM

a o @ 4

-

7 Export <7 Refresh

Device Role [T ]

& CORE '
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= Cisco DNA Center

Inventory Plug and Play

), Find Hierarchy

~ & Global
© Unassigned Devices
v & North America
I & Region - NY
> @@ NYC-01
> & Region - RTP

> & Region - SJIC

DEV m
rocus: Inventory v

" Filter @ Add Device
O Device Name ~
O RS12-ISR4331-18 ©

Tag De

1P Ad

10.4,

Provision - Network Devices - Inventory

LAN Automation Status |

Summary  Devices

Q  Search Table
Message

Starting Seed Device Configuration phase.

Reserved IP Address 10.4.227.65 for interface Loopback( on device =
PrimarySeedDevice.

—comm— oy

Reserved Subnet 10.4.227.0/26 for interface BDI1 on device ®.08 -

Started the Network Orchestration Session with primary device: RS12-1SR4331-18.

Starting LAN Automation by user: admin.

View the network devices discovered, by selecting the Devices tab

= Cisco DNA Center

Inventory Plug and Play

Q Find Hierarchy

~ ¢ Global
O Unassigned Devices
~ & North America
I « & Region - NY
> B8 NYC-01
> & Region - RTP

> & Region - SJC

Step 6.

Focus: Inventory

“ Filter @ Add Device
O Device Name =
0 RS12-ISR4331-18 ©

Tag De

1P Ads

10.4.

Provision - Network Devices - Inventory

LAN Automation Status

Summary Logs

If the new devices aren't listed here, check the Plug and Play page for missing devices @)

Q  Search Table

Device Name =~ IP Address Serial Number

NY-9300-4 10.4.227.68

In the LAN Automation Status > Summary tab slide-out, click Stop

© 2021 Cisco and/or its affiliates. All rights reserved.

Preview New Page

Last updated Sep 24, 2021 2:11 PM

Timestamp ~

Sep 25, 2021 02:08 PM

Sep 25, 2021 02:08 PM

Sep 25, 2021 02:08 PM

Sep 25, 2021 02:08 PM

Sep 25, 2021 02:08 PM

Preview New Page

Last updated Sep 24, 2021 2:22 PM

Status (1)

a @ @ o

 Refresh

a @ @ o

 Refresh

Completed

Upon network devices being discovered, stop the LAN Automation to complete the onboarding process.
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Cisco DNA Center

Inventory Plug and Play

Q Find Hierarchy

~ & Global Focus: Inventory v
© Unassigned Devices  Filer @ Add Device
~ & North America
O Device Name =
I « & Region - NY
RS12-ISR4331-18 @
> [ NYC-01 o -

> & Region - RTP

> & Region - SJC

° Show 25 v entries

Cisco DNA Center

Inventory Plug and Play

Q Find Hierarchy
.

: Inventory

~ & Global FOCU!
© Unassigned Devices  Filter @ Add Device
~ & North America
O Device Name =
I ~ & Region - NY
RS12-ISR4331-18 @
> @ NYC-01 o )

> & Region - RTP

> & Region - SJC

© 2021 Cisco and/or its affiliates. All rights reserved.

Tag De

1P Ad

10.4.

Tag De

1P Ad

10.4.]

Provision - Network Devices - Inventory

LAN Automation Status

Summary Devices Logs
Discovered Site
Primary Device
Peer Device
Primary Device Interfaces
IP Pool
Link Overlapping IP Pool
Multicast
Device Prefix

Hostname File

Status

Discovered Devices

) Completed : 1 © In Progress : 0 @ Error : 0

Provision - Network Devices - Inventory

LAN Automation Status

Summary Devices Logs
Discovered Site

Primary Device

Peer Device

Primary Device Interfaces

IP Pool

Link Overlapping IP Pool

Multicast

Device Prefix

Hostname File

Status

Discovered Devices

) Completed : 1 @ In Progress : 0 @ Error : 0

Preview New Page Q ® @ 4L
x
CaSCUpUA SU 2, 2UZT S W RETTEsT
NYC-01
RS12-ISR4331-18
None
GigabitEthernet0/0/2
NY_LAN_AUTOMATION_PREFIX
None
Disabled
NY-9300
None
Cancel
Preview New Page Q @ @ L
X
CHSCUPUSIBSU] 24, 202 T 225 P REITES T

NYC-01

RS12-1SR4331-18

None

GigabitEthernet0/0/2
NY_LAN_AUTOMATION_PREFIX
None

Disabled

NY-9300

Naone
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Cisco DNA Center

Provision « Network Devices -« Inventory

Preview New Page

Lest updated Sep 24, 2021 2:31 PM

Inventor Plug and Pla .
" . / LAN Automation Status
Q, Find Hierarchy
DEVICES (1)
~ 4 Global Focus: Inventory v Summary Devices Logs
© Unassigned Devices Filter @ Add Device  Tag De
~ & North America Discovered Site NYC-01
O Device Name « 1P Ad
I ~ & Region - NY Primary Device RS12-ISR4331-18
T O RS12-ISR4331-18 @ 104  poorpevice Nene
5 & Region - RTP Primary Device Interfaces GigabitEthernet0/0/2
IP Pool NY_LAN_AUTOMATION_PREFIX
> & Region - SJC
Link Overlapping IP Pool None
Multicast Disabled
Device Prefix NY-8300
Hostname File None
Discovered Devices !
) Completed : 1 In Progress : 0 & Error: 0

Step 7.

View the discovered network devices in the DNA Center Inventory.

Navigate to Cisco DNA Center, Provision > Network Devices > Inventory.

select the site from the Hierarchy and verify the devices is Reachable and Managed state.

Cisco DNA Center

| Provision - Network Devices - Inventory |

Inventary Plug and Play

Q) Find Hierarchy

@ Global > North America > Region - NY

DEVICES (2)
~ 4 Global Focus: Inventory
© Unassigned Devices Fiter | @ Add Device TagDevice Actions v ® | Takea Tour
~ & North America
0 IP Address Device Family ity (D) (©  Health Score
I ~ d Region - NY |
Switches and Hubs
= -9300-4 Reachable Managed Compliant
> @ NYC-01 NY-9300-4 & 10422768 ) 0 o) o L] g © Compiian 10
» & Region - RTP
¢ RS12-ISR4331-18 @  10.4.227.65 Routers @ Reachable @ Managed © compliant 10

> & Region - SJC

Tech Tip

Image Management for the discovered devices can be completed as a part of LAN Automation.

DNA Center Image Repository and be tagged with Golden for the device family for the site.

Cisco DNA Center

Q_ Find Hierarchy f Update Devices | == Show Tasks

~ & Global
i %] h "
« & North America V" Filter i Refres| Last updated: 7:44 AM
> db Region - NY Family Image Name

I > & Region - RTP

» &b Region - SJC > Cisco Catalyst 9407R Swit...

cat9k_iosxe.17.03.04.SPA.bin
"/ Unable to verify

| Design - Image Repository I

Device(s) Version

17.03.04
1 (Suggested, Latest)
Add On (2)

Process 6: Provision Cisco SD-Access Fabric Site(s).

Preview New Page

-.fRegion - NY/NYC-01

../Region - NY/NYC-01

Cisco.com ID

Golden Image

L]

Q@ @ &

2 Refresh

a e ®@ o

= K

Asof: 2:32 PM i Export £ Refresh

MAC Address Davice Rale i

ac:f5:e6:5c:9a:80 & ACCESS 1

00:3a:7d:81:¢5:b0 ¢ BORDER ROUTER 1

This requires image to be available in Cisco

Q@ @ 4

pdavanag (Not me?)

Device Role Action

TR

This section details the procedure to provision the network devices to a site, creating fabric site(s) and assigning fabric role to

the devices.
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I
Procedure 1. Provision the network devices to a site

This section details the steps needed to provision the network devices to a site with the intent to configure network parameters
such as AAA, DNS, NTP etc. defined in the Cisco DNA Center network setting.

Step 1. In Cisco DNA Center, navigate to Provision > Network Devices > Inventory.
Select the site from Hierarchy and network devices from the Devices list
Click Actions > Provision > Provision Device
Tech tip

Similar network devices such as switches, routers can be grouped together and provisioned to a site together.

= Cisco DNA Center Provision - Network Devices - Inventory Praview New Page Q @ @ O

Inventory Plug and Play

QF @ Global > North America > Region - RTP E - W
ind Hierarchy

DEVICES (9)

v &b Global Focus: Inventory v

© Unassigned Devices Filter | @ Add Device Tag Device | Take a Tour 3 Selected Asof: 7:27 AM (T Export 7 Refresh

~ i North America

] Device Name = IPAde  Inventory > @ ® c @ Health Score  Site MAC Ac  §
« ¢ Region - NY
B (] A-3850mc © 10.4, Software Image > @ Reachable © Managed © Compliant 8 .../Region - RTP/RTP-06  00:57:d2:48:¢
> B NYC-01
=
> dfb Region - RTP (] A-9300b @ 10.4 Assign Device to Site @ Compliant 10 ...[Region - RTP/RTP-06  b4:a8:b9:c0:
P Telemetry >
> & Region - SJC | Provision Device
= A-9407a © 104, peyice Replacement 3 @ Compliant 10 .../Region - RTP/RTP-06  2c:5a:0f:1c:f:
AN Automation
Others >
0O A-9500-1 @ 10.4. LAN Automation Status @ compliant 10 .../Region - RTP/RTP-06  00:a3:d1:44:
Compliance >
- -2 @ 4. Complia 1 - - :ad:d1:44:
O A-9500-2 © 10. (WLU Capable) @ compliant o] /Region - RTP/RTP-06  00:a3:d1:44.
O A-ASR1001%-1 @ 10.4.200.1  Routers @ compliant 10 .../Region - RTP/RTP-06  a0:3d:6f:d3:c
O A-ASR1001X-2 @ 10.4.200.2 Routers @ compliant 10 .../Region - RTP/RTP-06 00:a6:ca:el:l
(] A-N7706-1.sda-lab.local @ 10.4.200.11 Switches and Hubs @ Reachable @ Managed @ Non-Compliant 10 .../Region - RTP/RTP-06  8c:60:4f:ab:€

o Show 25 ~ entries Showing 9 of 9

Step 2.  Choose the site for each device in the list (the site auto) and select Next.

= Cisco DNA Center Provision - Network Devices - Inventory Preview New Page Q e ¢ L
Invento: Plug and Pla N .
i q v Assign Device to Site X
Q Find Hierarchy Soril umber Devicas
DEVICES (3) FCW1949C1TX A-3850me ’ il Global/North America/Region - RTP... x l
~ s Global Focus: Inventory v
e i i ®
® Unasslgned Dovices (3) Fiter | @ Add Device TagDevice Actions v @ | Take a Tour [ Apply o Al O
> db North America
D N - 1P Adk ice Famil
L evice Name dress - Device Family Reachabily e Lo - | & Global/North America/Region - RTP... I
] A-3850mc () 10.4.200.58 Switches and Hubs @ Reachable
Switches and Hubs - A &% Global/North America/Region - RTP...
= @ 4. 1 Ri habl FXS2131Q3YF A-9407a | J x
] A-9300b © 10420056 o SO0 © Reachable
Switches and Hubs
A-9407a @ .4.200.57 Reachable
] 9407a © 10.4.200.5 (WL Capable) L]
o Device Controllability is Enabled. Learn More | Disable Cancel
Cho 25
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Click Next

= Cisco DNA Center Provision - Network Devices - Inventory - Provision Devices

Inventory > Provision Devices

@ Assign Site o Advanced Configuration @ Summary

Devices

Select devices to fill out provisioning parameters

Find

=Q Device

Show
All ~

~ Devices having No Templates

N

No Devices Selected
Select a device or template from " Devices™ panel. Shift +

click to select multiple devices under a template, or single
click to select one at a time.

Cancel

View the parameters that gets provisioned on the device and select Deploy

= Cisco DNA Center

Inventory > Provision Devices

@ Assign Site @ Advanced Configuration o Summary

Provision - Network Devices - Inventory - Pravision Devices

I A-3850mc
v Device Details
A-9300b
Device Name: A-3850mc
A-9407a Platform Id: WS-C3850-24XU-E
Device IP 10.4.200.58

Device Location:

v Network Settings

© 2021 Cisco and/or its affiliates. All rights reserved.

Global/North America/Region - RTP/RTP-06

NTP Server: 10.4.245.102
AAA Network ISE Server 10.4.250.225
AAA Network Primary Server: 10.4.250.225
AAA Network Secondary Server: 10.4.250.226
AAA Client ISE Server 10.4.250.225
AAA Client Primary Server: 10.4.250.225
AAA Client Secondary Server: 10.4.250.226

a @ @ &

a @ @ o

WARNING: Do not use " admin® as the username for your device GLI credentials, if you are using ISE as your AAA server. If you do, this can result in you not

being able 1o login ta your devices.

DHCP Server: 10.4.249.102
DNS Domain Name: sda-lab.local
DNS Primary Server: 10.4.248.102
Syslog Server Cisco DNA Center
Netflow Collector (Not canfigured)

Cancel
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Under Provision Device slide-out page, select Now option and Deploy

= Cisco DNA Center

Inventory > Provision Devices

@ Assign Site @ Advanced Configuration o Summary

NTP Server:

AAA Network ISE Server

AAA Network Primary Server:
AAA Network Secondary Server:
AAA Client ISE Server

AAA Client Primary Server:

AAA Client Secondary Server:

DHCP Server:

DNS Domain Name:

Provision « Network Devices - Inventory - Provision Devices

10.4.249.102
10.4.250.225
10.4.250.225
10.4.250.226
10.4.250.225
10.4.250.225
10.4.250.226

WARNING: Do not use " admin® as the username for your device CLI o

being able to login to your devices
10.4.249.102

sda-lab.local

Step 3.  View the status of the Provision task by navigating to

Cisco DNA Center > Activities > Tasks

= Cisco DNA Center

Audit Logs Tasks Work Items

FILTERS: TYPE All ~s  STATUS - Upcoming I In Progress Success [ Failed ]

o PROVISION

Starts: Sep 15, 2021 9:21 AM Status: ° Success

o PROVISION

Starts:  Sep 15, 2021 9:21 AM Status: ° Success

o PROVISION

Starts:  Sep 15, 2021 9:21 AM Status: @ Success

a o @ 5

Provision Device x

O Later

(O Generate configuration preview
Creates preview which can be later used to deploy on selected devices. If Site
assignment is invoked during configuration preview, Device controllability
configuration will be pushed to corresponding device(s)

Task Name*
Provision Device

Cancel

Qa o @ o

Last updated: 9:30:58 AM £ Refresh

Step4. Repeat the steps in this Procedure to provision other network devices to a site, including the I0S-XE SD-WAN WAN

Edge devices .

© 2021 Cisco and/or its affiliates. All rights reserved.
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= Cisco DNA Center

Audit Logs Tasks

FILTERS:  TYPE All

o PROVISION

Provision Device

Hostname: A-ASR1001X-2

Starts: Sep 15, 2021 9:35 AM

o PROVISION

Provision Device

Hostname: A-ASR1001X-1

Starts: Sep 15, 2021 9:35 AM

o PROVISION

Provision Device
Hostname: A-9407a

Starts: Sep 15, 2021 9:21 AM

o PROVISION

Provision Device
Hostname: A-9300b

Starts: Sep 15, 2021 9:21 AM

o PROVISION

Provision Device
Hostname: A-3850mc

Starts: Sep 15, 2021 9:21 AM

Procedure 2.

Work Items

Status: @ Success

Status: @ Success

Status: (@ Success

Status: @ Success

Status: @ Success

Activities - Tasks

~  STATUS “ Upcoming | In Progress l Success J Failed

(Optional) Provision IP-Transit Network

Shawing 12 of 12

a @ @ &
Last updated: 9:36:51 AM Refresh

This section details the steps needed to create an IP-Transit network. This is needed only when the WAN Edge devices part of

site has connectivity to shared services network through the IP network.

Skip this Procedure at remote sites, that requires connectivity to SD-WAN Transit only.

Step 1.
Cisco DNA Center

Design

Step 2.

Inventory

Plug and Play

Create IP-Transit

In Cisco DNA Center, navigate to Provision > Fabric

View Details

Take aTour  [] Explore
pnnel X
Critical Issues Trends and Insights
Last 24 Hours Last 30 Days
P1 P2 Throughput Coverage Capacity

View Details

Click Add Fabric or Transit/Peer Network and Select Transit/Peer Network from the drop-down option

© 2021 Cisco and/or its affiliates. All rights reserved.
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= Cisco DNA Center Provision - Fabric a ® @ o0

SD-Access Fabrics and Transit/Peer Networks

Choase a Fabric or Transit/Peer Network below to manage, or add a new item by clicking "Add Fabric or Transit/Peer Network!

| @ Add Fabric or Transit/Peer Network

Fabric

Fabrics @

| Transit/Peer Network |

Default LAN Fabric

0 Site , 0 Fabric Device
0 Cantrol Plane , 0 Barder

Transit/Peer Networks @

SDWAN 10.4.246.11

Tech Tip

Transit: SDWAN is created on successful integration between Cisco DNA Center and SD-WAN vManage controller.

Under, Transit/Peer Network slide out page:
Input Transit/Peer Network Name
Select Transit/Peer Network Type: IP-Based
Select Routing Protocol: BGP

Input Autonomous System Number (ASN): peer network BGP AS number

Click Save
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= Cisco DNA Center Provision - Fabric a ® @ oL

. . Transit/Peer Netwark X
SD-Access Fabrics and Transit/Peer Networks
Choase a Fabric ar Transit/Peer Network below to manage, or add a new item by clicking *Add Fabric or Transit/Peer Netwark. o el ooty bt Fab Sk, olect Transt Gl Pane and conneciy e

Transit/Peer Network Name
I\F-TRANSIT

Fabrics @ Transit/Peer Network Type
) SD-Access

© IP-Based

Routing Protocol

Default LAN Fabric "

Transit/Peer Networks @

SDWAN 10.4.246.11

Cancel

= Cisco DNA Center Provision - Fabric Q ® ® O

SD-Access Fabrics and Transit/Peer Networks

Choose a Fabric or Transit/Peer Network below to manage, or add a .

tem by clicking 'Add Fabric or Trans r Network

@ Add Fabric or Transit/Peer Network

Fabrics ®

Default LAN Fabric

Transit/Peer Networks @

IP-TRANSIT SDWAN 10.4.246.11

[mer]l]  [eseee]

Procedure 3. Provision Fabric — Create Fabric Site

This section details the steps needed to create a Fabric site. The SD-Access fabric site is provisioned with I0S-XE WAN Edge
device as colocated Fabric Border, Control Plane roles and connected SD-WAN Transit and IP-Transit. The access switches are
associated with Fabric Edge role.
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Step 1. In Cisco DNA Center, navigate to Provision > Fabric

Create SD-Access fabric site, click Add Fabric or Transit/Peer Network

Select Fabric from the options

= Cisco DNA Center Provision - Fabric Q ® @ o

SD-Access Fabrics and Transit/Peer Networks

Choose a Fabric or Transit/Peer Network below to manage, or add a new item by clicking 'Add Fabric or Transit/Peer Network

| ° Add Fabric or Transit/Peer Network

Fabrics ©® | Fabric |

Transit/Peer Network

Default LAN Fabric

Transit/Peer Networks ®

IP-TRANSIT SDWAN 10.4.246.11

Step 2.  Input Fabric Name and location by selecting the site from the hierarchy.

And click Next

= Cisco DNA Center Pravision - Fabric a @ @ o

SD-Access Fabrics and Transit/Peer Networks Add Fabric Site h

Choase a Fabric or Transit/Peer Network below ta manage, or add a new item by clicking "Add Fabric or Transit/Peer Network!

MName the Fabric and choose a site for common policy enforcement. Al sites under the chosen site
will be added to the Fabric.
Fabrics @

Fabric Name
Fabric-RTP

Default LAN Fabric (Q Find Hierarchy

~ & Global (1)

~ & North America (3)

> & Reglon - NY (1)

I > & Region - RTP (1)

> & Region - SJC (1)
Transit/Peer Networks @

IP-TRANSIT SDWAN 10.4.246.11
Transit: IP Transit: SOWAN

Cancel

Step 3.  Select all the Virtual Network from the list that needs to be provisioned at the site.
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Click Add

= Cisco DNA Center Provision - Fabric Q & @ o

SD-Access Fabrics and Transit/Peer Networks Add Fabric Site -

Choose a Fabric or Transit/Peer Network below to manage, or add @ new item by clicking 'Add Fabric or Transit/Peer Network

Selected virtual netwark(s) will be used in the Fabric Site

. INFRA_VN X VN_CAMPUS X VN_GUEST X VN_IOT X
Fabrics @

4 Selected 2Q Find

-] Virtual Network =

Default LAN Fabric
0 DEFAULT_VN

INFRA_VN
o Coms e

VN_CAMPUS
VN_GUEST

Transit/Peer Networks @ e

Showing § of 5
IP-TRANSIT SDWAN 10.4.246.11
Transit: IP Transit: SDWAN
Step 4. Click on the fabric site ‘ Fabric-RTP ’ card and select the site from the list
= Cisco DNA Center Provision - Fabric Q@& @ o

SD-Access Fabrics and Transit/Peer Networks

Choose a Fabric or Transit/Peer Network below to manage, ar add a new item by clicking 'Add Fabric or Transit/Pear Network!

@) Add Fabric or Transit/Peer Network

Fabrics ©

Default LAN Fabric Fabric-RTP

0 Site , 0 Fabric Device 1 Site , 0 Fabric Device
0 Control Plane , 0 Border a Contral Plane , 0 Barde;

Transit/Peer Networks @

IP-TRANSIT SDWAN 10.4.246.11

Transit: IP Transit: SDWAN
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= Cisco DNA Center

All Fabrics > Fabric-RTP
Fabric Sites o

Fabric-RTP
£q  Find Hierarchy
v @ Fabric-RTP
Device

Fabric Site =

IP Address

~ Mregion - RTP ™

o Global/North America/Region - RTP -

Showing 1 - 10f 1

= Cisco DNA Center

) All Fabrics > Region - RTP

Fabric Sites Fabric-RTP

= Find Hierarchy Fabric Infrastructure

Host Onboarding

Fabric Role Connected Transit/Peer Network

Qe @ 0
=Q, Find

B
Qe @ 0

- =n

Show Task Status

v @ Fabric-RTP

~ §PRegion

RTP

Step 5.

@ Three (3) Information Alerts on this page. Expand to see detail. X
Callapse All Custom View Sep 15, 2021 11:39 AM
>
b
A—I A*;L:DJ
v v @
=Y
’
A-3850moade-lsb  A-0407aade-leb  A-9300bsde-lab @
Assign 10S-XE WAN Edge devices with Control Plane role.
Under Fabric Infrastructure, click the WAN Edge device and enable Control Plane functionality
Page 98 of 148

© 2021 Cisco and/or its affiliates. All rights reserved.



= Cisco DNA Center Q @ @ o

e All Fabrics > Region - RTP
Fabric Sites ) %
Fabric-RTP
A-ASR1001X-1/(10.4.200.1)
zq_ Find Hierarchy Fabric Infrastructure  Hy @ G peachable  Uptime: 2 days 19 hrs 44 mins
v & Fabric-rTP (D) Three (3) Information Alerts on _
3 Run Commands View 360 Last updated: 12:45 PM (¥ Refresh
Details Fabric Port Channel Advisories Configuration Power Fans User Defined Fields Interfaces More
~ ¢®Region - RTP & R
Fabric
G) Edge
@ Border
Cancel Add
Step 6.  Assign I0S-XE WAN Edge devices with Border functionality
Enable the Border role to the device
= Cisco DNA Center a @ @ &
All Fabrice > Region - RTP
Fabric Sites (] - ®
Fabric-RTP
A-ASR1001X-1(10.4.200.1)
=q_ Find Hierarchy Fabric Infrastructure 4" @ @ Reachable Uptime: 2 days 19 hrs 44 mins
v @ Fabric-RTP @ Three (3) Information Alerts on -
&3 Run Commands View 350 | Last updated: 12:45PM [ Refresh
Details  Fabric  Port Channel  Advisories  Configuration  Power  Fans  User Defined Fields  Interfaces  More «
I ~ region - RTP & —

Fabric

®

o o :]
@ cwomee @)

Transit: SDWAN is auto assigned to the IOS-XE WAN Edge device when selected as Border.
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= Cisco DNA Center Qa @ @ o

o All Fabrics > Region - RTP
fabric Sites Fabric-RTP A-ASR1001X-1 <
e N . Fabric Infrastructure
Q. Find Hierarchy Layer 3 Handoff Layer 2 Handoff
v @ Fabric-rTP @ Three (3) Information Al Enable Layer-3 Handoff
Local Autonomous Number
. 5000 —~
I ~ region - RTP & 0]
Default to all virtual networks (i)
18 Do not import external routes ()
@ Add Transit/Peer Site
~ SDWAN 10.4.246.11
10.4.246.11 - SDWAN Transit
This ste provides infernet access o oiher sites through SDA Transit. (1)
Tech tip

By default, Cisco SD-Access workflow chooses External Border as the Border type. For fabric sites that has connectivity to SDWAN Transit,
leverage the default border type on the WAN Edge device.

WAN Edge learns routes to the rest of the network through SD-WAN infrastructure and for fabric site the WAN Edge device is the gateway
of last resort implemented using LISP Proxy Tunnel Router (PxTR) functionality on fabric edge nodes.

Layer 3 Handoff Layer 2 Handoff

Enable Layer-3 Handoff

Local Autonomous Number
5000

—
-

Default to all virtual networks @

Do not import external routes Gj“

Step 7.  For sites that requires IP-Transit to be associated to site.

Click Layer 3 Handoff > Add Transit/Peer Site and select previously created IP-Transit network.

= Cisco DNA Center Q @ @ L
e | All Fabrics » Region - RTP
Fabric Sites Fabric-RTP A-ASR1001X-1 )
o R Fabric Infrastructure
=Q_ Find Hierarchy Layer 3 Handoff Layer 2 Handoff
v @ Fapric-RTP () Three (3) Information Al Enable Layer-3 Handoff
Lecal Autonomous Number
5000 ~
I ~ Mregion - RTP & w

Default to all virtual networks (7)

18 Do not impert external routes ()

e Add Transit/Peer Site

IP:IP-TRANSIT

10.4.246.11 - SDWAN Transit

his site provides internet access to other sites through SDA Transit

0]

Under the selected IP-Transit, select the ports that connected to the peer device by clicking the Add External Interface
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= Cisco DNA Center

) . . All Fabrics > Region - RTP
Fabric Sites Fabric-RTP A-ASR1001X-1

o ) Fabric Infrastructure

@ Find Hierarchy Layer 3 Handoff Layer 2 Handoff

v & Fabric-RTP @ Three (3) Information Al Enable Layer-3 Handoff

. | Local Autonomous Number
. 5000
~ ®Region - RTP o

0]

Default to all virtual networks (7)

B Do not import external routes (1)
@ ~0d Transiv/Peer site

v SDWAN 10.4.246.11

10.4.246.11 - SDWAN Transit

~ IP-TRANSIT

Select IP Pool

[] This site provides internet access to other sites through SDA Transit. ()

Select interface in the External Interface drop-down option

Select all the Virtual Networks that require IP-Transit handoff and assign a vlan number.

And click Save

Cisco DNA Center

[ ) All Fabrics > Region - RTP
oo sies Fabric-RTP A-ASR1001X-1
N < Back
=q Find Hierarchy Fabric Infrastructure o
v & Fabric-RTP (7) Theee (3) informarion A _Extemalinerfaco
I ~ @ region - RTP & =
Remote AS Number 3 m
Actions

Virtual Network =

INFRA_VN

VN_CAMPUS

VN_GUEST

VN_IOT

Under Select IP Pool, select the Border Handoff Pool

And click Add
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Enable Layer-3 Handoff

penns

Shawing 4 of 4

VLAN (D

301

3012

3013

3014

Qe @ o
X
Qa @ @ o
X
=Q Find

Cancel
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Cisco DNA Center

~ {#®Region - RTP o

Remove From Fabric

Fabric

. Barder Gonfiaure Desits
@ Control Piane

Capability

® Rendezvous Point

Step 9. Click Deploy
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Q @ @ O

- o | & Favrics > Region - AT
Fabric Sites Fabric-RTP A-ASR1001X-1 =
2q Find Hierarchy Fabric Infrastructure Layer 3 Handolf Layer 2 Handoff
~ & Fabric-RTP Three (3) Information A
External Interface () © ~w
I ~ MRegion - RTP o
=Q Fina
Intarface Number of VN(s)
GigabitEthernet0/0/2 4 5]
Showing 1 of 1
[ This site provides intamet access to other sites thiough SDA Transit, (T)
Select IP Pool
RTP_BORDER_L3Handoff (10.4.218... + |
@
Step 8. Click Add to add Border and Control Plane role to the device
= Cisco DNA Center Q @ @ 5
e | ai abrice > Region - RTP
Fabric Sites ) %
Fabric-RTP
A-ASR1001X-1 (10.4.200.1)
=Q  Find Hierarchy Fabric Infrastructure i @ Reachable Uptime: 3 days 1 hr 10 mins
v & ravric-rTP (i) Three (3) Information Alerts on )
“% Run Commands 7 View 360 Last updated: 5:11 PM () Refresh
Details Fabric Port Channel Advisories Configuration Power Fans User Defined Fields Interfaces More

&)
&)

Disabled

Cancel
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= Cisco DNA Center

e All Fabrics > Region - RTP

Fabric Sites Eabric-RTP

= Find Hierarchy

Host Onboarding

Qa o @ o

8 -

Show Task Status

v @ Fabric-RTP

~ §®Region - RTP o

= Cisco DNA Center

Fabric Infrastructure
@ Three (3) Information Alerts on this page. Expand to see detail. X ‘
Th‘:"ﬂ Collapse All Custom View Sep 15, 2021 12:45 PM
A-ASR1001X-2 A-ASRT001X-1
-
A-N7706-2.5da-lab A'N??D‘E'I.Is:la—lab
@
Q
&
oty ®
In the Modify Fabric slide out page, select Schedule Operation: Now and click Apply
a ® ® o
x

- Y | Al Fabrics > Region - RTP
Fabric Sites Fabric-RTP

=q_ Find Hierarchy Fabric Infrastructure

Modify Fabric

1 Device(s)

Host Onboarding
A This operation impacts all devices in the Fabric site.

7 @ Fabric-RTP

@ Three (3) Information Alerts on this page. Expand to see detail

Schedule Operation:

I ~ PRegion - RTP o

The Intemet

O Later

O Generate configuration preview

Task Name*
Modifying Fabric at Region - RTP

A-ASR1001X-2

-

<

A-N7706-2.5da-lab A-N7706-1
local loe:

-

-
A-3500-1 A-350

Step 10. View the status of the provision task by clicking the Show Task Status
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= Cisco DNA Center

Qe ® o
All Fabrics > Region - RTP _
Fobie Sies ® | fvicrr :a ey - |
zq Find Hierarchy Fabric Infrastructure  Host Onboarding

Show Task Status

v @ Fabric-RTP @ Three (3) Information Alerts on this page. Expand to see detal

- ‘
Collapse All Custom View Sep 15, 2021 6:15 PM
I ~ ®region - RTP ™
The Internet
= Cisco DNA Center Qa @ @ o
| aiFavrics > Region - TP
Fabric Sites (1) Fabric-RTP o Task Monitor X
= Find Hierarchy Fabric Infrastructure
Last Updated Sep 14, 2021 6:31 PM L Refresh
v @ Fabric-RTP () Three (3) Information Al W Filter
I ~ @ region - RTP @ Maodifying Fabric at Region - RTP DEPLOYED
+ Task Id: 56f87cc9-05b2-4aB0-9324-c2811cfB2564
+ Start Time: Sep 15, 2021 06:29 PM
- End Time: Ssp 15, 2021 05:30 PM
Device Detalls Prosision Details
Maodifying Fabric at Region - RTP pepLovED
+ Task Id: 16eb6297-7dal-48fa-b6al-dfbe84878aic
« Start Time: Sep 15, 2021 06:15 PM
+ End Time: Sep 15, 2021 0515 PM
Device Details Provision Details
Step 11. Repeat step 5 through step 10 to add any additional I0S-XE WAN Edge device at the site with Fabric Border and
Control Plane functionality.
= Cisco DNA Center Q @ ® o
Al Fabrics > Region - RTP =
Fabric Sites () Fabric-RTP =q N n
zq Find Hierarchy Fabric Infrastructure Host Onboarding Show Task Status
v @ Fabric-RTP (D) Tree (3) Information Alerts on this page. Expand to see detail. X ‘
Coflapse All Custom View Sep 15, 2021 6:15 PM
~ ®Rregion - RTP 5
A-ASRI001X-2 A-ASR1001X-1
Tech tip

Cisco DNA Center automates the fabric border configuration with IP-based Layer 3 handoff. The IP Transit workflow provisions the fabric
border with sub-interfaces for each VN extending the overlay segmentation to the peer-device, external-BGP neighborship is established
to advertise prefixes from the fabric site and receive shared-services subnets from the peer-device. The peer-device, also commonly
known as fusion device, takes cares of route-leaking between the extended overlay fabric site subnets and the global routing table

containing the shared-service subnets. Please refer to Software-Defined Access Medium and Larger Site Fabric Provisioning guide on
procedure to configure the peer-device.
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It is also important to connect the two fabric site border nodes and configure internal-BGP session for each VN. This is needed for any
Transit being deployed, either IP-Transit or SD-WAN transit, on the fabric Border Node. This would ensure the SD-Access LAN segment
traffic is forwarded to other border in the case of uplink failures to both the WAN transport or to the peer device.

Step 12. Assign fabric Edge role to network devices

Click on the network device in the Fabric Infrastructure tab and select Edge role

Click Add
= Cisco DNA Center a e @ o
All Fabrics > Region - RTP
Fabric Sites (] Fabric-RTP X
A-9300b.sda—|ab.\ocall(1 0.4.200.56)
=Q Find Hierarchy Fabric Infrastructure = =l @ Reachable Uptime: 1 day 9 hrs 53 mins
v & Fabric-rTP (i) Three (3) information Alerts on -
% Run Commands View 360 Last updated: 6:36 PM [~ Refresh
Details  Fabric  Port Channel  Advisories  Configuration ~ VLANs  Power  Fans  User Defined Fields  Interfaces  More

~ ®Region - RTP o

Fabric

@ o @
Barder
@ Control Plane

Capability

@ Embedded Wireless
® Rendezvous Paint Disabled

o

Repeat this step on other network devices that need to be provisioned with fabric Edge role

And click Deploy
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Fabric Sites

=a, Find Hierarchy

~ @ Fabric-RTP

I ~ #Region - RTP

Fabric Sites

2q_ Find Hierarchy

Ld @ Fabric~-RTP

Cisco DNA Center

a @ @ o
e All Fabrics > Region - RTP _ = n
Fabric-RTP - &=
Fabric Infrastructure Host Onboarding Show Task Status
@ Three (3) Information Alerts on this page. Expand ta see detail. X ‘
&) Collapse All Custom View Sep 15, 2021 6:33 PM
& The Internet
A-ASR1001X-2 A-ASR1001X-1
«* «*
«* <>
A-N7706-2.sda-lab A-N7706-1.sda-lab
local Jacal
T
o
A-9500-2
@ @
=}
&
.__,
<> 0]
A-9300b.sda-lab
oca
Cancel ]
In the Modify Fabric slide out page, select Schedule Operation: Now and click Apply
Cisco DNA Center Q @ ® o
© |roicrm = = n
Fabric Infrastructure Host Onboarding Show Task Status
apse All Custom View Sep 15, 2021 6:33 PM
The Interet
~ ®Region - RTP o

A-ASR1001X-2

A-N7706-2.sda-lab  A-N770
local

local

A-3850mc.sda-lab

A-9407a.sda-lab
local local

A-9300b.sda-lab
local

N0 »

Cancel

Tech Tip

The Cisco SD-Access solution supports integration of wireless controller at each fabric site. The wireless controller can be either dedicated
Wireless LAN Controller or Cisco Catalyst 9800 Embedded Wireless on Catalyst 9000 Series switch.

The Access Points (APs) within the fabric site need to establish a CAPWAP tunnel to WLC Management IP Address. APs associated in
INFRA_VN must have IP reachability to the Management IP Address via the Global Routing Table within the fabric site. The WLC IP Address
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reachability on the fabric edge node(s) must be through a more specific route and not through a default route. The management IP
address of WLCs connect to or through the WAN Edge routers should be present in the Fabric GRT Service VPN.

Refer to Cisco SD-Access Design Guide and Cisco SD-Access Wireless Design and Deployment Guide for supported platform and detailed
steps to implement fabric Wireless.

Step 13. Create additional Fabric Sites as necessary, with each fabric site connected to either SDWAN Transit or IP-Transit or
both.

= Cisco DNA Center Provision . Fabric Q ® @ o

SD-Access Fabrics and Transit/Peer Networks

Choase a Fabric ar Transit/Peer Network below to manage, or add a new item by clicking "Add Fabric or Transit/Peer Netwark'
@ Add Fabric or Transit/Peer Network

Fabrics @

Default LAN Fabric Fabric-NY Fabric-RTP

Site , 5 Fabric Devices
2 Gontrol Planes , 2 Border
Transit/Peer Networks ©
@
IP-TRANSIT SDWAN 10.4.246.11
T t: IF t: SDWAN
= Cisco DNA Center a ® @ L
Fabric Sites 0 = ' ! a | S n
= Find Hierarchy Fabric Infrastructure Host Onboarding Show Task Status
D NY Caliapsa Al Cus Sep 15, 2021 6:54 PM
v abric
~ ®Region - NY o 2
The Internet
v
(-;-)

RS12-ISR4331-18

v

NY-9300-1.sda-lab
Jocal

A CISCl

c

Cancel Deploy
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Procedure 4. Provision Fabric — Configure Host Onboarding

This section details the steps needed to select default Authentication Template for the site, associate IP Address pools to Virtual
Networks and Wireless SSIDs and optionally configure Ports.

Step 1. In Cisco DNA Center, navigate to Provision > Fabric, select a Fabric Site.

= Cisco DNA Center a o ® o

SD-Access Fabrics and Transit/Peer Networks

Choose a Fabric or Transit/Peer Network below to manage, or add a new item by clicking 'Add Fabric or Transit/Peer Network

e Add Fabric or Transit/Peer Network

Default LAN Fabric Fabric-NY Fabric-RTP

Transit/Peer Networks

IP-TRANSIT SDWAN 10.4.246.11

Step 2.  Select the site from the Hierarchy

= Cisco DNA Center

a o @ o
Fabric Sites e ;l;;r::‘c‘:_ﬂRfr;abric-RTP
=q Find Hierarchy
I v @ Fabric-rTP =
Device Fabric Site ~ IP Address Fabric Role Connected Transit/Peer Network
| - %?ﬁwm i 2 A-ASR1001X-1 Global/North America/Region - RTP 10.4.200.1 Border, Control Plane SDWAN 10.4.246.11, IP-TRANSIT
A-ASR1001X-2 Global/North America/Region - RTP 10.4.200.2 Border, Control Plane SDWAN 10.4.246.11, IP-TRANSIT

Showing 1 - 2 of 2

Step 3. Select Host Onboarding tab
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= Cisco DNA Center Q o @ O

All Fabrics > Region - RTP. —_
Fabric Sites =Q L t =

Fabric-RTP -
zqFind Hierarchy Fabric Infrastructure Host Onboarding | Show Task Status
@ Fabric-RTP Collapse Al Custom View Sep 16, 2021 5:03 AM
v abric-
The Internet
I ~ #®region - RTP 5 X
A-ASR1001X-2 A-ASR1001X-1

-
prs
A-N7706-1.sda-lab

ocal

-

pae

-8500-1 A-8500-2

@ = €}
Q
&
A-3850mc.sda-lab  A-9407a.sda-lab @

local ocal

Step 4. Select the default Authentication Template for the fabric site
Click Deploy
= Cisco DNA Center Q @ @ O
Al Fabrics > Region - RTP
Fabric Sites e Fabric-RTP
=q, Find Hierarchy Fabric Infrastructure Host Onboarding Show Task Status
« & Fanric-RTP Authentication Virtual Networks Wireless SSIDs Port Assignment
~ ®region - RTP o Select Authentication Template O]

Settings will be applied to all Fabric Edge host ports, unless overridden by a static port assignment.

O Open Authentication () Edit
[+] Closed Authentication () Edit
(@] Low Impact () Edit

O No Authentication ()

In the Modify Authentication Template slide-out page, select Schedule Operation: Now and click Apply
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= Cisco DNA Center

aQa @ @ o
e All Fabrics > Reglon - RTP
Fabric Sites . H : :
Fabric-RTP Modify Authentication Template
=q Find Hierarchy Fabric Infrastructure Host Onboarding
A Two (2) Warning Alerts
« & Fabric-RTP Authentication Virtual Networks Wireless SSIDH This operation impacts all edge devices in the Fabric site
— Interfaces on edge devices that have existing configurations as static trunk or static access of routed modes wil not be configured
automatically. Please default these interfaces, resync the devices and then try this operation again.
I ~ (#®Region - RTP o Select Authentication Template ()

Schedule Operation:
Settings will be applied to all Fabric Edge host ports, unless overrid

O Later
O Open Authentication () (O Generate configuration preview
Task Name*
o EhrFre e 5 ) Modifying Authentication Template at Region - RTP
lose: uf ntication .1

@] Low Impact ()

(@] No Authentication

Cancel

Step 5.  Select Virtual Networks tab

= Cisco DNA Center

a o @ O
e All Fabrics > Reglon - RTP
Fabric Sites Fabric-RTP
zq Find Hierarchy Fabric Infrastructure Host Onboarding Show Task Status
v @ Fabric-RTP Authentication Wireless SSIDs Port Assignment
I ~ Mregion - RTP o Select a Virtual Network to associate one or more IP Pool(s) with the selected VN.

Critical Pool: Not Selected @ ~dd vinual Network

INFRA_VN X VN_CAMPUS ® VN_GUEST ¥ VNIOT X
Select the Virtual Network
= Cisco DNA Center Q ® @ O
a All Fabrics > Region - RTP
Fabric Sit )
o Fabric-RTP
zq Find Hierarchy Fabric Infrastructure Host Onboarding Show Task Status
v @ Fabric-RTP Authentication Virtual Networks Wireless SSIDs Port Assignment
I ~ Mregion - RTP o Select a Virtual Network to associate one or more IP Pool(s) with the selected VN.
Critical Pool: Not Selected aAdd Virtual Network
INFRA_VN x| wn_campus ® VN_GUEST ¥ VNIOT X
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and click Add

= Cisco DNA Center Q ®@ @ 0
. e All Fabrics > Region -
Fabric Sites Faboric-RTP Edit Virtual Network: INFRA_VN X
=@ Find Hierarchy Fabric Infrastru
v @ Favric-RTP Authentication G Reset ) Export
Lv - =Q Find
T S— o Select a Virtual ] " Filter Delete Q
Critical Pool: No O VLAN Name ~ Pool Type IP Address Pool VLAN Layer-2 Flooding H
No data to display
INFRA_VN

associate IP Address Pool(s) part of the Virtual Network and click Add

= Cisco DNA Center a @ @ &L
- e All Fabrics > Region - RTP
Fabric Sites Fabric-RTP Edit Virtual Network: INFRA_VN x
za, Find Hierarchy Fabric Infrastructure  Host Onboarding
< Back
v & Fabric-RTP Authentication  Virtual N Wi
IE Address Pool Pool Type
I ~ ¢region - RTP o Select a Virtual Netwark to assaciate one or more IP | RTP_AP_PREFIX (10.4.211.0/25) ~ | AP ~ |
| |
Critical Pool: Not Selected
VLAN
INFRA_VN b VN_CAMPU VLAN Name
AP_POOL [ Auto generate VLAN name

1P Address Pool Pool Type I/%\
N
RTP_EN_PREFIX (10.4.211.128/25) I | Extended -
1
VLAN
VLAN Name
EN_POOL @ (0 Auto generate VLAN name

Cancel
Verify the IP Address Pools and click Deploy.
= Cisco DNA Center Qa e @ o
- o | AllFanrics > Ragion - RTP
Fabric Sites Fabric-RTP Edit Virtual Network: INFRA_VN X
za_ Find Hierarchy Fabric Infrastructure
v @ Fabric-RTP Authentication G Reset I Export | Q 2
7R =Q Find
I ~ ¢®gegion - RTP o Select a Virtual Network V' Filter | Delete Q Fino
Critical Pool: Not Selec O VLAN Name ~ Pool Type IP Address Paal VLAN Layer-2 Flooding H
RTP_AP_PREFIX
INFRA_VN O AP_POOL AP 10421 0125 Disabled
O EN_POOL Extended ?;:‘S:';F"::; Disabled
Showing 2 of 2
Cancel
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In the Update Virtual Network slide-out page, select Schedule Operation: Now and click Apply

= Cisco DNA Center

a @ ® o
. o All Fabrics > Region - RTP
Fabric Sites Fabric-RTP | Update Virtual Network
zq Find Hierarchy Fabric Infrastructure Host Onboarding

A\ This operation impacts all devices in the Fabric site.
~ @ Fabric-RTP

Authentication Virtual Networks Wireless SSIDs

Port

Schedule Operation:
3 a

~ #Region - RTP o

Select a Virtual Network to associate one or more IP Pool(s) with the selected VI

O Later

Critical Pool: Not Selected () Generate configuration preview

Task Name*
Modifying INFRA_VN at Region - RTP
INFRA_WN x WN_CAMPUS X
Cancel
|
n
= Cisco DNA Center Qa @ @ o
All Fabrics > Region - RTP
Fabric Sites e Fabric-RTP
za Find Hierarchy Fabric Infrastructure Host Onboarding

Show Task Status
~ @ Fabric-RTP Authentication Virtual Networks Wireless SSIDs Port Assignment

I ~ (@region - RTP » Select a Virtual Network to associate one or more IP Pool(s) with the selected VN,
G ei\dc\ Virtual Network

VN_CAMPUS b4 VN_GUEST i VN_IOT

Step 6. Repeat the previous step, Step 5, to associate IP Address Pools to Virtual Networks for the site.

For Virtual Network (other than the INFRA_VN), configure VLAN Name, Scalable Group, Traffic and feature(s) that is
required

© 2021 Cisco and/or its affiliates. All rights reserved. Page 112 of 148



= Cisco DNA Center a @ @ &L

- e All Fabrics > Region - RTP
Ll Fabric-RTP Edit Virtual Network:|VN_CAMPUS ”

20, Find Herarchy Fabric Infrastructure  Host Onboarding
—_— Back
v & Fabric-RTP Authentication Virtual Networks Wi
[ Layer-2 anly °
I ~ ¢®gegion - RTP o Select a Virtual Netwark to associate one or more IP

1P Address Paal

RTP_CAMPUS_DATA (10.4.212.0/..

Critical Pool: Not Selected

INFRA_VN VN_CAMPU

VLAN
VLAN Nama

| CAMPUS_DATA_POOL | ([ Auto generate VLAN name
Scalable Group Traffic

| Employees VI | Data = I O IP-directed broadcast
[ Layer-2 Fiooding (O critical Pool [0 common Pool

@ wireless Pool

Tech tip
Same VLAN Name can be used across multiple fabric sites with different IP Address Pool at each fabric site. This provides the simplicity to

configure a single Authorization profile in Cisco ISE, that returns same VLAN name to the fabric edge on successful authenticated.

Step 7. View the Virtual Networks and associated IP Address Pool

= Cisco DNA Center aQ @ @ 50
Fabric Sites Q@ ome T
=q_ Find Hierarchy Fabric Infrastructure Host Onboarding Show Task Status
~ @ Fabric-RTP Authentication Virtual Networks Wireless SSIDs Port Assignment
I ~ ®region - RTP s Select a Virtual Network o associate ane or more IP Pool(s) with the selected VN.
Critical Pool: Not Selected eAErJ Virtual Network

Procedure 5. Configure WAN Edge to advertise aggregate-summary routes for associated IP Address Pool

The I0S-XE SD-WAN WAN Edge device, which is colocated fabric Border, Control Plane node and WAN Edge device, is configured
to re-distribute OMP to LISP and vice-versa. This will result in WAN Edge device advertising both the host prefixes and network
subnet for each IP Address Pool associated to Virtual Network.

To optimize and avoid advertising the host entries to remote sites, configure corresponding vManage > Cisco VPN feature
template to advertise aggregate-summary subnets for each IP Address pool configured in the Virtual Network.

This section details steps to configure Cisco VPN templates to advertise aggregate-summary routes

Step 1. Login to vManage, navigate to Configuration > Templates > Feature tab
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Cisco vManage

£X CONFIGURATION | TEMPLATES

—

SD-WAN_CONTROLLER_V.
SD-WAN_CONTROLLER_V.

SD-WAN_CONTROLLER_S.

vSmart VPN

vSmart VPN

vSmart System

SD-WAN_CONTROLLER NTP SD-WAN _CONTROLLER NTP NTP

o

“ © Add Template
Template Type | NonDefault

-] SD-WAN_CONTROLLER_V.

" SD-WAN_CONTROLLER_V.
SD-WAN_CONTROLLER_S,

ol

Step 2.

Cisco vManage

£X CONFIGURATION | TEMPLATES

0o

Search Options Total Rows: 37

vSmart|vManage admin 13 Aug 2021 11:25:18 AM
vSmart |vManage 2 2 admin 13 Aug 2021 11:27:57 AM
vSmart|vManage 2 2 admin 13 Aug 2021 11:18:10 AM
vSmart|vManaae 2 2 admin 13 Aua 2021 11:18:50 AM

Search Service VPN, Cisco VPN feature template that was previously created for each Virtual Network.

Device Feature
o featwre
3 (o1=)
‘\ Template Type NonDefaul  ~ Search Options v Total Rows: 8 of 37
N S e S T I [ N
= VPN_SERVICEVPN30 VPN_SERVICEVPN30 Cisco VPN ISR4331|ISR4221X | ISR44, admin 13 8ep 2021 6:30:42PMP... ...
.. VPN_SERVICEVPN20 VPN_SERVICEVPN20 Cisco VPN ISR4331|ISR4221X| ISR44, 2 2 admin 13 Sep 2021 6:29:14PMP... ...
VPN_SERVICEVPN100 WPN_SERVICEVPN100 Cisco VPN ISR4331|ISR4221X | ISR44, 2 2 admin 12 Sep 2021 91953 PMP... ...
o VPN_SERVICEVPN10 VPN_SERVICEVPN10 Cisco VPN ISR4331|ISR4221X| ISR44, 2 2 admin 13 Sep 2021 6:26:52PMP... ...
RS_VPN_SERVICEVPN10 RS_VPN_SERVICEVPN10 Cisco VPN ISR4331|ISR4221X| ISR44 1 1 admin 138ep 2021 6:2715PMP... ...
RS_VPN_SERVICEVPN20 RS_VPN_SERVICEVPN20 Cisco VPN ISR4331|ISR4221X| ISR44 1 1 admin 13 Sep 2021 6:30:00PMP... ...
RS_VPN_SERVICEVPN30 RS_VPN_SERVICEVPN30 Cisco VPN ISR4331|ISR4221X | ISR44 1 1 admin 138ep 2021 6:3115PMP... ...
RS_VPN_SERVICEVPN100 RS_VPN_SERVICEVPN100 Cisco VPN ISR4331|ISR4221X| ISR44 1 1 admin 12 Sep 2021 10:07:25PM ... ...
Table4.  Service VPN — Virtual Network mapping
Virtual Network Service VPN Feature Template
INFRA_VN + GRT VPN 100 VPN_SERVICEVPN_100
VN_CAMPUS VPN 10 VPN_SERVICEVPN_10
Fabric-RTP
VN_loT VPN 20 VPN_SERVICEVPN_20
VN_GUEST VPN 30 VPN_SERVICEVPN_30
INFRA_VN + GRT VPN 100 RS_VPN_SERVICEVPN_100
VN_CAMPUS VPN 10 RS_VPN_SERVICEVPN_10
Fabric-NYC
VN_loT VPN 20 RS_VPN_SERVICEVPN_20
VN_GUEST VPN 30 RS_VPN_SERVICEVPN_30
Step 3.  Select each Cisco VPN template, click three dots (...) and select Edit
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Cisco vManage

¢ CONFIGURATION | TEMPLATES

Device Feature

[m]

. ee

a, Template Type | NovDefault < Q,  VPN_SERVICE x Search Options Total Rows: & of 37
S N T S T

- VPN_SERVICEVPN30 VPN_SERVICEVPN30 Cisco VPN ISR4331 | ISR4221X | ISR44. admin 13 Sep 2021 6:30:42 PM P..

. VPN_SERVICEVPNZ20 VPN_SERVICEVPNZ20 Cisco VPN ISR4331 |ISR4221X | ISR44. 2 2 admin 13 Sep 2021 6:29:14 PM P..

= VPN_SERVICEVPN100 Cisco VPN ISR4331 |ISR4221X | ISR44. 2 2 admin 12 Sep 2021 9:19:53 PM P..

o VPN_SERVICEVPN10 VPN_SERVICEVPN10 Cisco VPN ISR4331 | ISR4221X | ISR44. 2 2 admin 138¢ " 77 -
RS_VPN_SERVICEVPN10 RS_VPN_SERVICEVPN10 Cisco VPN ISR4331 |ISR4221X | ISR44. 1 1 admin 13 54 :Ietw
RS_VPN_SERVICEVPN20 RS_VPN_SERVICEVPN20 Cisco VPN ISR4331 | ISR4221X | ISR44. 1 1 admin 13 S¢ Change Device Models
RS_VPN_SERVICEVPN30 RS_VPN_SERVICEVPN30 Cisco VPN ISR4331 [ISR4221X | ISR44. 1 1 admin 135¢ Delete
RS_VPN_SERVICEVPN100 RS_VPN_SERVICEVPN100 Cisco VPN ISR4331 [ ISR4221X | ISR44. 1 1 admin 12 Se Copy

|

Step 4. Select Advertise OMP, under IPv4 section select Aggregate tab

Cisco vManage

o

OMP can be configured only on service VPNs

* CONFIGURATION | TEMPLATES

Device Feature

Feature Template - Cisco VPN | VPN_SERVICEVPN100

Basic Configuration DNS

IPv4 Route IPv6 Route Service Service Route GRE Route IPSEC Route NAT Global Route Leak

IPVE

BGP (IPvd)

Static (IPvd)

Connected (IPv4)

OSPF External

0SPFV3
EIGRP on | ® o
LISP @ on off

NETWORK

18IS on ® off

Aggregate (IPv4) on @® off

Step 5. Select Aggregate (IPv4): On
And select Add Aggregate
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Cisco vManage

OMP can be configured only on service VPNs ]

£ CONFIGURATION | TEMPLATES

Device Feature

Feature Template - Cisco VPN - VPN_SERVICEVEN100

-]
Basic Configuration DNS Advertise OMP IPv4 Route IPv6 Route Service Service Route GRE Route IPSEC Route NAT Global Route Leak
X
=
e Aggregate (IPvd) off
o

Input Prefix

Select Aggregate Only: ON
And click Add

And select Update at the bottom of the page

Cisco vManage

[Pl € CONFIGURATION | TEmPLATES OMP can be configured only on service VPNs -]

_ Device  Feature

- Feature Template - Cisco VPN - VPN_SERVICEVPN100

0 Basic Configuration DNS IPv4 Route IPv6 Route Service Service Route GRE Route IPSEC Route NAT Global Route Leak

NETWORK AGGREGATE

=

= Aggregate (IPvd) @ on off

m

[ Mark as Optional Row ¢
Prefix | - 10421128025
Cancel
o N TN
] On 10.4.211 0725 P
cancel
Tech Tip

The network IP Address prefix can be obtained from Cisco DNA Center. Navigate to Provision > Fabric > Fabric Site > Fabric Site > Host
Onboarding > Virtual Networks tab. Click each Virtual Network to view the IP Address Pool provisioned. Configure the IP Address
prefixes to corresponding Service VPN in vManage.

Please note the IP Address prefix in the INFRA_VN is mapped to Service VPN 100 (Fabric GRT Service VPN) in vManage.
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= Cisco DNA Center Q e @ O
) All Fabrics > Region - RTP
Fabric Sites SO
e s Fabric-RTP Edit Virtual Network *
@ Find Hierarchy Fabric Infrastructure
v 'ﬂ";’ Fabric-RTP Authentication V| G Reset Export
=Q Find
~ o Select a Virtual Network Filer Q
Critical Pool: Not £ (] VLAN Name ~ Pool Type IP Address Pool VLAN Layer-2 Flooding H
m m] AP_POOL AP 1022 Disabled
(m] EN_POOL Extended 1021 Disabled
. Showing 2 af 2

Step 6.  Click Next

Cisco vManage

L& CONFIGURATION | TEMPLATES

Device Template | A-ASR1007X-1 -

oo

P

Q D Total Rows: 1
[ .| chassis Number E=r Interface Name(wpn100_Jan_interfacez) 1Pva Address/ prefix-lengthivpn100_lan._interface2_address) intrface Name(vpn100 Jan_inerface1) | |
3
- © ASRI001-X-JAE204100WU 1.1.1.10 A-ASR1001X-1 TenGigabitEthernet0/0/1 10.4.202.5/30 TenGigabitEthernet0/0/0 eoe
o

Cancel

And select Configure Devices

Cisco vManage

‘Configure’ action will be applied to 2 device(s)
attached to 2 device template(s).

° CONFIGURATION | TEMPLATES

Device Template Total %) 9| omp
A-ASR1001X1 - 2 97 97 no shutdown
58| 58 send-path-limit 4

Device list (Total: 1 devices)

55 99 ecmp-1imit 4

100| 100 graceful-restart

101 101 no as-dot-notation
ASR1001-X-JAE204100WU 102|102 timers
AASRI001X11.1.110

103 0 holdtime 60

104 advertis t-interval 1

105 | 105 graceful-restart-timer 43200

108|106 eor-timer 300

107|107 axit

108 | 108 addr mily ipvd vef 10

109|109 advertise bgp

10| 110 advertise ospf external

| advertise connected

12| 2 advertise lisp

1 113 '

14| 114 ad ly ipvé vrf 100

15| 115 advertise bgp

16| 116 advertise ospf external

17| 17 advertise connected

118 advertise aggregate 10.4.211.0/25 aggregate-only
19 advertise aggregate 10.4.211.128/25 aggregate-only

18| 120 advertise lisp

19| 121 '

120 122 address-family ipvd vrf 20

121 123 advertise bap

igure Davice Rollback Timer

Cancel

Enable the option to Confirm Configuration changes and click OK
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Committing these changes affect the configuration on 2 devices. Are you sure you want to proceed?

C‘M

chmm configuration changes on 2 devices.

vManage

Bl TASK VIEW

Push Feature Template Configuration | & Validation Success ~ Initiated By: admin  From: 100.119.42.79

Total Task: 2 | Success : 2

o3
LN (01=]
~ Q Search Options v Total Rows: 2
[ o e e T T
= uccess one - Push Feature Template ... Xe -) o -
s Done - Push Fi Templ ASR1001-X-JAE203201X8 ASR1001-X A-ASRT001X-2 1A 10 LIRERERTI
o *  @Success Done - Push Feature Template ... ASR1001-X-JAE204100WU ASR1001-X A-ASRT001%-1 11100 10 LIRERIR

Step 7.  Repeat Step 3 through Step 6, for each Service VPN template to advertise only the aggregate routes in the OMP
protocol across SD-WAN fabric to other sites.

Cisco vManage

£X CONFIGURATION | TEMPLATES

Device Feature

N oz (oY=}

a, Template Type Moo Default = Q  VPN_SERVICE x
N S T B T T

Search Options ~ Total Rows: 8 of 37

- VPN_SERVICEVPN30 VPN_SERVICEVPN30 Cisco VPN ISR4331|ISR4221X| ISR44, admin 13 8ep 2021 6:30:42PMP... ..
.. VPN_SERVICEVPN20 VPN_SERVICEVPN20 Cisco VPN ISR4331|ISR4221X| ISR44. 2 2 admin 13 Sep 2021 6:2914PMP... ..
- WPN_SERVICEVPN100 VPN_SERVICEVPN100 Cisco VPN ISR4331|ISR4221X| ISR44, 2 admin 12 8ep 2021 91953 PMP... ..
m VPN_SERVICEVPN10 VPN_SERVICEVPN10 Cisco VPN ISR4331|ISR4221X| ISR44. 2 admin 13 Sep 2021 6:26.52PMP... ..
RS_VPN_SERVICEVPN10 RS_VPN_SERVICEVPN10 Cisco VPN ISR4331|ISR4221X| ISR44, 1 admin 138ep 2021 6:2715PMP... ..
RS_VPN_SERVICEVPN20 RS_VPN_SERVICEVPN20 Cisco VPN ISR4331|ISR4221X| ISR44, 1 admin 13 Sep 2021 6:30.00PMP... ..
RS_VPN_SERVICEVPN30 RS_VPN_SERVICEVPN30 Cisco VPN ISR4331|ISR4221X| ISR44 1 admin 138ep 2021 6:3115PMP... ..
RS_VPN_SERVICEVPN100 RS_VPN_SERVICEVPN100 Cisco VPN ISR4331|ISR4221X| ISR44 1 admin 128ep 2021 10.07:25PM ... ...

Procedure 6. (Optional) Provision Fabric — Port Assignment

Endpoints connected to an edge node can be dynamically associated to a VLAN through an ISE Authorization policy upon
successful authentication. The Authorization policy can include VLAN and SGT along with additional policy elements that are
downloaded to and enforced on the edge node.

For endpoints without a supplicant, Cisco DNA Center provides a workflow to statically configure the edge node’s port
connecting to the endpoint with VLAN and SGT information. The next steps demonstrate this static procedure, which configures
an access port with static VLAN and SGT assignment.

This procedure is not needed if the VLAN and SGT are dynamically assigned via ISE Authorization polices.

Step 1. In Cisco DNA Center, navigate to Provision > Fabric, select the appropriate Fabric Site > Host Onboarding > Port
Assignment tab
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Cisco DNA Center

Fabric Sites (]

a o @ 4

2Q Find Hierarchy Fabric Infrastructure Show Task Status

v & Fabric-rTP Authentication Virtual Networks Wireless SSIDs

~ ®region - RTP 5
Filter PortNo ~ A-Z LinkStatus
[] Select All
A-3850mc sda-lab local
E O GigabitEthernetiiosi + O i IF3 + [ Gigabi 10i3 + [ cigabitEthernsti0/4 + [ aigabitEtherneti/0i5 +
Ia A-93000 sda-lab local
a A-9407a sda-lablocal
[ GigatitEtherneti 1076 + O i 017 + [ cigati [0 4 [ cigebitethernet1 /0/9 + [ cigabitEthernet1/0/10 4
[ GigabitEthemet1ja11 + O wonz2 4 O 0/13 % [ GigabltEthernet1/0/14 & [ ] GigabitEthernet1/0j15 &
[J GigabitEthernet1/0/16 + O i 017 + [ Gigabi 0i18 + [ cigabitEthernet1/0/19 + [ GigabitEthernat1/0i20 +

Step 2.  select the Fabric Node and click on the Interface

input Connected Device Type: User Devices

select the IP Address Pool from the drop-down options for Voice and/or Data
select the Scalable Group for endpoint connected to the interface

select Authentication: No Authentication

and click Update

Cisco DNA Center

Fabric Sites e

All Fabrics > Region - RTP
Fabric-RTP

zq Find Hierarchy Fabric Infrastructure

Host Onboarding

v & Fabric-RTP Authentication Virtual Netwaorks

& Clear i Refresh Assign
~ ¢#Region - RTP &

Filter PortNo ~ A-Z

B #-3850me sda-tabiocal

B #-9t07asda-tab local

3000, sda-lab.local

© 2021 Cisco and/or its affiliates. All rights reserved.

Wireless SSIDs

LinkStatus

[ Select All

abitEthernet1 70/

tEthernet] 0/6

[ GigabitEthernet10j11

] GigabitEthernet1/0/16

[] GigabitEthernet! f0/2

O cigavitemernet 17

[ Gigabitethernet1 fos12

[ GigabitEthernet! 10717

a @ @ &L

Port Assignment x
Show Ports

Connected Device Type

User Devices (ip-phone,computer,laptop) w
VLAN Name / IP Address Pool (Data)
CAMPUS_DATA_POOL / RTP_CAMPUS_DATA ( 10.4.212.0 | VN_CAMPUS ) ~
Scalable Group
IP_PHONE_SGT ~

Scalable groups are anly supported on No Auth b

TAN Name TP Ragdress Paot (Varee]

CAMPUS_VOICE_POOL / RTP_CAMPUS_VOICE ( 10.4.213.0 | VN_CAMPUS ) v |

Description

Cancel
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Step 3.
= Cisco DNA Center
Fabric Sites

=a_ Find Hierarchy

v @ Fabric-RTP

I ~ MRegion - RTP

e

All Fabrics > Region - RTP
Fabric-RTP

Fabric Infrastructure Host Onboearding

Authentication Virtual Networks Wireless SSIDs

& Clear ' Refresh Assign

Filter PortNo ~ A-Z LinkStatus

] Select All

E A-3850me. sda-lablacal

I E A-93000.sda-Iab.local

E A-8407a.5da-lab local

[ GigabitEthernet10j1

USER_DEVICE | Mo Authentcation
CAMPUS_DATA_POOL (Data)
CAMPUS_VOICE_POOL (Voice)
P_PHONE_SGT

[ cigabitEtherneri /06

[ cigabitEthernet10i11

[ GigabitEthernet1f0/16

Configure additional interfaces on the same fabric node and click Deploy

Port Assignment

+

[ GigabitEthernett o2 + O

Qa @ @ o

Show Task Status

[ cigabitEthernet! 10/7 + O

O igavitemeretisonz [

[ cigabigmemettson? [

1013 + net1/0/4 + [ GigabitEthernet1/0/5 -

+ net! /0/9 + [ cigabitEtherneni/ojio &
ona vet1o/14 4[] GigabitEthemet1/0/15 &
wons % worns % [ igsbiEthemet1/oj20 1

In the Update Port Assignment slide-out page, select Schedule Operation: Now and click Apply

= Cisco DNA Center Q © @ o
- All Fabrics > Regian - RTP I s
Fabric Sites (] Fabric-RTP Update Port Assignment x
1 Port(s)
zq Find Hierarchy Fabric Infrastructure Host Onboarding
A\ This operation impacts the clients that are connected to the ports that are being updated on A-9300b.sda-lab.local
~ & Fapric-RTP Authentication  Virtual Networks  Wirsless SSIDs  Port
Schedule Operation:
# Clear | {Refresh Assign
~ (#®region - RTP o N O Later
! Filter PortNo ~ A-Z LinkStatus O Generate configuration preview
Task Name*
[] Select All Modifying Port Assignment for A-9300b.sda-lab.local at Region - RTP
A-3850me.sda-lab.local
B #sesomeadeibioe O agemnenwneion [}
A-9300b.sda-lab.local W mlt Sl T
CAMPUS_DATA_POOL (Dats)
CAMPUS_VOICE_POOL (Voice)
A-9407a.5da-ab lacal |P_PHONE_SGT
O cigbitethemetiiore  + [}
O cigsvitethemetjornt ¢ [
O aigavitethemeriiofie  + [
Cancel

Step 4.
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= Cisco

Fabric Sites

DNA Center

\ll Fabrice > Region - RTP
Fabric-RTP

L

Fabric Infrastructure

ic-RTP Authentication Virtual Networks
& Clear Refresh Assign
Req| RT! &
Filter PortNo = A-Z L

JR———
| A-8300m sa-tabloca

A-8407a.sda-lab local

Host Onboarding

Wireless SSIDs

nkStatus

[ cigabitEthernett f0/1

USER_DEVICE | No Authentication
CAMPUS_DATA_POOL [Data)
CAMPUS_VOICE_PODL (Veice)
P_PHONE_SGT

[ cigavitEthernet1 f0/6

[ GigabitEthesmet1 /11

Port Assignment

+

*

[ GigabitEthernet1 10/2

[ cigavitEmernett o7

[ GigabitEmernett /12

(m} i 117074

[ sigabitEtheret1iore

[ sigavitEthernet1j0/13

+

[ cigabitgthernet1 /078

[ Gigabitethernet1/0/14

Qe ® o

Show Task Status

[ GigabitEthernet1/0/5 +

[ cigabitEtherneni/o/10 4

[ cigebitthermenifois &

O cigabitEtherneri /16 + [ cigabitEmernst1 10/17 + O 8 + O O cigabitEtherneti/o/20 +

netlfo/1s

Deploy

nent updated

Process 7: Defining Group-Based Access Control Policies

This section details the procedure to configure consistent group-based access control policies across multiple fabric sites
connected via Cisco SD-WAN infrastructure and that are part of Cisco SD-Access | SD-WAN Pairwise Integration.

Procedure 1.

Configure Group

Step 1.  Navigate to Cisco DNA Center > Policy > Group-Based Access Control.

. a 3
Cisco DNA Center Q @ @
o
Design Al Endpoint Analytics Take a Tour () Learn More
1 policy Group-Based Access Control 5 X
. IP Based Access Control
Provision
Application
v Assurance
Traffic Copy
Workflows : Trends and Insights
Virtual Network
. Last 7 Days
Tools
(2 Platform 1 _— —— ——
-) Activity P2 Throughput Coverage Capacity
B Reports View Details View Details

¢ System

Step 2.  Under Policies tab, click the appropriate Source/Destination matrix element.

The Create Policy slide-out panel appears.
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= Cisco DNA Center

Policy - Group-Based Access Control

° Migration is complete. Cisco DNA Center will be the policy administr
migration log, and/or change the administration mode in GRAC Conf]

Policies Scalable Groups Access Contracts Analytics

Step 3.

Policies (O) ] Enter full screen

Create Policy

Employees — Contractors

Policy Status

Default

Enabled
S Filter Deploy £ Refresh Contract:
Change Contract
m Permit m Deny Custom Default
£ $ o & o o
& g . &
H $ §F & \0‘5& & & o & &
g 5§ & F F F F & .3
E & &S E S
Source
Auditors
8YOD
Contractors
Employees > Default Policy > Contractors
Developers Contractors > Default Policy > Employees
Development_Se...
Employees
Extranet L J
Guests
Intranet
loT_Device
loT_DEVICES
1P_PHONE

Expand Minimap

Click Change Contract from the Create Policy slide-out panel to change from the default contract.

Step 4.

= Cisco DNA Center

Policy . Group-Based Access Control

° Migration is complete. Cisco DNA Center will be the policy a
review the policy migration log, and/or change the administr§

Policies Scalable Groups Access Contracts A

Policies (O) [ 7 Enter full screen

Y Filter Deploy 3 Refresh

m Permit  m Deny Custom Default
£ =
= & & -3 o
- $ f &
£ & & & & 2]
E & o & e,ég g & & & §
y & & & & & F gy £
d ¥ & ¢ & & & & ¢ §
‘Source
Auditors
80D

Optionally, create a new custom contract by clicking the Create Contract by following Steps 5-8.

Create Policy

Employees — Contractors

Policy Status
Enabled

Default

Contract:

Change Contract

Select one of the existing or predefined contracts from the list.

If using an existing or predefined contract, skip to Step 9.
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Step 5. If creating a new contract, click Create Contract.

= Cisco DNA Center Policy - Group-Based Access Control a ® @
° Migration is complete. Cisco DNA Center will be the policy adr| < Edit Policy %
the policy migration log, and/or change the administration mod
Change Contract e Create Contract
Policies Scalable Groups Access Contracts Ana
7 Filter
Policies (O) [ 7 Enter full screen
Name « Description Policies Referencing Created in
—~ O Permit_IP_Log Permit IP with logging 0
" Filter Deploy £ Refresh
O Permit IP Permit IP SGACL 0
m Permit  m Deny Custom Defauit
O DenyRemoteServices Sample contract to block Remote Access and telnet services 0
& N
-g E& & & & O Deny_IP_Log Deny IP with logging 0
£ o & \é? & > .
r-} & & 5 Nf‘ & &
@ §‘ _po & § @ g & & gF
8 & & ¢ & & & & ¢ & QO Denylp Deny IP SGACL 0
Source
N O DENY_ICMP DENY_ICMP 0
Auditors
BYOD O AllowWeb Sample contract to allow access to Web 0
Contractors
O AllowDHCPDNS Sample contract to allow DHCP and DNS 0
Developers
Development_Se..
roA —
Employees Show 10 entries Showing 1 - 8 of 8 1
—J
Extranet
- C anee I

Step 6. Input a Name and Description.

Step 7.  Define the applicable Action, Application, Transport Protocol, Source / Destination, Port, and optionally enable
Logging.

Step 8.  Click Save.

= Cisco DNA Center Policy - Group-Based Access Control Q o @

° Migration is complete. Cisco DNA Center will be the policy administration point, an| Name* ‘
mode in GBAC Configurations IEMPLOVEES_CONTRACTDRS_L\MIT | |Lim‘msd [ ication between and C

Policies Scalable Groups Access Contracts

CONTRACT CONTENT (4)
Policies (0) . enter full screen #  Action* Application* Transport Protacol Source | Destination Port Logging Action
1 Deny Advanced ICMP - - E } ><
< Fil ~
V" Filter Deploy 7 Refresh 2 Deny bittorrent Tep Destination 6881,6882,6883,68 ... @) + %
W Pemit W Deny w Custom | Defaut 3 oey e e Destination 21,21000 - b X
.. Destinati 587
< 5 ; o4 Deny Advanced uoe , o + X
3 & I . 4 Source ANY
K g
176/ Foprid7d
& ESF S EE S ¢ Default Action  Permit Logging
‘Source
Auditors
BYOD
—
‘Contractors
Loa
Developers Gancel

Step 9. Select the contract using the ( radio button and click Change.
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= Cisco DNA Center Policy - Group-Based Access Control Q @& @®@
° Migration is complete. Cisco DNA Center will be the policy administration point, anj < Edit Policy
mode in GBAC Configurations
Change Contract e Create Contract
Policies Scalable Groups Access Contracts
— \\/ Filter
Policies (0) - enter full screen
Name Description Palicies Referencing Created in
. — O AllowDHCPDNS Sample contract to allow DHCP and DNS 0
%Y Filter Deploy 7 Refresh
w Pemit m Deny ustom befaut O AllowWeb Sample contract to allow access to Web 0
O Deny IP Deny IP SGACL 0
€ J 4
E & ?.7 ,f @] Deny_IP_Log Deny IP with logging 0
& - 4
Vil 77 rs78472
Sou 8 ¢ & ¢ & & & &y &S (@] DenyRemoteServices Sample contract to block Remote Access and telnet services 0
rce
Auditors EMPLOYEES_CONTRACTORS_LIMIT Limited Communication between Employees and Contractors 0
BYOD Show 10 entries Showing 1 -8 of & 1
oA
Contractors
L
Developers Cancel
Step 10. In the Policy Status drop-down, selected Enabled.
Step 11. Click Save.
= Cisco DNA Center Policy - Group-Based Access Control Qa @ @
° Migration is complete. Cisco DNA Center will be the policy administration point, an| .
mode in GBAC Configurations Create Policy
Policies Scalable Groups Access Contracts
I Contractors — Employees I Custom
Policies (0) " Enter full screen Policy Status
| Enabled v
Y Filter Deploy £ Refresh Contract:
Change Contract
W Permit m Deny w Custom Defaut
Name Description Policies Referencing
EMPLOYEES_CONTRACTORS_LIMIT [ Limited Communication between Employees and Contractors 0
5 / 5
H & & 5 . £ ‘fg" 7 &4 #  Action  Application Protocol  Source | Destination Port Logging
§ e F P K
Source oo © © @ £ 88 1 DENY advanced icMP . on
2 DENY bittorrent Tcp tinat 6881,6882,6863,6884,6885 6886, 6687,6568,6889 oN
Auditors
3 DENY fto TcP at 2121000 oN
BYoD
= 4 DENY advanced uoP Sethe 587 ON
Contractors
L)
Developers
Default Action PERMIT Logging ON
Development_Se...
Frmninusas Cancel
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= Cisco DNA Center Policy - Group-Based Access Control a @ @

o Migration is complete. Cisco DNA Center will be the policy administration point, and screens of Scalable Groups, Access Contracts and Policies in Cisco ISE will be read-only. You can review the policy migration lag, and/or change the administration
mode in GBAG Configurations

Palicies Scalable Groups Access Contracts

Palicies (1) . enter full screen £ GBAC Configuration  Default: Permit P @) Create Policies v n =

¢ Filter Deploy £ Refresh

m Permt m Deny m Custom || Default
N ; : S g s i
i P ; NNy IN
£ £ & Fos @ § & ¥ & F
A £ iés s & F&8
&5 E § & & & o & & &

Source

Contractors > EMPLOYEES_CONTRACTORS_LIMIT > Employees

Auditors Employees > Default Policy > Contractors

BYOD

Contractors | |

Developers

Step 12. |If needed, return to Step 1 to define additional contracts policies.

Step 13. Once complete, click Deploy to provision the policies.

= Cisco DNA Center Policy - Group-Based Access Control a ® @
° Migration is complete. Cisco DNA Center will be the policy administration point, and screens of Scalable Groups, Access Gontracts and Policies in Gisco ISE will be read-only. You can review the policy migration log, *
and/or change the administration mode in GBAC Configurations

Policies Scalable Groups Access Contracts Analytics

Policies (1) [ 1 Enter full screen %} GBAC Configuration  Default: Permit IP .Grete Policies v H =

5 Filter > Refresh

m Permit  m Deny Custom Default
H o o 5 e 49 5. &
2 o o & o e & . F e & T T ¥ ES
] £ . & N G g o
L g P s 0 $§887 77777777

’ ’ 5 &

dd &g fddfyyddFdesLsdTELSs

‘Source

Auditors

BYOD

‘Contractors

Developers

Development_Se.
Employees
Extranet

Guests
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Operate

This section covers the steps used to monitor, manage, and troubleshoot various network components in this Integrated Domain

deployment.

It is organized into the following processes and procedures:

Monitoring and Assuring the Cisco SD-Access Infrastructure View Cisco DNA Center and ISE communication status

View Cisco DNA Center Assurance summary

View Cisco DNA Center Assurance details

View Fabric provisioning details in Cisco DNA Center

Validating Policy enforcement View Group-Based Access Control policies and access contracts

Verify policy configuration on edge nodes

Monitoring SD-WAN Edge device health Monitor 10S-XE WAN Edge router health and connection status

View the Audit Logs in the SD-WAN vManage controller

Process 1: Monitoring and Assuring the Cisco SD-Access Infrastructure

This process demonstrates how to monitor and assure the SD-Access Infrastructure using Cisco DNA Center Assurance.

Procedure 1. View Cisco DNA Center and Cisco Identity Service Engine communication status

Similar to the steps in the prerequisites, this procedure verifies Cisco DNA Center and ISE integration. This procedure displays a
list of the ISE Primary and Secondary Policy Administration Nodes (PAN) and ISE Primary and Secondary pxGrid Nodes and their

communication status with Cisco DNA Center.

Step 1. Navigate to Cisco DNA Center > System > System 360.

Step 2.  Under Externally Connected Systems, view the status of the Identity Service Engine (ISE).
The output will vary based on the deployment. At a minimum, there should be two entries:
e Primary — Available v

e PxGrid — Available v
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= Cisco DNA Center

System 360 Service Explorer

System Management

Software Updates

As of Sep 16, 2021 1:49 PM

@ Connected to Cisco’s software server.

@ System Package is up to date

Externally Connected Systems

Identity Services Engine (ISE)

Secondary 10.4.250.226 &
Primary 10.4.250.225
Pxgrid-Active 10.4.250.225
Pxgrid-Standby 10.4.250.226 &

Available )
Available )
Available )
Available )

Update

System - System 360

Backups

As of Sep 16, 2021 1:49 PM

® No backups server configured. Configure

IP Address Manager (IPAM)

As of Sep 16, 2021 1:43 PM

® No IPAM server configured. Configure

Qe @ o
Application Health
As of Sep 16, 202 49 PM
® Automation
® Assurance
vManage
As of Sep 15, 202 49 PM
Server URL 10.4.246.11 & Available )
Username admin
Update

Procedure 2. View Cisco DNA Center Assurance summary

The main Cisco DNA Center provides a wealth of information regarding the state and status of the devices it manages, along
with details on configuration elements. These are each shown in different dashlets.

Step 1. To view the overall network health, including the network devices, wireless clients, and wired clients, navigate to the
main dashboard by clicking the Cisco DNA Center button in the top left corner.

Step 2.  For further details and to navigate to the Assurance application, click View Details in a dashlet.

© 2021 Cisco and/or its affiliates. All rights reserved.

Page 127 of 148



= Cisco DNA Center Q @ @

Welcome, admin

Take aTour  (5) Learn More

| Learn about new capabilities In this release on the Cisco DNA Center YouTube Channel. K

Assurance Summary

Health @ Critical Issues Trends and Insights
Healthy as of Nov 19, 2020 6:38 AM Last 24 Hours Last 7 Days
’I O O % % 5 ; % O 1
Network Devices Wireless Clients Wired Clients P1 P2 Throughput Coverage Capacity
View Detalls View Detalls View Details
Network Snapshot
Sites Network Devices

Application Policies
As of Nov 19, 2020 6:41 AM

Unclaimed: O Successful Deploys: 0
DNS Servers : 1 o
Unprovisioned: 0 Errored Deploys: 0
NTP Servers : 1

Unreachable: 0 Stale Policies: 0

As of Nov 19, 2020 6:41 AM As of Nov 19, 2020 6:41 AM

Add Sites Find New Devices Add New Policy

Procedure 3. View Cisco DNA Center Assurance details

The Cisco DNA Center Assurance application provides rich details and information that expand further on the summary data
presented on the main dashboard.

Step 1. Navigate to Cisco DNA Center > Assurance > Dashboards > Health.

Step 2.  Click the tabs for Overall, Network, Client, and Application to get respective detailed health information.

Overall Used to monitor and troubleshoot the overall health of your enterprise
Network Displays a global view of the network and is used to determine if there are potential network issues to address
Client

Displays a global view of the health of all wired and wireless clients and is used to determine if there are potential client
issues to address

Application Displays a global view of the applications and is used to determine if there are application client issues to address
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= Cisco DNA Center Assurance - Dashboards - Health Q @ @

| Overall |Nelwurk| ICIientI IAppIicalion

() Global - Last 24 Hours v Actions

Network Devices Wired Clients

LATEST 1 OO% Healthy (1) TOTAL: 8 LATEST 1 00% Healthy CONNECTED: 5

616 No Devices No Devices 22 No Devices No Devices B B
0%
€ S8

Wirel lien
AN P < < A = eless Clients
¥ > peS > A =
Router Core Distribution Access Wireless Access
Controller Point LATEST = —% Healtny (1) ACTIVE:O
v

o 0%

5 .

5a 5a . o

View Network Health View Client Health

Top 10 Issue Types

Priority ~ Issue Type Device Role Category Issue Count Site Count (Area) Device Count Last Occurred Time

P2 Switch power failure ACCESS Device 1 1 1 Jun 21, 2020 12:40 PM

P3 Device time has drifted from Cisco DNA Center BORDER ROUTER Device 29 3 6 Jun 22, 2020 4:48 AM

P3 Device time has drifted from Cisco DNA Center ACGESS Device 13 2 2 Jun 22, 2020 2:41 AM

P3 Device time has drifted from Gisco DNA Center UNKNOWN Device 1 0 1 Jun 21, 2020 8:39 PM
Tech tip

For further details, see the Cisco DNA Center Assurance User Guide.

Procedure 4. View Fabric provisioning details in the Cisco DNA Center task status

Use this procedure to verify the configuration that is deployed on the SD-Access devices.
Step 1. In Cisco DNA Center, navigate to Provision > Fabric.

Step 2.  Select the fabric site in the Fabrics section.

Step 3.  Select the site from the hierarchy list in the left panel.

Step4. Click Show Task Status.

© 2021 Cisco and/or its affiliates. All rights reserved. Page 129 of 148


https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-user-guide-list.html

= Cisco DNA Center

o All Fabrics > Region - RTP

Fabric Sites Fabric-RTP

Fabric Infrastructure

za, Find Hierarchy

v & Fabric-RTP

|I ~ ®region - RTP o

Host Onboarding

>

The Internet
~
A-ASR1001%-2 A-ASR1001X-1

A-N7706-2.sda-lab  A-N7706-1.sda-lab
local local

A-3850me.sda-lab A-34073.5da-lab
acal local

Step 5. Under a task, select Provision Details to view the details.

= Cisco DNA Center

e All Fabrics > Region - RTP
Fabric-RTP

Fabric Sites

Fabric Infrastructure

=q_ Find Hierarchy

v & Fabric-RTP

~ Mregion - RTP o

Step 6.  Click the network device in the Fabric Infrastructure tab, Select Run Commands
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Task Monitor

% Fier

Modifying Port Assignment for A-3850mc.sda-lab.local at Region - RTP

+ Task Id: 0a3b82(7-580c-49b3-0036-6743b2556342
« Start Time: Sep 16, 2021 11:24 AM
2021 11:25 AM

Collapse All

Modifying Port Assignment for A-9407a.sda-lab.local at Region - RTP

+ Task Id: 157dfC40-2480-435f-bbb8 -0f4ad9655fec
+ Start Time: Sep 16, 2021 11:23 AM
« End Time: Sep 16, 2021 11:24 AM

Device Details Provision Details

a @ @ o

Custom View  Sep 16, 2021 5:24 PM

AN CE ]

[S]

a o @ o

Last Updated Sep 15, 2021 5:26 PM  _ Refrash

DEPLOYED

DEPLOYED
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= Cisco DNA Center

e > Region - RTP

Fabric-RTP

Fabric Sites

Fabric Infrastructure

Step 7.

Table 5.

show lisp sessions

Show ip bgp summary

Show ip bgp vpn4 all summary

Show ip route vrf <Service_VPN>

Table 6.

Hol

A-ASR1001X-1{(10.4.200.1)

@ @ Reachable Uptime: 4 days 25 mins

Fabric Advisories

Details Port Channel

[ Remove From Fabric

Fabric

Capability

® A

Verification Commands — SD-Access fabric Border, Control Plane

Command Runner

to Cisco DNA Center co

4 Run Commands ast updated: 5:27 PM

Configuration Power Fans User Defined Fields Interfaces

A-ASR1001X-1@10.4.200.1

ter “man” anytime to g

In the Command Runner tab, issue the commands outlined in Table 5, Table 6 to view the fabric status.

Refresh

More

Displays the LISP control plane status to fabric Edge and Wireless

Controller node.

Displays BGP neighborship state towards SD-WAN WAN transports.

Displays BGP neighborship state towards Peer Transit Networks for
each Service VPN.

Displays the routes learnt from the Peer Transit network device on

specified Service VPN

Verification Commands — SD-Access Edge

Displays the LISP control plane status to fabric Control Plane node

show lisp sessions

Show ip dhcp snooping binding

Show authentication status

Show cts environment-data
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Displays DHCP snooping binding database table for all client
connected on the edge node

Displays authentication status for all clients connected to the edge
port configured for authentication.

Displays the Cisco Trustsec environment-data state downloaded
from ISE.
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Process 2: Validating Policy Enforcement

Use this process to view that TrustSec policy that has been defined in Cisco DNA Center and that it has been provisioned with
the SD-Access fabric devices.

Procedure 1. View Group-Based Access Control policies and access contracts

This procedure uses the Cisco DNA Center Policy Application to view the configuration of the TrustSec Policy Matrix and the
defined access contracts.

Step 1.  Navigate to Cisco DNA Center > Policy > Group-Based Access Control.

Step 2.  Select the Policies to view the TrustSec Policy Matrix.

= Cisco DNA Center [ Policy - Group-Based Access Control Q & @
Scalable Groups Access Contracts

Policies (1) .~ enter full screen £ GBAC Configuration  Default: PermitIP @) Create Policies v u =

~ Filter Deploy 2) Refresh

m Permt W Deny Custom Default

3 o i ¥ o &
§ v & PO &
H &5 £ F e S 8T 77855 .
£ & ¢ & o4 i 3 F §F OF 4 4
g & & & §F o &5 F 8 S F g & &
- i A S NS S A & AP
I &5 EFE e FEF TS

Source

Auditors

ao0

Contractors

Developers
Development_Se.

Emplovees

Step 3.  Select the Access Contracts tab to view the predefined and custom contracts.

= Cisco DNA Center I Policy - Group-Based Access Control | Q ® @
Policies Scalable Groups
Access Contracts (8) Last updated: 7:45AM  ( Refresh @ cCreate Access Contract
Filter Deploy
D Name « Description Created in Rules Count Policies
AllowDHCPDNS Sample contract to allow DHCP and DNS 2 ]
AllowWeb ‘Sample contract to allow access to Web 2 o
Deny IP Deny IP SGACL o
Deny_IP_Log Deny IP with logging 0
DenyRemoteServices Sample contract to block Remote Access and telnet services 4 0
EMPLOYEES_CONTRACTORS_LIMIT Limited Communication between Employees and Contractors 4 1
Permit IP Permit IP SGACL o
Permit_IP_Log Permit IP with logging 0

Procedure 2. Verify policy configuration on edge nodes

This procedure uses the Cisco DNA Center Command Runner functionality to verify the policy configuration on edge nodes.

Step 1. Navigate to Cisco DNA Center > Provision > Fabric.
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Step 2.  Select the fabric site in the Fabrics section.
Select the site from the hierarchy list in the left panel.

Select the Fabric Infrastructure tab and the Fabric Edge node

= Cisco DNA Center a @ @ O
Fabrcs > Region - NY
Fabric Sites e Fabric-NY
NY-9300-1.sda-lab.locall(10.4.227.65)
d Fabric Infrastructure Ho| = , -
nd Hierarchy 2 ) Reachable Uptime: 2 days 5 hrs 4 mins
= This release brings in support f
M/ won't be able to add new devici Run Commands Last updat i Refr
Il - : Details Fabric Port Channel Advisories  Configuration VLANS Power Fans User Defined Fields Interfaces More
~ (reg v o —

Remove From Fabric

Fabric
© =
Command Runner NY-9300-1.sda-lab.local@10.4.227.65
Capability to Cisco DNA Center
this wi
® Rendezvous Point

Step 3. In the Command Runner tab, issue the commands outlined in Table 7 to view the policy configuration status.

Table 7.  Policy Verification Commands — SD-Access Edge Node

show cts environment-data Displays the Cisco TrustSec environment data downloaded from ISE

show authentication sessions interface <interface_id> details Displays authentication details, associated authorization profile, SGT
tag, and associated security group-based policy for the endpoint
connected on the interface

show cts role-based permissions Displays the Security Group-Based policy downloaded from ISE for
enforcement
show cts role-based counters Displays the packets denied or permitted based on the defined

Group-Based Access policy

Process 3: Monitoring SD-WAN Edge device

Use this process to view the status of the TrustSec configuration on the WAN Edge routers.

Procedure 1. Monitor I0S-XE WAN Edge router health and connection status

Step 1. Navigate to vManage > Monitor > Network.
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Step 2.  Select the WAN Edge from the list.

Step 3.  Select System Status option from the left panel

Cisco vManage

H L MONITOR  tietw System Status
P T o [111.10 1ei010 b asmomnx @

0 mr3
Reboot 6 [ Crash
f<3  TCP Optimization
WAN Throughpat
A o @ Module Hardware Inventory
= B8 Fans N/A
Top Telkers. ﬂ Temperature Sensors
WAN
o
TLoc
Tunnel CPU & Memory (¥ RealTime| 1h 3h &h 12h 7days Custom ~
100%

Security Monitoring

Firewall

Intrusion Prevention

> sow
URL Filiering 1.06% o
cpPu
Advanced Malware
Protection
TLS/SSL Decryption "
Load average over 24 hrs
Umbrella DNS Re-direct 100%
Control Connections
a
Evenis £
20.01% H
ACL Logs
Memory

Troubleshooting

0%
- Sep15,21:00  Sep 15,22:00 Sep 15,23:00  Sep 16,00:00 Sep 16,01:00 Sep 16,0200 Sep 16, 03:00  Sep 16, 04:00  Sep 16, 05:00 Sep 16, 06:00 Sep 16, 07:00 Sep 16, DE:00  Sep 16, 09:00 Sep 16, 1
ime.

Step 4. Select the Real Time option from the left panel.

Step 5. Inthe Device Options box, search for the following:
IP Route and filter for certain Service VPN
Control Connections

BFD Session
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PN

&

L moNIToR Real Time
RS12-ISR4331-18 | 1212121

Device Options:

Select Device ~
QoS

TCP Optimization

WAN Throughput

IP Route

= Filter = | PN ID: 100

Q

iottpis | oapptcs | oetrten et | 10— o rtes | esipsoies | s oo e oonto | et

Flows

Top Talkers

Site ID: 12

Device Model: ISR4331 @

Search Options v

0e

Total Rows: 85

16 Sep 2021 6:37:58 PM PDT Sdwan-system-ntf 10.4210.12/30 100 ftextomp 1101 1212121 RS12ISR43... ipvd false 251
VAN 16 Sep 2021 6:37:58 PM PDT Sdwan-systermintf 10.4210.16/30 100 fextomp 111 1212121 RS1ZISRAZ... fpvd false 251
TLOC 16 Sep 2021 6:37:58 PM POT Sdwan-system-intf 10.4.210,125/32 100 -extomp 11.am 12123920 RS12-I1SR43. ipwd false 251
el 16 Sep 2021 6:37:58 PM PDT Sdwan-systerm-intf 10.4210.126/32 100 fextomp 11m 1212121 RS12ISRAZ... ipvd false 251
16 Sep 2021 6:37:58 PM POT Sdwan-system-intf 10.4.211.0/25 100 ftextomp 1101 121212 RS12ISRA3... fpvd false 251
EEELLY By 16 Sep 2021 6:37:58 PM PDT Sdwan-system-intf 10.4211.128/25 100 eextomp 111 1212121 RS12-ISR43... ipv4 false 251
Firewall 16 Sep 2021 6:37:58 PM PDT Sdwan-system-intf 10.4.218.0/30 100 n-extomp 1.1.1.10 1212127 RS12-I1SR43. ipwd false 251
o Prevention 16 Sep 2021 6:37:58 PM PDT Sdwan-system-ntf 10.4218.16/30 100 ftextomp 11am 1212121 RS1ZISR43... ipvd false 251
16 Sep 2021 6:37:58 PM PDT GigabiEthernet0/0/2 10.4.227.65/32 100 fextomp 10.4.227.67 1212121 RS1ZISRA3... fpvd false 15

ltering & Sep 2021 6:37:58 PM POT GigabitEthernet0/0/2 10.4227.66/31 100 0000 1212121 RS12I5R43... fpvd false 0

Advanced Mahware 16 Sep 2021 6:37:58 PM PDT GigabitEthernet0/0/2 10.4227.66/32 100 direct 0000 1212121 RS12SRA3... Ipvd false 0
(RETiED 16 Sep 2021 6:37:58 PM PDT Sdwan- sy<1pmln\| 10.4.246.0/24 100 direct 1.1 121212 RS12-I1SR43. ipwd false 251
TLS/SSL Decryption 16 Sep 2021 6:37:58 PM PDT Sdwan-syster-intf 10.4247.0/24 100 ftextomp 1111 1212121 RS1ZISR43... ipvd false 251
Umbrella DNS Re-cleact 16 Sep 2021 6:37:58 PM POT Sdwan-system-intf 10.4.248.0/24 100 n-extomp 1.1an 121212 RS12-I1SR43. ipwd false 251
16 Sep 2021 6:37:58 PM PDT Sdwan-system-ntf 10.4.249.0/24 100 ftextomp 1111 1212121 RS1ZISR43... ipvd false 251
B B 16 Sep 2021 £:37-58 PM PDT Sdwan-system-intf 10.4.250.0/24 100 Hextomp 1am 1212121 RS1ZISR43... Ipvé false 251
T S 16 Sep 2021 6:37:58 PM PDT Sdwan-system-intf 10.50.0/30 100 ft-extomp 1111 1212.12.1 RS12ISR43... fpvd false 251

16 Sep 2021 6:37:58 PM POT Loopback 10.5.205.18/32 100 ft-extomp 0000 1212121 RS12SRA3... Ipvd false 0
Frents 16 Sep 2021 6:37:58 PM PDT Sdwan- sy<1pmln\| 0.5.207.0/30 100 direct 1.1 1212121 RS12-I1SR43. ipwd false 251
ACL Logs 16 Sep 2021 £:37:58 PM PDT Sdwan-system-intf 10.5.207.4/30 100 r-extomp 1.1am 1212121 RS1ZSR43... ipvé4 false 251
Troubieshooting 16 Sep 2021 6:37:58 PM POT Sdwan-systerm-intf 10.5.207.24/30 100 ftextomp 1101 121212 RS12ISRA3.. fpvd false 251
16 Sep 2021 6:37:58 PM PDT Sdwan-systemHntf 10.5.207.28/30 100 ftextomp 1111 1212121 RS1ZSRA3... ipvd false 251

Real Time

Procedure 2

Use this procedure to view Audit Logs, config shared by DNA Center to vManage to provision the WAN Edge device.

Step 1.

Step 2.

Cisco vManage

Monitor

Audit Log

ACL Log

DASHBOARD | MAIN DASHBOARD

w )

Edge device by vManage controller.

Cisco vManage

L3 MONITOR | AuDIT LOG

= Filter v

Q 10.4.249.51 x

25 Sep 2021 3:10:38 PM PDT

25 Sep 2021 3:10:10 PM PDT
25 Sep 2021 3:09:59 PM PDT
25 Sep 2021 3:09:58 PM PDT
25 Sep 2021 3:09:30 PM PDT
25 Sep 2021 3:09:24 PM PDT

25 Sep 2021 3:09:23 PM PDT

admin
admin
admin
admin
admin
admin

admin

Search Options v

10.4.249.51

10.4.249.51

10.4.249.51

10.4.249.51

10.4,249.51

10.4.249.51

10.4.249.51
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WAN Edge -6

In vManage, navigate to Monitor > Audit Log

Warning: The configuration database administrator
username and password is default and less secure.
User is advised to update it. To know more on how

to update it, click here

6

Site Health (Total 3)

Full WAN Connectivity

Partial WAN Connectivity

0 ©  NoWAN Connectivity

Completed template push to device

Device Validation Template device config - Validation s

Template RS12-1SR4431-21 successfully attached tod

Completed template push to device
Device Validation Template device config - Validation s
Template RS12-1SR4331-18 successfully attached to d

Completed template push to device

vBond - 1

template
template
template
template
template
template

template

@

template-device
template-device
template-device-.
template-device-.
template-device-.
template-device

template-device-

1

vManage - 1

Reboot

Transport Interface Distribution

0 sites <10 Mbps
10 Mbps - 100 Mbps
3 sites 100 Mbps - 500 Mbps
> 500 Mbps
0 sites

vedge-ISR4331/K9-FDO2012092M

Validation

1212122

vedge-ISR4431/K9-FOC2228200S8

Validation

1212321

vedge-ISR4331/K9-FD02012092M

View Percent

a8 e )

Warning

Invalid

ttilization

(= =]

In the search tab, input Cisco DNA Center IP Address to filter configuration that is shared and provisioned to the WAN

1h 6h 12h 24h 7days Custom ~

®©0e

Total Rows: 57 of 80

push._template_configuration-1cc
push_template_configuration-1cc.
push_template_configuration-1aa
push_template_configuration-1aa
push_template_configuration-1aa
push_template_configuration-bb1

push_template_configuration-bb1
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Step 3.  Select a task and click the three dots (...) to view the Audit Log Details or CLI Diff

Cisco vManage

L] MONITOR | AUDIT LOG

= Filter~ 1h 6h 12h 24h 7Fdays Custom =

=}

Q10424951 % Search Options v Total Rows: 57 of B0
= 25 Sep 2021 3:10:38 PM POT admin 10.4249.51 Completed template push to device template template-device-... vedge-ISR4331/K9-FDO2012092M push_template_configuration-1ce. .
= 25 Sep 2021 3:10:10 PM PDT admin 10.4249.51 Dewice Validation Template device config - Validation ... template template-device-... Validation push_template_configuration-1ce.

25 Sep 2021 3:09:59 PM PDT admin 10.4.249.51 Template RS12-1SR4431-21 successfully attached to d...  template template-device-... 1212.12.2 push_template_confiquration-1aa. .. |
m

25 Sep 2021 3:09:58 PM PDT admin 10.4.249.51 Completed template push to device. template template-device-... vedge-ISR4431/K9-FOC22282008 push_template ¢

Audit Log Details
25 Sep 2021 3:09:30 PM POT admin 10.4.249.51 Device Validation Template device config - Validation s... template template-device-... Validation push.template ==
i
25 Sep 2021 3:09:24 PM PDT admin 10.4249.51 Template RS12-1SR4331-18 successfully attached to d...  template template-device-... 1212121 push_template_
95 Gan 2171 21072 DA ONT armin w0 A 740 81 Femnlatad tamnlate nich tn dsuica tamniate tamnista.dauinre.  uerdnaGRAI AKB.ERNINIINGTNA rurch tamnlata ~

In the Config Diff window, select Side by Side to view the Old Configuration and the New Configuration

O mlinepiff (@) side by side

| 0ld Configuration New Configuration

system system
ztp-status success ztp-status success
pseudo-confirm-commit 300 pseudo-confirm-commit 300

personality vedge personality vedge

device-model vedge-15R-4431 device-model vedge-I5R-443
chassis-number ISR4431/K9-FOC22282008 chassis-number TSR4431/RI-FOC222682005
host-name RS12-ISR4431-21 host-name RS12-I5R4431-21
system-ip 12.12.12.2 system-ip 12.12.12.2

overlay-id overlay-id

site-id site-id

port-offset port-offset

control-session-pps control-session-pps

max-omp-se: s max-omp-sessions

admin-tech-on-failure admin-tech-on-failure

sp-organization-name EN-SOLUTIONS sp-organization-name EN-SOLUTIONS
organization-name EN-SOLUTIONS organization-name EN-SQLUTIONS

port-hop port-hop

track-transport track-transport

track-default-gateway track-default-gateway

console-baud-rate 9600 console-baud-rate 9600

Appendix A: Hardware and Software Versions

The following products and software versions were included as part of validation in this deployment guide, and this validated set
is not inclusive of all possibilities. Additional hardware options are listed in the associated SD-Access Compatibility Matrix and
the Cisco DNA Center data sheets. These documents may have guidance beyond what was tested as part of this guide. Updated
Cisco DNA Center package files are regularly released and available within the packages and updates listing in the release notes.

Table 8.  Cisco SD-WAN Infrastructure

Part number Software version
Cisco vSmart viptela-smart-20.3.4-genericx86-64.ova 20.3.4
Cisco vManage viptela-vmanage-20.3.4-genericx86-64.ova 20.3.4
Cisco vBond viptela-edge-20.3.4-genericx86-64.ova 20.3.4
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m

ASR 1001-X Series ASR1001-X 17.3.4a

ISR 4300 Series ISR4331/K9 17.3.4a

Table 9. Device Platform, Model, and Software Version

Cisco DNA Center DN2-HW-APL-L Cisco DNA Center 2.2.2.5
Identity Services Engine R-ISE-VMS-K9 ISE 3.0 Patch 2

Catalyst 9300 Series C9300-48U 1734

Catalyst 9400 Series C9400-48U 17.3.4

WLC 8540 Series AIR-CT8540-K9 8.10.151.0

Cisco Catalyst 9800 Embedded Wireless on C9300 Embedded Wireless 17.34

C9300, C9400, C9500 Series Switch

Table 10. Cisco SD-Access fabric devices

Catalyst 9300 Series Switches Fabric Edge, Embedded Wireless

Cisco ASR 1000-X Series Aggregation Services Routers Colocated Border and Control Plane Node
Catalyst 9300 Series Switches Edge Nodes

Catalyst 9400 Series Switches Edge Nodes

Table 11. Cisco DNA Center Package Versions

System 1.6.424

System Commons 2.1.365.62360
Access Control Application 2.1.365.62360

Al Endpoint Analytics 1.4.365

Al Network Analytics 2.6.9.453
Application Hosting 1.6.0.2107090810
Application Policy 2.1.364.170201
Application Registry 2.1.364.170201
Application Visibility Service 2.1.364.170201
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Assurance - Base

Assurance - Sensor

Automation - Base

Automation - Intelligent Capture
Automation - Sensor

Cisco DNA Center Global Search

Cisco DNA Center Platform

Cisco DNA Center Ul

Cisco Umbrella

Cloud Connectivity - Contextual Content
Cloud Connectivity - Data Hub

Cloud Connectivity - Tethering

Cloud Device Provisioning Application
Command Runner

Device Onboarding

Disaster Recovery

Group-Based Policy Analytics

Image Management

Machine Reasoning

NCP - Base

NCP - Services

Network Controller Platform
Network Data Platform - Base Analytics
Network Data Platform - Core
Network Data Platform - Manager
Network Experience Platform - Core
Path Trace

RBAC Extensions

Rogue and aWIPS

© 2021 Cisco and/or its affiliates. All rights reserved.

2.2.2.411

2.2.2.404

2.1.365.62360

2.1.365.62360

2.1.365.62360

1.5.0.362

1.5.1.137

1.6.2.432

2.1.364.592099

1.3.1.359

1.6.0.380

2.12.1.2

2.1.365.62360

2.1.365.62360

2.1.365.62360

2.1.364.362034

2.2.1.226

2.1.365.62360

2.1.364.212034

2.1.365.62360

2.1.365.62360

2.1.365.62360

1.6.1019

1.6.579

1.6.541

2.1.365.62360

2.1.365.62360

2.1.364.1910003

2.2.0.45



SD Access 2.1.365.62360
Stealthwatch Security Analytics 2.1.364.1091088
Wide Area Bonjour 2.4.363.75002
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Appendix B: References Used in This Guide

Cisco 4000 Series Integrated Services Router Gigabit Ethernet WAN Modules Data Sheet:
https://www.cisco.com/c/en/us/products/collateral/routers/4000-series-integrated-services-routers-isr/datasheet-c78-
730527.html

Cisco DNA Center Assurance User Guides: https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-

center/products-user-guide-list.html

Cisco SD-Access and Cisco DNA Center Management Infrastructure: https://cs.co/sda-infra-pdg

Cisco SD-Access Fabric Provisioning Prescriptive Deployment Guide: https://cs.co/sda-fabric-pdg

Cisco SD-Access for Distributed Campus Prescriptive Deployment Guide: https://cs.co/sda-distrib-pdg

Cisco SD-Access Solution Design Guide: https://cs.co/sda-cvd

Cisco SD-Access Solution Design Guide, SD-Access Operational Planes Chapter:
https://www.cisco.com/c/en/us/td/docs/solutions/CVD/Campus/cisco-sda-design-guide.htmI#SDAccessOperationalPlanes

Cisco SD-WAN Design Guide: https://www.cisco.com/c/en/us/td/docs/solutions/CVD/SDWAN/cisco-sdwan-design-guide.html

Cisco SD-WAN Edge Onboarding Prescriptive Deployment Guide:
https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/sd-wan-wan-edge-onboarding-deploy-guide-2020jan.pdf

Cisco SD-WAN End-to-End Deployment Guide: https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/SD-WAN-
End-to-End-Deployment-Guide.pdf

Cisco vManage How-Tos for Cisco 10S XE SD-WAN Devices, Chapter: What’s New in Cisco vManage:
https://www.cisco.com/c/en/us/td/docs/routers/sdwan/vManage How-Tos/vmanage-howto-xe-book/whats-new.html

Overview of TrustSec Guide, Configuring Native SGT Propagation (Tagging):
https://www.cisco.com/c/dam/en/us/solutions/collateral/borderless-networks/trustsec/C07-730151-
00 overview of trustSec og.pdf

Release Notes for Cisco 10S XE SD-WAN Devices, Cisco 10S XE Release Amsterdam 17.3.x:
https://www.cisco.com/c/en/us/td/docs/routers/sdwan/release/notes/xe-17-3/sd-wan-rel-notes-xe-17-
3.html#concept ecj kyz blb
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https://www.cisco.com/c/en/us/products/collateral/routers/4000-series-integrated-services-routers-isr/datasheet-c78-730527.html
https://www.cisco.com/c/en/us/products/collateral/routers/4000-series-integrated-services-routers-isr/datasheet-c78-730527.html
https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-user-guide-list.html
https://www.cisco.com/c/en/us/support/cloud-systems-management/dna-center/products-user-guide-list.html
https://cs.co/sda-infra-pdg
https://cs.co/sda-fabric-pdg
https://cs.co/sda-distrib-pdg
https://cs.co/sda-cvd
https://www.cisco.com/c/en/us/td/docs/solutions/CVD/Campus/cisco-sda-design-guide.html#SDAccessOperationalPlanes
https://www.cisco.com/c/en/us/td/docs/solutions/CVD/SDWAN/cisco-sdwan-design-guide.html
https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/sd-wan-wan-edge-onboarding-deploy-guide-2020jan.pdf
https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/SD-WAN-End-to-End-Deployment-Guide.pdf
https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/SD-WAN-End-to-End-Deployment-Guide.pdf
https://www.cisco.com/c/en/us/td/docs/routers/sdwan/vManage_How-Tos/vmanage-howto-xe-book/whats-new.html
https://www.cisco.com/c/dam/en/us/solutions/collateral/borderless-networks/trustsec/C07-730151-00_overview_of_trustSec_og.pdf
https://www.cisco.com/c/dam/en/us/solutions/collateral/borderless-networks/trustsec/C07-730151-00_overview_of_trustSec_og.pdf
https://www.cisco.com/c/en/us/td/docs/routers/sdwan/release/notes/xe-17-3/sd-wan-rel-notes-xe-17-3.html#concept_ecj_kyz_blb
https://www.cisco.com/c/en/us/td/docs/routers/sdwan/release/notes/xe-17-3/sd-wan-rel-notes-xe-17-3.html#concept_ecj_kyz_blb

Appendix C: Acronym Glossary
AAA—Authentication, Authorization, and Accounting
ACP—Access Control Policy

ACI—Cisco Application Centric Infrastructure
ACK—Acknowledge or Acknowledgement
ACL—Access Control List

AD—Microsoft Active Directory

AFl—Address Family Identifier

AMP—Cisco Advanced Malware Protection
AP—Access Point

API—Application Programming Interface

APIC— Cisco Application Policy Infrastructure Controller (ACl)
ASA—Cisco Adaptative Security Appliance
ASM—Any-Source Multicast (PIM)
ASR—Aggregation Services Router

Auto-RP—Cisco Automatic Rendezvous Point protocol (multicast)
AVC—Application Visibility and Control
BFD—Bidirectional Forwarding Detection
BGP—Border Gateway Protocol

BMS—Building Management System

BSR—Bootstrap Router (multicast)

BYOD—Bring Your Own Device

CAPWAP—Control and Provisioning of Wireless Access Points Protocol
CDP—Cisco Discovery Protocol

CEF—Cisco Express Forwarding

CMD—Cisco Meta Data

CPU—Central Processing Unit

CSR—Cloud Services Routers

CTA—Cognitive Threat Analytics

CUWN—Cisco Unified Wireless Network

CVD—Cisco Validated Design

CYOD—Choose Your Own Device
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DC—Data Center

DHCP—Dynamic Host Configuration Protocol

DM—Dense-Mode (multicast)

DMVPN—Dynamic Multipoint Virtual Private Network
DMZ—Demilitarized Zone (firewall/networking construct)
DNA—Cisco Digital Network Architecture

DNS—Domain Name System

DORA—Discover, Offer, Request, ACK (DHCP Process)
DWDM—Dense Wavelength Division Multiplexing

ECMP—Equal Cost Multi Path

EID—Endpoint Identifier

EIGRP—Enhanced Interior Gateway Routing Protocol
EMI—Electromagnetic Interference

ETR—Egress Tunnel Router (LISP)

EVPN—Ethernet Virtual Private Network (BGP EVPN with VXLAN data plane)
FHR—First-Hop Router (multicast)

FHRP—First-Hop Redundancy Protocol

FMC—Cisco Firepower Management Center

FTD—Cisco Firepower Threat Defense

GBAC—Group-Based Access Control

GbE—Gigabit Ethernet

Gbit/s—Gigabits Per Second (interface/port speed reference)
GRE—Generic Routing Encapsulation

GRT—Global Routing Table

HA—High-Availability

HQ—Headquarters

HSRP—Cisco Hot-Standby Routing Protocol

HTDB—Host-tracking Database (SD-Access control plane node construct)
IBNS—Identity-Based Networking Services (IBNS 2.0 is the current version)
ICMP—Internet Control Message Protocol

IDF—Intermediate Distribution Frame; essentially a wiring closet.

IEEE—Institute of Electrical and Electronics Engineers

© 2021 Cisco and/or its affiliates. All rights reserved. Page 142 of 148



IETF—Internet Engineering Task Force

IGP—Interior Gateway Protocol

IID—Instance-ID (LISP)

IOE—Internet of Everything

loT—Internet of Things

IP—Internet Protocol

IPAM—IP Address Management

IPS—Intrusion Prevention System

IPSec—Internet Protocol Security

ISE—Cisco Identity Services Engine

ISR—Integrated Services Router

IS-1IS—Intermediate System to Intermediate System routing protocol
ITR—Ingress Tunnel Router (LISP)

LACP—Link Aggregation Control Protocol

LAG—Link Aggregation Group

LAN—Local Area Network

L2 VNI—Layer 2 Virtual Network Identifier; as used in SD-Access Fabric, a VLAN.
L3 VNI— Layer 3 Virtual Network Identifier; as used in SD-Access Fabric, a VRF.
LHR—Last-Hop Router (multicast)

LISP—Location Identifier Separation Protocol

MAC—Media Access Control Address (OSI Layer 2 Address)
MAN—Metro Area Network

MEC—Multichassis EtherChannel, sometimes referenced as MCEC

MDF—Main Distribution Frame; essentially the central wiring point of the network.

MnT—Monitoring and Troubleshooting Node (Cisco ISE persona)
MOH—Music on Hold

MPLS—Multiprotocol Label Switching

MR—Map-resolver (LISP)

MS—Map-server (LISP)

MSDP—Multicast Source Discovery Protocol (multicast)
MTU—Maximum Transmission Unit

NAC—Network Access Control
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NAD—Network Access Device

NAT—Network Address Translation

NBAR—Cisco Network-Based Application Recognition (NBAR2 is the current version).
NFV—Network Functions Virtualization

NSF—Non-Stop Forwarding

OMP— Overlay Management Protocol

OSI—Open Systems Interconnection model

OSPF—Open Shortest Path First routing protocol

OT—Operational Technology

PAgP—Port Aggregation Protocol

PAN—Primary Administration Node (Cisco ISE persona)

PCl DSS—Payment Card Industry Data Security Standard

PD—Powered Devices (PoE)

PETR—Proxy-Egress Tunnel Router (LISP)

PIM—Protocol-Independent Multicast

PITR—Proxy-Ingress Tunnel Router (LISP)

PnP—Plug-n-Play

PoE—Power over Ethernet (generic term, may also refer to IEEE 802.3af, 15.4W at PSE)
PoE+—Power over Ethernet Plus (IEEE 802.3at, 30W at PSE)

PSE—Power Sourcing Equipment (PoE)

PSN—Policy Service Node (Cisco ISE persona)

pxGrid—Platform Exchange Grid (Cisco ISE persona and publisher/subscriber service)
PXTR—Proxy-Tunnel Router (LISP — device operating as both a PETR and PITR)
QoS—Quality of Service

RADIUS—Remote Authentication Dial-In User Service
REST—Representational State Transfer

RFC—Request for Comments Document (IETF)

RIB—Routing Information Base

RLOC—Routing Locator (LISP)

RP—Rendezvous Point (multicast)

RP—Redundancy Port (WLC)

RP—Route Processer
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RPF—Reverse Path Forwarding

RR—Route Reflector (BGP)

RTT—Round-Trip Time

SA—Source Active (multicast)

SAFI—Subsequent Address Family Identifiers (BGP)
SD—Software-Defined

SDA—Cisco Software Defined-Access

SD-Access—Cisco Software Defined-Access
SDN—Software-Defined Networking

SD-WAN—Cisco Software-Defined WAN

SFP—Small Form-Factor Pluggable (1 GbE transceiver)
SFP+— Small Form-Factor Pluggable (10 GbE transceiver)
SGACL—Security-Group ACL

SGT—Scalable Group Tag, sometimes reference as Security Group Tag
SM—Spare-mode (multicast)

SNMP—Simple Network Management Protocol
SSID—Service Set Identifier (wireless)
SSM—Source-Specific Multicast (PIM)

SSO—Stateful Switchover

STP—Spanning-tree protocol

SVI—Switched Virtual Interface

SVL—Cisco StackWise Virtual

SWIM—Software Image Management

SXP—Scalable Group Tag Exchange Protocol
Syslog—System Logging Protocol

TACACS+—Terminal Access Controller Access-Control System Plus
TCP—Transmission Control Protocol (OSI Layer 4)

UCS— Cisco Unified Computing System

UDP—User Datagram Protocol (OSI Layer 4)

UPOE—Cisco Universal Power Over Ethernet (60W at PSE)
UPOE+— Cisco Universal Power Over Ethernet Plus (90W at PSE)

URL—Uniform Resource Locator
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VLAN—Virtual Local Area Network

VN—Virtual Network, analogous to a VRF in SD-Access

VNI—Virtual Network Identifier (VXLAN)

vPC—virtual PortChannel (Cisco Nexus®)

VPLS—Virtual Private LAN Service

VPN—Virtual Private Network

VPNv4—BGP address family that consists of a Route-Distinguisher (RD) prepended to an IPv4 prefix
VPWS—Virtual Private Wire Service

VRF—Virtual Routing and Forwarding

VSL—Virtual Switch Link (Cisco VSS component)

VSS—Cisco Virtual Switching System

VXLAN—Virtual Extensible LAN

WAN—Wide-Area Network

WLAN—Wireless Local Area Network (generally synonymous with IEEE 802.11-based networks)
Wol—Wake-on-LAN

XTR—Tunnel Router (LISP — device operating as both an ETR and ITR)
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Appendix D: Recommended for You

Cisco IBNG / Enterprise Networking Validated Design and Deployment Guides: https://cs.co/en-cvds

Deploying SD-Access Embedded Wireless on Catalyst® 9300 switches: https://community.cisco.com/t5/networking-
documents/cisco-sd-access-embedded-wireless-on-catalyst-9300-deployment/ta-p/3886635

Cisco SD-Access Segmentation Design Guide: https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/CVD-SD-
WAN-Design-20180CT.pdf

Cisco SD-WAN Design Guide: https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/sd-wan-wan-edge-
onboarding-deploy-guide-2019dec.pdf

Cisco SD-WAN: WAN Edge Onboarding Deployment Guide:
https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/SDWAN/sd-wan-wan-edge-onboarding-deploy-guide-2019dec.pdf

Cisco SD-WAN Enabling Direct Internet Access Deployment Guide:
https://www.cisco.com/c/en/us/td/docs/solutions/CVD/SDWAN/CVD-SD-WAN-DIA-2019JUL.html

Cisco SD-WAN Application-Aware Routing Deployment Guide:
https://www.cisco.com/c/en/us/td/docs/solutions/CVD/SDWAN/cisco-sdwan-application-aware-routing-deploy-guide.html
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Feedback

For comments and suggestions about this guide and related guides, join the discussion on Cisco Community at https://cs.co/en-

cvds.
Americas Headquarters Asia Pacific Headquarters Europe Headquarters
Cisco Systems, Inc. Cisco Systems (USA) Pte. Ltd. Cisco Systems International BV Amsterdam,
San Jose, CA Singapore The Netherlands

Cisco has more than 200 offices worldwide. Addresses, phone numbers, and fax numbers are listed on the Cisco Website at https://www.cisco.com/go/offices.
Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks,

go to this URL: https://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner
does not imply a partnership relationship between Cisco and any other company. (1110R)
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